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INTRODUCTION|

Quality data are critical for advocating for funding to meet family planning program needs, setting
program goals, and identifying the human and material resources necessary to meet those goals.
Projecting contraceptive use is essential for setting realistic yet ambitious family planning service goals
and planning for the resources a program will require in the future. Sound programming requires data
so that the goals and activities selected are appropriate and evidence-based. But family planning
program designers, managers, and implementers are often not equipped with the data or tools needed
to make realistic programming decisions.

Reality V is an easy-to-use Excel-based tool developed by The ACQUIRE Project and
EngenderHealth that can be used to generate data for evidence-based advocacy and strategic planning.
The tool can be used to set realistic family planning goals, plan for service expansion to meet program
objectives, and evaluate alternative methods for achieving specific goals. The Reality V tool helps users
plan based on informed estimates of contraceptive need, and thus it can be used as an important
advocacy tool for illustrating both unmet need as well as the inputs required to achieve set goals. A key
feature of the tool is that it enables users to quickly test future scenarios for a program, including
whether current goals are achievable or feasible. It can help managers better understand the costs of
continuing to rely on a particular method in a program, as well as the potential benefits of expanding
the method mix to promote use of more effective contraception.

The tool was also designed to be a stand-alone product that could be used in low-resource settings,
where high-capacity Internet connections or high-level programming skills may not be available.
Anyone with basic Excel skills will be able to use the tool. Beneficiaries of the tool could include
planners and administrators from Ministries of Health and other key agencies at the national,
provincial, or district levels, as well as family planning programmers at donor agencies or cooperating
agencies.

This User’s Guide sets forth instructions and the methodology for projecting family planning trends
and instructs a user on how to apply the tool. It is written for self-teaching and can also be used as a
teaching aid for group training. The complete Reality \ package consists of the User’s Guide and an
accompanying CD-ROM. The CD-ROM contains an electronic version of the guide, the Reality v
Excel example used in this guide, and a blank Reality \ template that you can use for your own
projections. The CD-ROM also contains additional resources, primarily electronic copies of the
resources used for this guide, tools for estimating population of women of reproductive age, and
United Nations population files that can aid in projecting future populations.
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I. OVERVIEW:
WHAT IS REALITY YV AND
WHAT CAN IT DO FOR YOW?

Statement of Purpose

Reality V is a family planning tool that can be utilized to generate data for evidence-based advocacy and
planning. The tool can be used to set realistic family planning goals, plan for service expansion to meet
program objectives, and evaluate alternative methods for achieving specific goals. Reality \ allows users
to assess past trends in the contraceptive prevalence rate (CPR), to test future scenarios for the
geographic area in which their program is operating, and to test whether established goals are
reasonable for the local context in which they are working.

Background
Projecting Family Planning CPR Goals and Planning Realistically

Projecting overall CPR and method-specific prevalence rates is essential to advocating for investment
in family planning, evaluating current family planning program efforts, setting goals for the future, and
planning realistically for the resources the program will require. But program managers often are not
equipped with the figures or tools needed to make realistic programming decisions. Sound
programming requires data, so that the goals and activities selected are appropriate and evidence-
based. Projecting CPR is an art, not a science, but utilizing projections as part of the decision-making
process helps to establish realistic yet ambitious programming goals and contributes to the planning
process for how to meet these goals. It is important to note that the quality of the projections (output)
is closely tied to the quality of the data entered (input) and to the validity of the assumptions made. To
generate reliable projections for a program, one should have good knowledge of the program and be
aware of aspects of the program that may change and affect contraceptive demand or use.

Need for Local, Context-Specific Projections

Projection software is sometimes used to estimate future CPR at the national level, but the same type
of projections cannot necessarily be made at the regional or district levels. There is a real need to
project family planning goals and needs at subnational levels, to improve programming processes and
family planning program results. Often, significant regional differences in family planning usage exist
within a given country and should be reflected in both program design and resource allocation. Reality
v builds on existing demographic national-level family planning projection tools such as Spectrum/
FamPlan to project CPR and user, commodity and supply, and service needs at the regional, district,
and site levels (Stover et al., 2000).

What Is Reality \ and What Can It Do for You?

Reality \ is a tool consisting of a simple Excel workbook that generates data for decision making; it
allows one to assess past CPR trends and test future scenarios for the geographic area in which a
program is operating. The tool uses demographic data to project the number of contraceptive users
over a set time period, and based on that information, it can calculate the number of adopters (new
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users), commodity and supply needs and costs, service delivery capacity, and couple-years of
protection (CYP).! A user can test and assess whether established goals are reasonable for a particular
context, given the human or financial resources available. The tool was designed with the end user in
mind, making it easy to generate data for decision making. The tool can be used nationally and
subnationally in the health system. It is designed to be rolled out and replicated in diverse settings,
particularly in low-resource settings where other forecasting tools are not available.

A key feature of the tool is that it enables users to quickly test multiple “what if” scenarios for a
program. It can help managers better understand the costs of continuing to rely on a particular method
in a program, as well as the potential benefits of expanding method mix to promote the use of more
effective contraception. It can illustrate how reducing discontinuation affects the number of adopters,
commodity and supply needs, and service delivery capacity.

Reality\: It’s Not about Targets, It’s about Planning

Informed and voluntary decision making is a pillar of quality family planning services and a basic tenet of
the fundamentals of care. Clients’ right to freely choose the family planning method they want to use to
achieve the desired number and spacing of their children is widely recognized. The right to choose
implies that the client is not being pressured or coerced to accept family planning or to use a particular
method. It also implies that a range of methods is available from which the client can choose without
constraint. For clients to exercise this right, they need accurate information that they can understand,
access to trained health care professionals with good communication and counseling skills, and a social
context that supports them in making decisions about their fertility and reproductive health that meet
their needs.

In developing goals or targets for contraceptive prevalence in a population, one must be very careful
not to compromise individual clients’ rights to voluntary and informed choice. Though numerical goals
are important for realistic planning and budgeting, they should not be passed down to individual health
care workers as targets or quotas that they are required to meet as part of their performance
expectations. Doing so compromises the quality of services and jeopardizes the client’s voluntary
choice by creating a provider bias for or against specific methods.

Reality \ is a planning tool to help policy makers and managers understand what is realistic within the
limits of existing resources, to estimate the potential impact of family planning on certain reproductive
health outcomes, and to project what additional resources will be needed to serve the estimated
number of family planning clients at future points, based on what is known about the population and
the unmet need for services. The results should be used to project resource requirements and to
advocate for and deploy them, but not to set individual targets for health service providers. Not only
would this compromise the quality of services, it would also violate the terms and conditions of USAID
funding, as stipulated in the Tiahrt Amendment (USAID, 2009). This U.S. law prohibits the use of any
numerical targets or quotas of total numbers of births, of family planning acceptors, or of acceptors of
a particular family planning method (though it permits quantitative estimates or indicators used for
budgeting or planning purposes). The Tiahrt Amendment applies to any U.S. nongovernmental
organization (NGO), foreign NGO, public international organization (PIO), or foreign government
receiving funds, technical assistance, commodities, or training from any U.S. government account for
family planning activities.

CYP is the amount of contraception necessary to protect one couple from pregnancy for one year, based upon the
volume of all contraceptives sold or distributed to clients during that year.
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e Sample Questions That Reality\/ Can Help Answer:
o If past contraceptive prevalence trends continue, where will we be in 2015?

o The Ministry of Health has set a goal of 30% modern method prevalence by 2015. Is this
achievable? What human and material resources will be required to achieve this goal?

o How many intrauterine devices (IUDs) will have to be inserted per service site to obtain a 1%
IUD prevalence?

o How much would reducing discontinuation affect the numbers of users and commodities
needed to reach a target?

o If you have a high unmet need for family planning, what will be required to meet 50% of that
need?

o The national program is adding Sino-implant (II) to the method mix. If we have 100,000

adopters a year, how many removals can we expect annually?

Uses of Reality

The Reality V tool helps you plan based on informed estimates of need, by examining the relationship
of contraceptive prevalence to contraceptive users, adopters, implant removals, commodities, com-
modity and supply costs, and service delivery capacity, based on the number of women of
reproductive age (WRA) or married women of reproductive age (MWRA) in a given geographic area.
When testing potential future scenarios, Reality \ can also generate estimates of adverse reproductive
health outcomes (unintended pregnancies, abortions, unintended births, and maternal, infant, and child
deaths) that could be averted if the target method mix and CPR were to be achieved. This type of
local, specific information is crucial in evaluating whether CPR goals are achievable and in advocating
for the resources needed to actually achieve these goals.

The tool is set to run projections based on simple assumptions for estimating family planning usage
and needs. It is important to note that these data are intended to illustrate trends for future family
planning programs; they are only intended to be used to set goals for the purposes of planning, not to
set performance targets. The projections are only estimates based on an established methodology and
can provided a basis for predicting future family planning needs. Several other USAID-funded tools
can be used as complements to Reality V. These include the FamPlan module of the previously
discussed Spectrum, which was developed by the Policy Project (Futures Group International);
CastCost, developed by the U.S. Centers for Disease Control and Prevention (CDC); and PipeLine,
developed by the DELIVER Project (JSI) (Bagga et al., 2009).

Reality V: Getting Acquainted with the Tool

The Reality\/ tool consists of an Excel workbook containing two basic worksheets:

1. Past Trend Continuation

2. Future Goals

Customizable graphs corresponding to each worksheet are also generated in separate sheets.

Each worksheet contains set formulas to minimize the amount of data you will have to input to
examine either a past trend or a projected future scenatio.

The only software you will need is Microsoft Office, specifically Microsoft Excel. While this guide will

help you to navigate the process of inputting data and analyzing the projections, basic Excel skills are
needed. Skills such as knowing how to move through a worksheet, how to save files, how to copy a

The RESPOND Project RealityV User’s Guide—Version2 5



workbook and worksheet, how to print, how to hide columns and rows, or how to copy and paste
data into a Microsoft Word file will come in handy when you use the Reality \ Tool. Appendix C:
Excel Functions: Tips on Using Excel (page 81) provides instructions on the multiple Excel functions
used in the Reality \/Ptool.

The worksheets have been color coded to help guide you through the process.
e The only cells in which you need to input data are the green cells.

The rest of this guide will help you to use the actual Excel file.

e The visual illustrations contained in the guide have been enlarged or reduced for this guide; you will
have complete control over how you view the Reality \ Excel file when you are using it on your
computer. In some images, you will see a blue line denoting cells linked to a formula; this helps direct
your attention to the appropriate cells in the visual, but these lines will not appear on your screen
when you use the actual tool.

While this guide will direct you on how to use the Reality V tool to input data and generate projections,
each section also contains additional information and illustrative questions that can help you interpret
the projections and think about them in a larger programmatic context.

To follow along with the examples in the guide, you need to look at the Excel file on your computer as
you read. Looking at the Excel worksheets in their entirety also helps provide context on the data that
are captured within the worksheet. The Reality \ Excel file contains two different Excel worksheets—
the first calculates method-specific prevalence at a future point in time if prevalence (past trend)
continues; the second worksheet allows you to set a future prevalence goal (scenario) and see what it
will take in terms of users, adopters, and commodities to meet this goal and what the potential impact
of doing so might be. While you do not need to examine your past trend calculations first, this will
help provide insight into how your program has performed and will also illustrate the effects of a
simpler extrapolation into future years. After that, you will be able to test future scenarios.

Enabling Macros

Before you begin to work with Reality v or any of its accompanying tools, you must enable macros in
Microsoft Excel. Macros are stored series of commands and functions that automatically run to
perform a specific task; these are embedded into the tools to simplify several aspects of navigating the
sheets. Without macros enabled, Reality \ will still function; these are included to simplify the data
entry process for the user. The customizable graphs and population calculators will #of function if
macros are not enabled.

Follow these steps to enable macros in Tools | Data  ‘Window

Excel on your computer with Office Protection »
2003: anal Seek, ..
1. Open a blank Excel workbook. | - |
acra Fil & Macros... alk+F5
2. In the Tools menu, select Macro, -
then Security. Custamize, ., @ Record Mew Macro...
3. Select the “Medium” security Dptions. .. | Security. ., .
. w s
option, then select OK. % # visual Basic Editor Alt+F11
. Cl he Excel workbook.
4. Close the Excel workboo @%  Microsoft Script Editor — Al-+Shife+F11
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5. Open the Reality \ workbook.

6. A grey box will ask you whether you want to enable or disable macros. Select “Enable macros.”

You will 7ot need to perform steps 1 through 4 each time you use the tool, unless you switch to a
different computer.

For users of Office 2007 or 2010:
1. Open a blank Excel workbook.

" [

2. Click the Microsoft Office Button. ™
3. Select Excel Options.

In the Trust Center category, click Trust Center Settings, and then click the Macro Settings
category.

Select the “Medium Security” option.

Select “OK,” then close the Excel workbook.

Open the Reality \ workbook.

A grey box will ask you whether you want to enable or disable macros. Select “Enable macros.”

Sl B

You will 7ot need to perform steps 1 through 6 each time you use the tool, unless you switch to a
different computer.

I. Past Trend Continuation Worksheet

To project contraceptive prevalence into the future based on your past trend, or to know whether
future CPR goals are realistic, it helps to first assess where you have been:

e How has prevalence by method changed over time?

e What would the future total prevalence be in year X /fthe trend were to continue?

The above questions can be answered by calculating your past trend; this is done in Worksheet No. 1:
Past Trend Continuation. This worksheet will calculate past CPR trends based on 2-5 data points and
project those trends to continue for up to 25 years into the future. By inputting 2-5 data points, you
can use the worksheet to capture a basic trend during a specific time period.

Note: The Past Trend Continuation worksheet will project the trend for a period of 25 years beyond the
most recent data point entered. However, the further out one projects, given the linear nature of the
model, the less reliable the numbers become. Uncertainty in the projections increases as the period of
the projections increases; this worksheet is only intended to provide an estimate of where programs
would be at a point in the future if trends that have occurred in the past continue. It is not an exact
prediction of future trends, as many factors may change.

The image on page 8 is an extremely reduced image of the Past Trend Continnation worksheet and is
included here to provide a quick, big-picture visual to help explain the file’s overall set-up. It does not
represent the size of the fields you will see in Excel; the image is included here simply to give you an
idea of how the worksheet is organized.

The RESPOND Project RealityV User’s Guide—Version2 7



P HEHEH

...........................

F

Notice that while this file may at first seem complex, all of the cells are linked and contain formulas
that automatically update once you input your data into the green cells. The green cells contain figures
such as CPR, population data, and commodity and supply costs.

The color coding can help make sense of what you are seeing.

As noted, the green cells are the only cells in which you have to input data.

The spreadsheet area demarcated by the grey border to the left contains the main information used
for calculating the projections. The purple area indicates the area where future projections are
calculated. The spreadsheet is formulated to instantaneously run calculations and projections as
you input the necessary data. All cells, with the exception of the green ones, contain formulas used
for the projections. The formulas in the worksheet are locked, to minimize mistakes.

The basic indicators (outputs) that the Past Trend Continnation worksheet can project are:

CPR

Population data for the number of women or number of married women
Number of users

Number of adopters

Number of implant removals

Commodities

Costs’

Service provision
CYP

2 Only commodity costs are included as default values in Reality v, but users can enter per-unit total service costs, if

available, to calculate the total costs of providing services.
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The data inputs required to generate these basic indicators are:

Method-specific CPR data for 2-5 years

The population of WRA or MWRA for all years of interest

CYP
Discontinuation rates
Commodity and supply or total service costs

Note: Default method-specific values are provided for the final three, but you can enter country-specific
values if these are available.

Optional service provision outputs that one can generate are:

Estimated number of clients per facility per month

Estimated number of implant removal clients per facility per month

These require you to input the following:

Numbers of facilities in the geographic area of interest that are able to provide each method

Estimated number of annual client visits for each method

Before proceeding, navigate the Past Trend Continunation Excel worksheet to get a better sense of how it is
set up.

2. Future Goals Calculation File
You may want to test family planning projection
scenarios for a multitude of purposes, such as:

Planning for future needs to determine what CPR
goals mean in terms of numbers of users, of
commodities, or of sites that will be required to
serve clients

Assessing whether previously established goals are
realistic or what kind of resources will be needed to
meet these goals

Identifying the potential impact of achieving a
target CPR and method mix

Advocating for more resources at the national level
or from donors

Analyzing how to optimize family planning
resources for maximum impact and how to obtain
estimates for future resource allocation (For
purposes such as this, you can use the Future Goals
worksheet.)

To the right is a reduced image of the Future Goals
worksheet in its entirety; again, this is included to
provide an overview of how that worksheet is set up.

The RESPOND Project
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You can see that it is very similar to the Past Trend Continuation worksheet. As in that worksheet, the
only cells in which data have to be input are the green cells.

Similar to the Past Trend Continnation worksheet, the indicators that the Future Goals worksheet can

project are:
e CPR
e Population data for the number of women or number of married women

Number of users
Number of adopters

e Number of implant removals
e Commodities
e Costs
e Service provision
o Estimated number of clients per facility per month
o Estimated number of implant removal clients per facility per month
e CYP

In addition, the Future Goals worksheet can project the following impact indicators:
e Unintended pregnancies averted

e Abortions averted

e Unintended births averted

e Maternal deaths averted

e Infant deaths averted

e Child deaths averted

Required data inputs to generate these impact indicators are:
e Country-specific or regional abortion ratios

e Country-specific maternal mortality ratios

e Country-specific infant mortality rates

e Country-specific child mortality rates

e Method-specific failure rates

e Pregnancy rates

e Spontaneous abortion rates

Note: Default method-specific values are provided for the final three, but you can enter country-
specific values if these are available.

This worksheet contains the same level of analysis as the Past Trend Continunation worksheet, with the
addition of the impact calculations. Be sure to take an opportunity to examine this file to get a better
sense of how it is set up.

Now that you have an overview of the tools, you can start to run projections.
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Il. GETTING DOWN TO BUSINESS:
USING REALITY Y TO
GENERATE PROJECTIONS

What Do | Need to Begin?

For any level of projection that you would like to run (national, regional, district, or site), you will need:
e Two to five years’ of CPR data points (with data segregated by method)
e Population data

CPR Data

e CPR data may come from sources such as the Demographic and Health Survey (DHS), Multiple
Indicator Cluster Survey (MICS), or Reproductive Health Survey (RHS). You can run projections
on either women of reproductive age (WRA) or married women of reproductive age (MWRA);

therefore, you will need to ensure that you use CPR data corresponding to the level of projection
you would like to run (i.e., CPR figures for WRA or for MWRA).

e Estimated data can also be used when actual data are not available: If you have one data point for
the past and you have a reasonable estimate for the current CPR, you can utilize estimated data for
the second data point. (You need to make sure to document the rationale for your estimate.)

e You can also utilize data from another nation or region that has a similar profile to the geographic
area on which you would like to focus. Please keep in mind that regional estimates or some other
data can be used as your starting point and that you can adjust the CPRs you input based upon
how you think your program has done. The tool was designed to give you, the user, as much
flexibility as possible, based on the data or estimates that are available.

All CPR figures in the spreadsheet have been rounded to the second decimal place. This allows for
easy display and computation and keeps enough precision for the projections.

Population Data

Depending on the level of analysis you choose, population data on numbers of WRA or MWRA are
needed for Reality Xl projections. If you have them, local-level population projections (such as pro-
jected census data) can be used here. If not, a commonly used source of population projections is the
United Nations World Population Prospects Database. The Reality V CD-ROM contains tools to help you
calculate the population of WRA or MWRA; see the assumptions undetlying the population estimates
on pages 73-78 of this guide. You can also use information from the U.S. Census Bureau for
population projection estimates.

3 For calculating a continuation of a past trend, one can input up to five data points. A minimum of two are required.
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Running the Projections

I. Calculating Past Trends

Before you jump into testing future scenarios, it is advisable to calculate past trends, to help give you a
sense of how the family planning program has performed to date. While you can certainly test future
scenarios (i.e., run projections on the Future Goals worksheet) without calculating past trends, the past
trend figures will help you assess what may be realistic for the future of your program, based on
historical trends; it will also help provide context before you begin to run future scenarios.

Detailing Source Data and Assumptions

On your computer, open the worksheet labeled Past Trend Continuation. Be sure that you have enabled
Macros in Excel by following the steps listed on pages 6—7 of this guide. In the top left-hand corner,
you will see seven fields of information that are critical to input (see below), to ensure that you are able
to remember all of your source data and assumptions. This will help you to follow the work you are
doing in the spreadsheet and will also help others understand exactly what the projection is based on.

o

1 | Date:
z | Title of Scenaric:

Geographic Level/Name of
Analysis {i.e. national, region,

3 |district):

4 | Assumptions:

5 | Based Upon WRA or MWRA:
& | Population Data Source:

7 | CPR Data Source:

Source Data and Assumptions That You Have to Input

1. Date

e In this field, you should note the date on which you are working on the file. It may also be
helpful to note the initials of the original creator of the file.

2. Title of Scenario
e Label and name the scenario to make it easy to refer back to it. The title may contain
information such as the country or district name and the nature of the projection (i.e., Region
X in Country X: Projected Past Trend Continuation).
3. Geographic Level/Name of Analysis (i.e., National, Regional, District-Level)

e This field will allow you to specify the geographic area of your projections. For example, if you
are running national-level trends, you can enter National, however, if you are running the data
on a specific region, district, or site, it is important to note the proper name within this field.

4. Assumptions

e Detailing the assumptions is crucial to knowing what the data are based upon.

e The example notes that the 1998-2003 trends are being calculated and are a basis for
projecting into the future.

e It is very important to note that year-to-year changes can be projected in various ways; this
tool projects based upon an average annual increase or decrease (slope).
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5. Based upon WRA or MWRA

e In this field, it is important to note whether you are basing your projections on populations of
WRA or MWRA. This will ensure that anyone looking at the file understands which CPR
trends are being analyzed and also which population numbers are being utilized for the
projections.

6. Population Data Source

e This field will capture information on the source of the WRA or MWRA data used.

e The example shows that the numbers utilized in this file came from the United Nations
Population Division World Population Prospects, which is the source of the data in the National
Population Calculator included on the CD-ROM. If you obtain your data from an Internet
page, you should reference the web site and the date on which you accessed the information.

7. CPR Data Source
e Here, you will want to note the source(s) of the CPR data.

e In this example, we can see that 1998 and 2003 DHS data are being used. Be as specific as
possible regarding your sources. If, for instance, you use service statistics for a specific district
to estimate your CPR, be sure to note the time period for which the service statistics apply. If
you are using another source, such as the RHS, be sure to note that information in this field.

e Entering this information in every worksheet you use will help you and others refer back to the
original sources. This information is also critical in explaining what the projections illustrate.

CPR Survey Data

Now that you have completely filled in your background data and assumption fields, it is time to begin
to input #he numbers. This section will guide you as to where to input data and will illustrate the formulas
and projections that result from your data inputs. Again, for clarity, be sure to continuously look at the
Excel file on your computer screen to get a better sense of the worksheet as you read this guide.

The figure on page 14 shows cells that require your data input for calculating the past trend. As
previously noted, the green cells are the only cells throughout the Reality V tool into which you will
input data. It is important to keep this in mind, as most of the other cells within the worksheets
contain formulas that link back to the green cells. Also, although the tool allows you to enter up to five
CPR data points per method, only two are required.

Note: There is no precise formula for determining the number of data points to enter. Consider the
factors that have driven FP trends most recently when determining whether to use two, three, four, or
five data points. For example, if you have data from 1990, 1994, 1999, 2003, and 2007, do you think that
the factors driving change between 1990 and 1994, 1994 and 1999, and 1999 and 2003 are still occurring
today? If so, these five data points should be included. If you think that factors that began in 1999 are
most reflective of trends today, include only the three most recent data points.

Determining which trends to project to continue is an art form; there is “right way.” However, project-
ing the continuation of past trends is not the main purpose of Reality v, and past trends are often not
continued into the future (programs end, demand shifts, etc.). The Past Trend Continuation worksheet in
Reality  is just to help you to get a sense of where your program has been and where it might be if it
continues to grow at the rate at which it has in the past.

The RESPOND Project Reality V' User’s Guide—Version 2
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We can see that this section of the &

wotksheet contains information on
Survey Data (or Estimated Data) for
Calentating CPR Past Trend. Column A | 2
contains the labels for individual a |cer
methods. Columns B through F are | 14 |F

the sections of the worksheet where | 18 |Injectable - two-month
. . 1€ |Injectable - three-month
CPR data points for each method will 14

Male Condom
be entered. 12 | Female Condom

20 | Any Trad. or Folk,

We know from the background data | 21 |Iimplant - Forplant, Jadelle

22 |Implant - Implanan

previously detailed that the trend
being calculated is based on MWRA | z4 |

and that the data came from the | 25 |Female Sterilization
DHS; therefore, the numbers in Male Sterljzation
column E are based on the CPR for
MWRA from the 1998 DHS and the

Auny Method

numbers in column F are based on | 31 | anyModern Method

CPR for MWRA from the 2003 [3&] AILAPMs

19 | Standard Days Method

23 | Implant - Sino-implank (1)

First Last
Diata Diata

12.50
770 w0
F 150" zE0

DHS. (If you choose to base the projection upon WRA, you must be sure to enter the CPR figure for

all women, not just for married women.)

Reality V has the capacity to project figures for a number of methods:

Pill (oral contraceptives)
Two-month injectable
Three-month injectable
Male condom

Female condom
Any traditional or folk methods
1IUD

Female sterilization
Male sterilization

discontinuation data for these categories.)

Standard days method (also known as SDM or CycleBeads)

Hormonal implants (Norplant”®, Jadelle, Implanon, or Sino-implant (IT))

Two “other” methods of your choice (Note that Reality \ does not provide default CYP, cost, or

It is possible that you will not have data for every method listed; this could be due to the fact that the
method is not available in your geographic area or that the method is too new for data on it to be
available. It is important to keep in mind that while these options are available in Reality v, you only
have to input figures for the methods that are applicable to your program. The tool has been designed
to allow for this type of flexibility, so it can meet the needs of multiple users.

Also, note that only two data points (i.e., data for two different years) are required. However, if you
have access to up to five data points, Reality V will generate a line of best fit to project trends between
the data points. CPR data for previous years, if available, can create a more nuanced projection that

considers past trends when calculating future CPR.
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CPR Data That You Have to Input

1. Column F contains the Last Data Point. Input the year of your most recent data point (Cell F13). In
this example, 2003 was chosen for the most recent year.

2. Using the CPR data from your source, input method-specific CPRs for your most recent year (Cells
F14-F28). Each figure shows the percentage of WRA or MWRA using that method. For any method for
which you do not have data, you can either leave the corresponding green CPR cell blank or enter 0.

3. Input the year of your second-most-recent data point (Cell E13). In the example here, 1998
appears as the earliest year for which CPR data were accessible.

4. Using the CPR data from your source, input method-specific CPRs for the second-most-recent
year (Cells E14-E28).

5. If you have access to more than two data sets, follow these steps to enter your additional data and
their corresponding years.

Note: The CPR data may be entered in any order that you prefer. However, you may find it most
convenient to enter your data in chronological order, with the most recent year on the right, in
Column F, and the older data in ascending order, with the oldest starting at the left (Column B) and the
most recent on the right. Also, the years of the data sources must be entered into the green cells at the
top (B13 through FI13, if you have five data points); the calculator considers the difference between
these years when projecting CPR trends. If they are left blank, no calculation will be performed.

As mentioned eatlier, it is not necessary to have data for every method listed in Reality \; for methods
with no data, you can input the number 0 into the appropriate cells or simply leave them blank. You
will also notice that there are multiple options for the injectable (Row 15 is for the two-month
injectable, and Row 16 is for the three-month injectable); given that many programs have both options
available, the tool allows you to project based on both types of injectables. The same is true for
implants: Row 21 is for Norplant or Jadelle (given that Norplant will not be on the market in the
future), while Row 22 is for Implanon and Row 23 is for Sino-implant (II). Again, providing multiple
options for both injectables and implants offers flexibility for the individual user.

Given that there are two options in Reality \ for the injectable and three for the implant, you can
choose which fields you want to use and how to input those data. For example, if you are using a DHS
survey that gives you one CPR figure for injectables (e.g., 10%) and you know that about half of that
use is due to the two-month injectable and about half is due to the three-month injectable, then you
can input “5” into cell F15 and “5” into cell F16. Alternatively, if the injectable CPR is 10% and you
know that this is due solely to the three-month injectable, you would then input “10” into Cell F16.
Keep in mind that it is up to the Reality V user to decide which fields to use.

For the purposes of this guide, for simplicity the three-month injectable is used as the injectable
example and Norplant/Jadelle is used as the implant example.

If you have data on another method or methods of interest, feel free to enter those data in the
“Other” fields in Rows 27 and 28. Note that Reality V will not provide data for commodity and supply
costs, CYP, or discontinuation rates for the “Other” entries; you will have to enter your own values
into the corresponding green cells throughout the worksheet. You can also change the labels from
“Other 1” and “Other 2” to the specific names of the other methods.

The RESPOND Project Reality V User’s Guide—Version 2
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When using survey data (such as the DHS or RHS), always check to ensure that you are using the
correct numbers. As indicated above, if your projection is to be based on MWRA, ensure that you are
inputting the CPR for MWRA and not for all WRA. It is also critical to double-check all of your
numbers for accuracy. Given that the spreadsheet formulas are linked to the figures you input and will
automatically calculate projections, even small inaccuracies will result in faulty projections.

CPR Summary Information

Under the list of methods, there are three summary categories; based on the data you previously
entered (cells B14-28 through F'14-28), this information will be automatically calculated:
o Any method: sum of all the methods listed above
o Formula=SUM(B14:B28)
o Any modern method: sum of pill, injectable, male condom, female condom, SDM, implant, IUD,
female sterilization, male sterilization, and “other”
o Formula=SUM(B14:B19,B21:B28)
o Al long-acting and permanent methods (1.A/PMs): sum of implant, TUD, female sterilization, and male
sterilization
o Formula=SUM(B21:B26)

Fa2 - f :M|N|:SUM(F21F2E:|,1DD:| This ICVCI Of analysis prOV‘ideS a
- B ] ¢ | © | £ 7 useful picture of the overall CPR

status and provides a comparison
among categories of methods.

First Last

Data Data LOr example, these projections
12 can help you decide if you want to
13 |cpR put more effort into advocating
14 |pil for more resources. If LLA/PMs

12 |Injectable - two-month
16 |Injectable - three-mornth
17 |Male Candaom

18 |Female Condam

19 |Standard Days Method
20 |Any Trad. ar Falk

21 |Implant - Marplant, Jadel
22 |Implant - Implanon

23 |Implant - Sino-implant (D
24 {IUD

25 |Female Sterilization
Male Sterilization

are particularly underutilized, you
may want to think about
strengthening these services in
your program. LA/PMs ate often
underutilized for a number of
reasons, including myths and
misconceptions about them, a
lack of supplies, or a lack of
skilled providers who can offer
them. LA/PMs also requite a
larger up-front investment than
do resupply methods such as the

Ariy Methiod - F 1am ™ sED ) o ,
31 | Any Modern Method - 770 1400 pil or the injectable. Yet in the
32 | &N LAPMs d

- 1.50 2500 longer term, LA/PMs are among
the most cost-effective methods and are appropriate for both those who want to space births and those
who want to limit future pregnancies.

We can see from the image above that Cell F32 (A4 1.A4/PMs for the year 2003) is calculated by
adding implants, IUD, female sterilization, and male sterilization in the year 2003 (cells F21 through
F26). This is an example of the formulas contained throughout the worksheet.
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Calculating the Past CPR Trend

To project based on the past trend, the average annual increase or decrease must be calculated. If you
enter only two data points, this is simply the difference between the first CPR and the second CPR,
divided by the number of years between them. This approach is more conservative than using a
constant percentage change from year to year. If you enter 3-5 data points, a line of best fit will be
generated, and the slope will be used as the annual rate of increase.

The formulas in Column G will automatically calculate the average annual change during the past period
by calculating the slope of the line of best fit between all CPR points entered. This information is very
important for assessing the progress of your family planning program against strong family planning
programs. (Strong family planning programs have typically been able to increase CPR by approximately
1.5 percentage points annually; see the tables in Appendix F [page 105] for more information on family
planning trends.) The average annual rates of increase in Column G can help you think about how your
program compares against a strong program. When testing future goal scenarios (discussed in detail later
in this guide), the average annual increase or decrease can also help you think about whether your future
program goals are realistic. Since an annual increase of 1.5 indicates a s#omg program, an increase
projected to go much higher than 1.5 points annually may not be reasonable to expect. Goals may turn
out not to be achievable if they are initially set too high. Assessing what an achievable annual gain for
your context may be requires thinking about factors such as past performance, family planning resource
allocation, service delivery capacity (current and any planned expansion), and trends of family planning
programs in settings similar to yours.

e 'The following image shows Column G: Average Annual Increase/ Decrease for Past Trend.
o This is the slope of the line of best fit between the data points entered.

a, B | ¢ | o | E | F | G
Average Annual
Increase/Decrease

First Last for Past Trend to Be

Data Data Used in Formulas for
12 Point Point Projections
12 |CPR 1998 2003
14 |Rill 2E0 320" n1z
12 |Injectakble - two-month d 0.00
16 |Injectable - three-mornth 250 40" 0.78
17 |Male Condom 0.50 140" 022
18 |Female Condom ¥ 0.00
19 |Standard Days Method i 0.00
20 |Any Trad. ar Falk 700 480" -0.4a
2 |Implant - Morplart, Jadells 0.00 030" 0.06
22 |Implant - Implanon i 0.00
23 |Implant - Sino-implant (0 d 0.00
24 |IUD 0.40 20" -0.04
25 |Female Sterilization 1.40 200" 012
26 |Male Sterilization 000 ooa” 0.0o
27 |Cther 1 r 0.00
28 |Cther 2 r 0.00
29
30 | Ay Method - - - F 1armF 1ge0 " 078
3 | Any Modern Method - - - 7.0 1400 F 1.26
32 | ol LaPhs - - - a0 250 F 014
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Interpreting the Data: CPR Trends

We can see from the example on page 17 that over the five-year period between data points, use of some
methods has grown, while use of others has declined. It is critical at every step in this process to think
about what the data illustrate. When examining the data, it is necessary to consider the various root causes
that may have influenced CPR and family planning uptake in the years between surveys.

Issues to Consider

When examining the past trend’s annual increase or decrease, you may want to think about issues such as:
Is the annual increase or decrease equal to, more than, or less than what you may have thought?
In terms of international experience, relatively strong family planning programs can experience a 1.5%
annual increase in CPR; how does your program compare to this number? (See Appendix F [page
105] for international estimates on past annual increases/decteases of family planning programs.)

e What factors contributed to these changes within the health care system and in an external
environment?

e Have there been shifts in commitment at various policy levels, either toward or away from family
planning in general or specific methods?

e Where have resources been allocated? Have they been allocated to public health? Are they being
allocated to other health needs?
What were the family planning priorities during the years between surveys?
Have champion policy makers, health service providers, community leaders, or other family
planning advocates been lost to other professional positions or geographic areas?
Are myths and rumors about a particular method contributing to possible decreases in utilization?
Might any communication campaigns or community activities have contributed to an increase in
method utilization?
Have contraceptive stock-outs reduced usage?
Have new family planning methods been introduced in your program?
Have there been any changes in policies governing the level of cadre allowed to provide a specific
method during the years between surveys?

e Are there any other factors that may have played a role?

It is important to ask these types of questions to make sense of the projections. In the example

provided, one might analyze the data based on factors such as:

e The three-month injectable experienced the highest growth rate, at 0.78 percentage points
annually. What might the reasons be for this increase? Could it be due to word-of-mouth reporting
(i.e., women hearing about it from their friends)? Could it be because women feel they can use the
method without their partner’s knowledge? Could it be due to provider bias, because the method
can be given relatively quickly? Could it be due to an increase in the number of providers trained
to offer the service? Was there a policy change that allowed a lower level of health service provider
to offer injectables? Did the method satisfy an unmet need in the community?

e IUD use declined by 0.04 percentage points per year. What might the reasons be for this decrease?
What level of health service provider can offer IUD services? Was there a decrease in the number
of professionals who could offer it? Could the decline be due to myths or rumors about the IUD?
Did eatlier communication campaigns about the method stop at some point between the survey
years? Were there adequate commodities to meet demand? What impact did donor support or
termination of support have on IUD use?

e Implant prevalence (for this example, we are using Notrplant/Jadelle) rose from 0.00 to 0.30
between survey years. What might account for this growth? Were implants introduced in the area
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This level of analysis is important in thinking about how best to plan for future family planning programs
and to advocate for the types of interventions that are needed to strengthen and sustain programs.

Continuation of the Past Trend: Projecting into the Future

The spreadsheet will automatically calculate (on an annual basis) the continuation of the past trend into
the future, 25 years after your last data point, based on the assumption that the past trend will
continue. It is important to keep in mind, however, that the farther into the future you project, the less
reliable your numbers become. Projecting out 25 years provides simply some indication as to where
your program could possibly be years from now if a basic past trend continues.

Note: If you wanted to examine a past trend up to 2015, for example, you can look at the column containing those
figures; assessing figures for up to 25 years is not required for use of the tool.

We can see how the formulas are constructed to project CPR into the future. For example, the image
below shows that female sterilization in the year 2004 is calculated by using the 2003 data point in
Column F and adding the average annual increase (the slope). The tool performs this calculation for
each method for the subsequent 25 years.

One caution is that if the 2003 CPR for a method is already high and the annual increase was also high,
a 25-year projection can produce an impossibly high level of use (even to up to 100% of women).
Keep in mind that even in countries with very strong family planning programs, total CPR rarely
exceeds 70%; the United States, the United Kingdom, and South Affrica have total CPRs of 72.8%,
82.0%, and 60.3%, respectively (UN, 2009). Not only may the projection for total CPR rise too high, it
may also do so for the subtotals for modern methods and for LA/PMs. Likewise, a significant decline
for a particular method may produce a projected CPR of zero within a few years. Therefore, you must
inspect each method’s projection to decide how likely it is and analyze the outcomes accordingly.

[25 A fe =hAKD N3 E25+4A025)
A, g | c | o | E | F | [E; 1
Average Annual
IncreaselDecrease
First Last For Past Trend to
Data Data Be Used in

12 P oint Point Formulas for

13 |CPR 1998 2003 2004
14 [Pill 2.60 az’ 0.1z 332
15 |Injectable - two-month o 0.oa 0.0
16 | Injectable - three-month 2.50 g40" 0.va T.18
17 | Male Condom 0.a0 1a0F 0.z 212
12 | Femnale Condom . 0.00 000
19 | 5Standard Days Method F 0.0 0.a0
20 | Any Trad. or Folk 7.00 4507 -0.42 412
21 |Implant - Maorplant, Jadellg 0.0 oz’ 0.0& 0.36
22 | Implant - Implanon o .00 000
23 | Implant - Sinc-implank (1) i 0.0 0.a0
24 [IuD 0.40 nzn” -0.04 016
25 | Female Sterilization 140 2on” 012 212
26 | Male Sterilization 0.00 nan” 0.00 n.on
27 | Otker P o) 000
28 | Other 2 a 000 000
24

30 | AnyMethod - - - F uamF o izen F nFE 1338
3| Any Maodern Method - - - .70 1400 F 126 1528
32 | AllLAIPRS - - - F ien 260 F 04 2e4
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It is important to note that the formulas have been constructed to ensure that the CPR of any given
method will not go below zero, even if a sharply negative trend is occurring; they will also not exceed
100%, even if a sharp increase is projected. Clearly, that would indicate that early trends cannot
continue at the same annual rate. An important caution is to examine the trend for the total CPR, since
the individual method assumptions may drive it too high, far above the average level for strong family
planning programs (1.5% per year).

We can see in the figures below how, given the defined assumptions, the past CPR trend behaves for
every method, based on the average annual increase previously calculated.

13 |CPR
14 | Fill

15 | Injectable - two-month
& |Injectable - three-month
17 [Male Condom

18 | Female Condom

19 | 5tandard Days Method
20 | Any Trad. or Folk

21 |Implant - Marplant, Jadell
22 | Implant - Implancon

23 |Implant - Sino-implant (1)
24 | IUD

20 | Female Sterilization
Male Sterilization

n.on 0.00 0.0
AL 7.6 a7
212 234 256

0.oo 0.00 0,00

0o 0.00 n.0n
412 164 16

036 0.4z 043

n.on 0.00 0.0

n.on 0.00 n.0n
016 niz 0.0z
212 2.4 236

n.on 0.00 n.on

0.00 n.0n

0.00 n.on

Any Methiod - - - 2006 | 2094

31| Any Maodern Method - - - 770 1400 52 | 17.vs
32 | AllLAPMS - - - 180 | 250 278 2492

Here we see the projections through 2029, which is the 25-year projection in this example.

& B C D

G

153 |CPR

14 |Fil

15 [Injectable - twwo-month
16 |Injectakle - three-manth
17 [Male Candom

18 |Female Condom

19 |=tandard Days Method
20 |Any Trad. or Folk

2 |lmplart - Morplant, Jadelle
22 limplant - Implanon

23 |Implant - Sino-implant (1)
24 Il

25 |Female Sterilization

26 [Male Sterilization

30 | Any Method
31 | Any Modern hMethod
32 | All LAPMs

20 Reality V' User’s Guide—Version 2 The RESPOND Project



Interpreting the Data: Projected Past Trend Continuation

It is critical to assess projections and ask yourself questions about what they suggest. One may look at
the results and see, for example, that due to the annual decrease in prevalence of any traditional
method, use is projected to be zero in 2013. It is important to think about how likely this is, or
whether there may in fact still be some traditional method use by then. IUD use was also projected to
be zero by 2008; again, it is important to think about how reasonable these numbers are and what they
mean.

If you are only concerned with knowing the projected modern method CPR in 2015, or any other
specific year in the future, all that you need to do is find the column for that year and analyze the
results accordingly. Though the file is set to project to 25 years, it is not necessary to use it beyond the
final year of interest.

The following image, for example, shows prevalence up to the year 2015. We can see that the
prevalence of any method use is 29.40%; modern method prevalence is also 29.40%, due to the annual
decrease in traditional methods. Again, it is important to analyze the data and think about what the
numbers suggest.

Assessing the past trend will help you think about the types of scenarios you would like to test when
projecting and will help put into perspective the goals that have been set.

o, BE | c [ p] E] F ] G H = [ T
Average Annual Projed
IncreaseDecrease
First Last for Past Trend to Be
Data Data Used in Formulas

112 Point Foint for Projections
|13 |CPR 1998 2003 2014 2015
14 Pl 280 3z20” 012 452 4 54
| 15 |Injectable - two-month i 0.0d 0.0a 0.0o
|16 |Injectable - three-month 250 Gan” 0.7a 14.93 15.76

17 |Male Concom 080 140" 022 432 454
| 18 |Female Condom i .00 0.00 0.00

19 |Standard Days Method a 0.00 0.0a 0.0a
| 20 [&ry Trad. o Folk 700 4E0" -0.45 0.00 0.00
| 21 |Implant - Morplant, Jadele poo0 030" 0.06 0.96 102
| 22 |Implant - Implanon i 0.00 Q.00 Q.00
| 23 |Implanit - Sinc-implart (1) i 0.00 0.00 0.00
| 24 [IUD o040 020" -0.04 0.00 0.00
| 25 |Female Sterilization 140 2m" 012 332 344
| 26 |Male Sterilization oon o000 0.00 0.00 0.00
| 27 |Cther 1 d 0.00 0.00 0.00
| 25 |Other 2 d 0.00 0.00 0.00
129 |

30 | Any Method - - - Ma70 Meen 7 0.7a 2810 2940
|31 | Any Modern Methad - - - 770 1400 ° 126 2810 29.40

32 | &)1 AP - - - 180 250" 014 4 28 4 4F

Issues to Consider

As you move forward, be sure to keep in mind your current family planning program context and
capacity. Running projection models can help illustrate future needs, but it is up to the programmer to
think about how the results relate to the current local context in terms of issues such as:
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e Current resource allocation: Will current resources keep up with projected increases in services?
e Stock-outs: Are stock-outs or lack of supplies a barrier to service provision?

e Provider capacity: What level of cadre is able to provide services?

e Community awareness of methods: Do communities know the benefits of all methods?

e Client access to methods: Can clients obtain a variety of methods without having to travel long
distances?

Population Data

Now that you have projected CPR based on your past trend, it is time to explore the relationship
between population data and CPR.

Thinking about programmatic elements such as those previously noted will help you to put the data
into a broader context and to think about how and where you may need to advocate for more funding
and human resources or about where you may need to target interventions to strengthen the family
planning program.

The projected population of WRA or MWRA is a critical component in calculating numbers of users,
adopters, or commodities, as well as service delivery capacity. Most countries’ populations are
increasing, and this will affect those numbers. Data on the numbers of users, adopters, removals, and
commodities are necessary for illustrating what CPR means in terms of numbers, not just percentages.
It also helps to illustrate the impact of a growing population on CPR.

The following example illustrates how population growth can have an impact on users: Country X had
a 31.5% any-method CPR among MWRA in 1998 and a 31.5% any-method CPR among MWRA in
2003. The CPR data seem to indicate that Country’s X CPR stagnated over the five-year period
between surveys. However, Country X experienced population growth over that same time period. In
1998, the population of MWRA was approximately 4.3 million, while in 2003, the number of MWRA
had risen to approximately 5.1 million. The chart below shows that while the any-method CPR stayed
the same between surveys, the population increased, and therefore the number of family planning
users actually increased.

Estimated Difference in
Any-method CPR MWRA Estimated no. of users between
Year among MWRA population users 1998 and 2003
1998 31.5% 4.3 million [.4 million 200,000
2003 31.5% 5.1 million 1.6 million

This example shows that the number of family planning users in Country X grew over time; focusing
solely on CPR leaves the impression that no gains had been made and that the family planning
program had stagnated.

Population Data That You Have to Input

Now that you have completed inputting past CPR trend data and projecting future CPR, it is time to
input the population data needed to calculate the numbers of users and adopters for any given year
and method. You must be sure to input the number of WRA or MWRA, depending on which you
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decided to use as your basis for planning. As noted above, most projections use MWRA, but if you use
WRA, you must also use CPR based on WRA.

We can see from the following image that Row 36 of the Past Trend Continuation worksheet contains the
number of MWRA in this example. You will then need to input the projected population figures into
these green cells going out 25 years, or until the year in which you are interested. It is very important
that you always double-check your population figures to make sure that they were input correctly.
Again, as this input is connected to formulas throughout the worksheet, any inaccurate data entry here
will result in faulty projections.

Average Annual
IncreasefDecrease For
First Last Past Trend to Be Used
Data Data in Formulas For
Foint FPoint Projections

CPR 1998 2003 2004 2005 2006
Fill 260 220" 0.1z 232 344 156
Injectable - bwo-month i 0.an 0.a0 0.aa 0.0
Injectable - three-month 2.50 g40" 0.ra [AL] T.96 a4
Iale Candom 0.20 1307 0.2z 212 234 256
Female Condom - Q.00 0.0o 0.00 0.00
Standard Days Method i 0.an 0.a0 0.aa 0.0
Any Trad. ar Folk, 7.00 4e0” -0.42 412 164 16
Implant - Morplant, Jadelle 0.0 oz’ 0.0& 0.36 0.42 0.4%
Implant - Implanon H 0.an 0.an 0.0 0.oa
Implant - Sinc-implant (1] i 0.an 0.a0 0.aa 0.0
o 0.40 nzo® -0.04 016 niz 0.0&
Female Sterilization 140 zm” 0.1z 212 2.24 236
Iale Sterilization 0.00 noo® 0.00 0.00 0.00 0.00
Cither 1 r 0.00n 0o 0.00 0.00
Cither 2 H 0.00 0.00 0.00 0.00
Any Method - - - F uwnF e F 072 13.28 20,08 2094
Any Modern Method - - - .70 oo F 1.26 15.26 16.52 17.78
AllLAIPRAS - - - F = F 260 F 014 2E4 278 2az
Population Data:
Mumber of 0 1] L] 1998 2003 2004 2005 2006
MYRA SR8,289 1028782 Copy Fram Caleulator 1,065,414 1106120 1142954

The Reality \ CD-ROM includes an Excel file titled “Calculators” that contains two calculators to help
you calculate the population of WRA or MWRA. These are:

1. The Growth Rate Calculator
If you have age- and sex-specific population data for one year in your geographic area of interest
(i.e., a recent census that provides data for your region or district), as well as an estimated growth
rate, this calculator can calculate an estimate of the population of WRA for your years of interest.

2. The National Population Calculator
Occasionally, you might want to look at scenarios at the national level. This calculator uses 2008
United Nations population data to calculate the population of women in any age range for any
country.” Country-specific data from the most recent DHS or from Profiles for Family Planning and
Reproductive Health Programs (Ross et al., 2005) provide data on the percentage of women of repro-
ductive age who are currently married or in union. No data inputs are required for national-level

* Population data used in Reality \ were provided with the permission of the United Nations Population Division. Sozrce:
United Nations, Department of Economic and Social Affairs, Population Division, 2009.
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population estimates. However, the tool provides you with the option to calculate an estimate of
the population in your geographic area of interest, by entering an estimated percentage of the
national population that resides in your area of interest.

Prior to using either of these tools, ensure that you have enabled macros in Excel on your computer
by following the steps listed on pages 6—7 of this guide.

Calculate the Population of WRA Based on Growth Rate

Population Data That You Have to Input

e Tirst, you will need to input the range of years for which you need population data (the range of
years for which you will want to look at contraceptive trends in Reality v, including the years for
which you are using CPR data).

e You also need to enter age- and sex-specific population data for your region of interest for one
year within your target age-range. In general, we will want the number of married women between
the ages of 15 and 49. While this information can often be found in the latest national census
report, it is often not broken down into age-groups by sex, particularly if it is only a preliminary or
summary census report. If this is the case, it may be simplest to calculate the percentage of the
national population residing in your area of interest (by dividing the population of the area by the
total national population) and use the National Population Calculator, described below.

e Tinally, you will need to input an estimated population growth rate; this information is often found
in census reports.

Follow the steps outlined within the calculator itself. Enter data only in the blue cells.

1. Enter the first and last years for which you want to calculate population data.

e In the Past Trends Continunation sheet, the first year will be the year of your most recent data
source, in Cell F13 (for example, if using a 2005 source as your most recent data point, your
population figures will need to start from 2005). The last year for which you want to calculate
data will vary based on your needs; if you are interested in continuing past trends through
2015, for example, the last year would be 2015.

e In the Future Goals sheet, the first year will be the year of your most recent data source (Cell
D14) and the last year will be the year for which you want to test a CPR goal (Cell C14).

Enter the year for which you have population data (the year in which the data were collected).

Enter the population of WRA or MWRA in your geographic area of interest.

Enter the estimated rate of population growth.
Click on the “Calculate” button; the estimated population of WRA of MWRA for each year will be
generated below.

AR N
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Calculate using growth rate projection

Define the year range for which you will need population data fo 2020

Define the year for which you hawve population data 2017

Enter the population data that you have 44,444|

Enter the annual percentage population growth rate 1.58%

Indicate whether you want to look at all women of reproductive age (WRA) or just married
women of reproductive age (MWRA).

M wRrA or M MWRA

If you have selected MWRA, please enter the percentage of WRA
who are married: A0%

Calculate

See the below example, in which we calculate the estimated population of WRA between the years
of 2005 and 2010, based on a population of 100,000 in 2005 and an estimated growth rate of 1.5%.

~alcul . : i

Define the year range for swhich you swill need

Step T population data 2005 to 2010
Step 2 |Define the year for which you have population dats

Step 3 |Enter the population data that ywou have | 1|:u:|,|:u:u:||

Step o |Enter the annual percentage population grovwth rate 150

Indicate whether you want to look at all women of reproductive age (WRA) or
Step 5 just married women of reproductive age (MWRA).

CwWRE or MOMMARS

If you have selected MWRA, please enter the -
percentage of WRA who are married: G0

Step 6 || Calculate "

Projection for 2005 - 2010 using & population of 100,000 from
Population Growth Rate Result yesr 2005 with a growth rate of 1.5% and MARA, rate of S50%
2005 2006 2007 2008 2009 2010
f0,000 a0, 750 51,511 02,284 53,068 53,064
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After verifying that the data look correct, move back to the Reality \ workbook. Immediately before
the green population cells for the years beyond your most recent data point, select the “Copy from
Calculator” button, and your population values generated in the Calculator should automatically
populate the corresponding cells.

Population Data
35 [Humber Indicates: 2004
36 | MWRA Cogry From Calculator 1,065 414

Alternatively, you could copy and paste the figures from the Calculator workbook into the green
population data cells in Reality V.

Note that, in the Past Trends Continnation sheet, if you would like to view data for the years prior to the
year of your most recent data source (past years), the “Copy from Calculator” button will not bring
these figures over from the calculator. Rather, you will need to copy and paste the values generated in
the calculator into the population cells in Reality V. In the example on page 23, for example, the
population values for 1998 (Cell E36) will not be imported automatically, while the values for 2003
and beyond will.

Also, if the years for which you generate population data in the calculator do not correspond with the
range of years you have entered in Reality v, you will receive an error message. If you change the years
entered as your data sources, any population values will be erased and the process will need to be
repeated.

This tool can be used to calculate WRA population estimates at any geographic level (national,
regional, district, clinic catchment area, etc.), provided that you have an estimate of population data for
one year as well as an estimated population growth rate.

Calculate the Population of WRA Based on United Nations Population Data

This tool uses United Nations population data from 2008 to calculate the national population of
women (married or all) in your age range of interest in the country you select.” ¢

National Population Data That You Have to Input
e No data input is required if you wish only to calculate the population of WRA (married or all) at
the national level.

e If you wish to estimate the number of WRA in a particular region or district, you will need an
estimate of the percentage of the national population that resides in your area of interest.

Follow the steps outlined within the Calculator itself. Select options from the drop-down menus in the
blue cells.

> Population data used in Reality V were provided with the permission of the United Nations Population Division.
Source: United Nations, 2009.

¢ Data on the percentage of women of reproductive age who are married or in union are obtained from the most recent
DHS for each country. If this information was not available through the DHS, data were obtained from Ross et al.,
2005.
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1. Select your country from the drop-down menu, as shown below.

Ethiopia -
El Salvador -
Equatorial Guinea
Eritrea
Estonia
Fiji
Finland
France i

2. As with the calculator based on growth rates, enter the first and last years for which you want to
calculate population data.

o In the Past Trends Continuation sheet, the first year will be the year of your most recent data
source, in Cell F13 (for example, if using a 2008 source as your most recent data point, your
population figures will need to start from 2008). The last year for which you want to calculate
data will vary based on your needs; if you are interested in continuing past trends through
2015, for example, the last year would be 2015.

e In the Future Goals sheet, the first year will be the year of your most recent data source (Cell
D14) and the last year will be the year for which you want to test a CPR goal (Cell C14).
3. Select the range of ages of women for which you will need population data. (In general, we will
look at women between the ages of 15 and 49 as women of reproductive age.)

4. Indicate whether you would like to look at all WRA or only at those who are married.

e If you select MWRA, you can use the default percentage of WRA that are married that will
automatically appear in the box (from the most recent DHS), or you can enter your own
percentage.

5. Indicate whether you wish to view data for the national level or for another geographic level.

e If you select the “other geographic level” option, you will need to enter the percentage of the
national population that resides in your area of interest. This can be calculated by dividing the
population of the area of interest by the total national population; these figures can usually be
obtained from the most recent census report.

6. Click on the “Calculate” button.

7. Tollow the steps outlined above to copy the values into the green population cells in Reality V by
using the “Copy from Calculator” button. Be sure that the years for which you calculated
population data align with the years in Reality v, or you will receive an error message.

See the example on page 28, in which we calculate the population of MWRA between ages 15 and 49
in a specific region that comprises 11% of the population of Ethiopia for 2005 to 2010. We use the
default value of 64.5% of women being married, but we could enter another value in the box if we
wished to.
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Step 7 | Country |Ethil:|pia

Step 2 ear Range to 201
Step 3 Age Range to 45-4

Indicate whether you want to look at all women of reproductive age
Step 4 (WRA) or just married women of reproductive age (MWRA).

CWRA o ¥ WMARA

ge);g:nf;g;: i,efh\e,f/t;g m,‘g”},’:\e ﬂggfg; nter the B4.5% | (the country's default percentage is provided

!!

Step 5|1 Mational population or ¥ Other geographic-level popula

If you select other geographic-level population,
enter the percentage of the national population

that lives in this area: 11%
Step 6 ( Calculate |
- After clicking the “Calculate” button, copy andPaste the values generated below into the green
Step 7 “Population Data” cells in Reality

Ethiopia from 2005 to 2010 in the age rande 15-19 to 45-49 for the
Eesult Data Set B4.5% married women with 11% of the national population
2005 2006 2007 2008 2009 2010
1205089 1244100 1284953 1327400 1371101 1415761

Upon verifying that the numbers look correct, we would then use the “Copy from Calculator”
button to paste the values into the green population data cells in Reality V

For more specific information on how to obtain or calculate population data estimates needed for

Reality \, see Appendix A: Population Data (page 73).

Population data are linked to all other levels of analysis, so we will now move on to the Number of Users
to explore how population growth impacts family planning programming.

Number of Users

After inputting the number of WRA or MWRA, it is time to quantify CPR in terms of users. Again,
while CPR itself is important, calculating the number of users by method helps to quantify and
illustrate what CPR #zeans for the demands upon a program.

While we saw a simple example above of the relationship between CPR and population, the actual
formula for calculating the number of users is:

e MWRA*CPR/100, ot
e WRA*CPR/100, where the CPRs pertain to the percentage of all women using a method
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The following example shows the projected number of female sterilization users in 2015. We can see
the calculation in the formula bar, and the blue line denotes the two fields linked to the calculation for
the CPR and for MWRA:

e Number of MWRA * female sterilization CPR/100

T53 - £ =T$36"T25/100
A E | F | ] H R’ [ s | T |
13 |CPR 1998 2003 2013 2014 2015
14 | Fill 2,50 3m’ 0.1z 440 452 454
15 |Injectable - two-month I 0.0 0.a0 0.aa 0.a0
16 | Injectable - three-month 250 g40" 0.73 14.20 14,93 15.76
17 | Mlale Condom 080 190" 0.2z 4.10 432 454
18 |Female Condom s 0.00 0.a0 0.q0 0.a0
19 | Standard Days Method I 0.0 0.a0 0.aa 0.a0
20 | Any Trad. or Folk 7.00 40" -0.48 0.0a 0.00 0.0a
21 [Implant - Marplant, Jadelle 0.an oz’ 0.0& 0.0 0.96 1.02
22 |Implant - Implanon s 0.0 0.a0 0.aa 0.a0
23 |Implant - Sino-implant (I I 0.0 0.a0 0.aa 0.a0
24 |1UO 040 nz” -0.04 0.0a 0.00 0.0a
26 | Femnale Sterilization 140 oo™ 0.1z .20 3.3z r 344
26 | Male Sterilization 0.on oo 0.00 0.0a 0.00 0.0a
27 | Other 1 I 0.00 0.0a 0.00 0.0a
28 | Other 2 s 0.00 0.0a 0.00 0.0a
24
a0 | Any Method Foum®  wee P 0.7e 2680 2210 29.40
3 | Any Modern Method 7.70 o0 F 126 26,80 2810 29.40
33 AllLAIPRS R 2an F 014 410 428 446
35 | Population Data: Number of 1998 2003 2013 2014 2015
36 | MWRA BR8.289 1,026,782 Copy From Calculator 1470,483 1516,E17 + 1562745
Reszize Columns to Fit

ar
L]
339 |NUMBER OF USERS

Last

Data
40 FPoint
41 1998 2003 2012 2014 2015
53 | Female Sterilization 12,06 20,536 47 056 50.352' [k ?58!

Interpreting the Data: Number of Users

We know from the earlier trend analysis that female sterilization utilization was increasing by 0.12
percentage points annually. You may have thought “0.12 points is not much at all” or “increasing
female sterilization usage by 0.12 points annually should not be that difficult”; this is where looking at
the numbers of users and adopters becomes extremely useful.

In this example, female sterilization prevalence in 2014 is 3.32%, which equals an estimated 50,352
female sterilization users.

In 2015, the prevalence is projected to be 3.44%. However, because the number of MWRA rose, there
would be an estimated 53,758 users in 2015. Thus, because of the increase in MWRA, an increase in
prevalence of a mere 0.12 percentage points means an increase of 3,400 users in one year. Keep in mind
that this increase in users may require more adopters than 3,4006; this net increase in users must account
for the number of sterilized women who age out of the reproductive age-group.
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We can look at an example of resupply methods to solidify the importance of examining users. We
see from the following image that pill users are calculated in the same way. All of the cells pertaining
to the projected number of users are formulated in the same way throughout the worksheet; they all
link to the number of MWRA*CPR/100.

T4 - B =TE3E*T14/100
A E | F | ] F-r [ s | T I
13 |CPR 1998 2003 2013 2014 2015
14 | Fill 2.E0 zz0” 0.1z 4.40 4.52 r 454
15 |Injectable - two-month I 0.0 0.a0 0.aa 0.a0
16 | Injectable - three-month 2.A0 g40” 0.va 14.20 14.498 15.76
17 | Male Condom 0.0 130" 0.zz2 4.10 4.3z 4.54
18 | Female Condom F 0.00 0.00 0.00 0.00
19 | Standard Days Method I 0.0 0.a0 0.aa 0.a0
20 | Any Trad. or Folk, T.00 4e0” -0.48 0.00 0.00 0.00
21 [Implant - Marplant, Jadelle 0.an oz’ 0.0& 0.0 0.95 1.02
22 | Implant - Implancon F 0.00 0.00 0.00 0.00
23 |Implant - Sino-implant (11 I 0.0 0.a0 0.aa 0.a0
24 | 1UDO 040 oz’ -0.04 0.00 0.00 0.00
20 | Fermnale Sterilization 140 zm” 0.1z 3.20 R 344
26 | Male Sterilization 000 oo’ 0.00 0.00 0.00 0.00
27 | Other 1 ' 0.00 0.0o 0.o0 0.0o
28 | Other 2 L 0.00 0.00 0.00 0.00
29
20 | Any Method 14.70 12E0 F 0.ra 26.80 2810 29.40
3| Any Modern Method T.ro o0 F 126 26.50 28.10 29.40
32 | AllLAPMSs 1.80 zh0 F 0.14 4.10 4.28 44K
k]
35 |Population Data: Number of 1998 2003 2013 2014 2015
36 | MWRA BRE289  102ETEZ Copy From Calculator 1470429 1516.617 +  1BEZ 745
Resize Columns to Fit

ar
1]
39 |NUMBER OF USERS

Last

Data
40 Foint
H 1998 2003 2013 2014 2015
42 | Fill 22,316 32,857 B4 702 E3,551 ¥ 2,51

This shows that pill prevalence of 4.64% in 2015 means that there will be 72,511 users in 2015. We
saw from the trend analysis that pill prevalence was calculated to rise by 0.12 percentage points

annually, so the 0.12 percentage point increase in prevalence translates into an increase of 3,960 pill
users between 2014 and 2015.

Again, explore the projections and think about what the numbers indicate. It is important to think
about the projection in the context of family planning programming and the likely implications for
access, resources, services, etc. Before continuing with further discussion and analysis on what user
numbers can illustrate, it is important to look at numbers of adgpters. Calculating the number of
adopters (new users) will shed more light on how to understand the number of users. The strong
relationship between the various levels of analysis becomes increasingly apparent as we move
through these steps.
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Number of Adopters (New Users)

We have seen how the number of projected users is calculated, but to actually attain a given number of
users in any one year, we have to account for various factors.

New adopters are needed each year for three reasons: to replace those who discontinued since the
previous year (as well as sterilization users who pass age 49); to allow for the rise in the CPR; and to
allow for population increase in WRA or MWRA. These three sources of adopters (new users) pro-
duce the projected increase in users for the next year. The Excel worksheet shows the growth in users
needed from one year to the next due to the CPR rise and population growth, and the number of
adopters needed is this increase plus an allowance for dropouts from the previous year. The formulas
in each cell for adopters correspond to that.

Thus the formula for calculating the number of adopters in a given year is:
(Number of users in the current year — number of users in the previous year)
_l’_
(Number of users in the previous year * discontinuation rate)

Note that if a current user switches to a new method, she is considered an adopter (new user) for that
method. For example, if a woman has used injectables for a decade but has an IUD inserted this year,
she is an adopter (new user) of the IUD (and a discontinuer of injectables).

The following examples will help show the application of these formulas and the relationship between
users and adopters. First, we will explore discontinuation.

Discontinuation

Discontinuation rates impact the programmatic decisions you make. Discontinuation will always be a
factor with contraceptive methods, for a range of reasons: People may not be satisfied with their method,;
the partner may not like the method; people may lack access to a method; a couple may want to have
another child; a couple may switch to another method; or the user may no longer need contraceptive
protection. However, health service providers can reduce discontinuation by taking such measures as
offering thorough counseling, so that clients know what to expect from their method. It is important for
programmers to assess why clients discontinue their method, so the reasons can be addressed
accordingly.

Discontinuation rates are calculated here by estimating the percentage of all users who cease use in a
12-month period. If you have local data on method-specific discontinuation rates, you can use those.

Discontinuation data may also be available through the DHS and are also included in Appendix E of
this guide (page 103). If you do not have local data on discontinuation rates, you can use average
international rates, which are already included in the green cells in Reality V:

e Pill 0.50
e Injectable’ 0.50
e SDM 0.40

7 Previous international estimates indicated that the discontinuation rate for injectables was approximately 0.40. However,
our examination of DHS data from 35 surveys in 19 countries suggests that the average discontinuation rate is higher, at
approximately 0.50.
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e Condom (male and female) 0.50

IUD 0.28
Implant (Norplant or Jadelle) 0.28
e Implant (Implanon) 0.48
e Implant (Sino-Implant (II)) 0.28
e Sterilization 0.10

These rates are based on the following factors:

e Discontinuation rates for resupply methods (pill, injectable, and condoms) consist of the
percentage of users who stop relying on a method over a one-year period.

e The discontinuation rate for SDM (also known as Cycle Beads) also refers to the percentage of
users who stop using the method in a one-year period. It is important to point out that this is a
new method currently being introduced in many settings. The discontinuation rate given here is
based on initial work done with the method and may be a conservative estimate. For more
information on this method, please see the Institute for Reproductive Health, Georgetown
University (www.ith.org/RTP-SDM.htm).

e For the IUD and implant, the mean percentage discontinuing is estimated by calculating the
reciprocal of the mean duration of use (the duration of use is also linked to the CYP factor). Thus,
current estimates indicate that IUD users employ the method for approximately 3.5 years; dividing
1 by 3.5 produces the percentage of users who drop out per year. This approach suggests that
approximately 28% of IUD users drop out from using the method in any given year (Ross et al.,
2005).

e Implant discontinuation is calculated in the same way as for the IUD. Estimates for five-year
implants indicate that women use them for approximately 3.5 years (again, the duration of use is
linked to the CYP factor). Dividing 1 by 3.5 produces the percentage of users who drop out.
Again, approximately 28% of implant users drop out in any given year (Ross et al., 2005). If your
program is switching to an implant such as Implanon, which can be used for up to three years,
then you could estimate that in actual practice, duration of use may be approximately 2.1 years.
You would therefore divide 1 by 2.1 to obtain the percentage of users who drop out annually
(48%). (Because information on Implanon use is limited, the Implanon estimates used here are
calculated based on average Norplant use.”)

While one does not discontinue using sterilization, its discontinuation rates actually refer to the
percentage who age out of the reproductive cycle after age 49. International estimates indicate that a
user relies on sterilization for approximately 10 years before aging out.

We can see from the numbers above that resupply methods have higher discontinuation (or dropout)
rates than do LA/PMs. Discontinuation rates can significantly impact the number of adopters needed
each year to match a projected number of users. These estimates are also based on CYP factors (see
Ross et. al., 2005, B.1). See Appendix D for more information on CYP.

For more information on discontinuation, see Stover et al., 2000, and Ross et al., 2005.

8 A systematic review of subdermal implants noted no difference in continuation rates between Implanon and
Notplant. In four studies covering a total of 625 women, 87% of Implanon users were continuing to use the method
at three years. This translates into an average duration of use of 2.6 years. (See: Power et al., 2007.)
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Relationship between Users, Adopters, and Discontinuers

The relationship between users, adopters, and discontinuers is simple but can be confusing.

Consider the following analogy:

e If we fill a bucket with water, we can consider all of the water in the bucket to be our users;
these are all of the individuals who use a method.

e The percentage of the bucket that is filled with water represents our CPR; to achieve a higher
CPR, we need to add water to the bucket (increase our number of users).

e However, our bucket has a small hole through which water leaks out; all of the water that spills
out represents our discontinuers. These are individuals who stop using a particular method for
any reason.

e To increase our CPR (or just to maintain it, because of discontinuation), we need to add more
water to the bucket. The water that is added represents our adopters—the individuals who
begin to use a method within a given year.

Note that if we were to reduce the amount of water that left the bucket through the leak (ie.,
reducing the discontinuation rate), we would need to add less water to compensate for the leak (i.e.,
we would need to add fewer new adopters).

Discontinuation Data That You Have to Input

Reality V provides default discontinuation rate data in the green cells in Rows 65 through 79,
although you may use different rates if you so choose. Column G to the right shows the cells in
which you could include the discontinuation rate for each corresponding method.

A, e
Method-Specific

G2 |HUMBER OF ADOPTERS (HEW USERS) Discontinuation Rates
G

B

BS | Pill 0.50
E6 |Injectable - two-month 0.50
&7 |Injectable - three-month 0.a0
B3 |Male Condom 0.s0
63 [Fermale Condotm 0.50
70 | Standard Days Method 0.40
71 | Any Trad. ar Falk 0.65
72 |Implart - Morplant, Jadelle 0.28
73 |Implant - mplanon 0.4a
74 |Implant - Sino-implant (D 028
¥ 1D 0.25
76 |Female Sterilization 040
F¥ | Male Sterilization 010
7 [Cther 1

73 [Cther 2

To illustrate the link between adopters and users, we can look at an example for a resupply method.
We will continue with the example of the pill in the year 2015.
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TES - A =MAX(D,(T42-5421+($GEE"542))
A G H R = T

| 39 |HUMBER. OF USERS
40
41 2013 2014 2015
|42 |Fil g4 702 T 2N
| 43 |Injectable - twao-manth 1] 1]
| 44 [Injectable - three-month 208,809 246 289
| 43 [Male Condam 50,290 70545
| 46 |Female Condom 1] 1]
| 47 |Standard Days Methood 1] 1]
| 48 |Any Trad. or Folk 1] 0
| 49 |Implant - Morplant, Jadelle 13,234 15940
| 50 |Implant - nplanon 1] 1]
| 521 |Implant - Sino-implant (0 0 1]
| 32 (D 1] 1]
| 93 |Female Sterilization 47 036 33,753

34 |Male Sterilization 1] 0

55 [CrtheH 1] 1]
| 36 [Cther 2 1] 1]
57
| 58 | &ny Method 394,091 426 169 459 447
|59 | Any Modern Methaod 394,091 426169 50,447

GO0 | Al LAPKMS 50,290 G4 511 9 655

Method-Specific

| 62 [HOMBER. OF ADOPTERS (HEW USERS) Discontinuation Rates

63
| G4 | 2013 2014 2015

65 |Pil s | s 7778 s 7433 Wl WV 5

We see that in Cell T42, there are 72,511 pill users in 2015.

These 72,511 pill users in 2015 represent a total of:

1. The number of women who continued using the method between 2014 and 2015

2. The number of women who contributed to the increase in pill prevalence by 0.12 percentage
points between 2014 and 2015

3. The increase in the number of MWRA in the population base

However, even more adopters are needed to replace users from the previous year who discontinued
use. Therefore, we can see (in Cell T65) that 38,326 MWRA must adop? the method in 2015 to produce
the 2015 total of 72,511 pill users. This is calculated using the following formula:

(Number of pill users in 2015 — number of pill users in 2014)
+

(Number of pill users in 2014 * pill discontinuation rate)
In terms of cell locations, the formula is: (T42-842)+(G65*S42)

We will continue with the example of female sterilization in the year 2015 to examine the impact of aging
out on the number of adopters.

The image on page 35 shows the number of adgpters needed in 2015 in order to reach a total of 53,758
female sterilization users in 2015. We can see that the formula is linked to the number of users in the
previous year.
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176 M A =MAX(D,(T53-S53)+($GTE*S53))

& G H R | = T

39 |HUMBER. OF USERS
40
41 2013 2014 2015
53 |Female Sterilization 47 056 850352 #53 758
B

HUMBER. OF ADOPTERS {HEW Method-Specific
62 |USERS) Discontinuation Rates
53
) 2013 2014 2015
7E |Female Sterilization * B T FHEa= 84421

Interpreting the Data: Number of Adopters

In this example, to make up for the numbers of sterilization users who age out and to allow for the
increase in MWRA in the population base, a total of 8,442 MWRA will need to adopt the method in
2015 to raise the overall number of users from 50,352 to 53,758.

Given that the sample projections here pertain to the district level, 8,442 women accessing female
sterilization services in one year could have a dramatic impact on the service delivery system. If, for
example, only two sites in the district can provide female sterilization services, the 0.12% increase in
female sterilization prevalence may not be achievable. Later in this guide, we will revisit this example to
examine further how this increase impacts the service delivery system’s capacity over time.

In going through the various levels of analysis, it becomes clear that projections are useful in esti-

mating future family planning needs. Looking at an increase in the number of users and adopters raises

issues you need to consider, such as:

e What do these numbers mean in terms of commodities and resource requirements?

e Can the current service delivery system handle this type of projected client load?

e Is there a way to move services to lower levels in the service delivery system, so that clients can
access services more easily? Would providing some methods in the community free up higher level
cadres to offer more LLA/PM services, such as IUDs or sterilization?

Before delving deeper into these questions, it will be helpful to look at projections of commodities and
of service delivery capacity.

Removals

For most contraceptive methods, discontinuation simply means that the client stopped using the method
on his or her own; a client stops taking the pill, for example, or does not return for more injections.
However, for the implant and the IUD, a woman who wishes to discontinue use must return to a health
facility to have the device removed by a health professional. For all types of implants, it is important to
know how many clients will return to have their device removed each year. By applying the annual
discontinuation rates to the number of users for these methods, we can estimate the number of clients
who will want removals for each type of implant each year. Reality V will automatically calculate the
number of implant removal clients, based on the number of users and the discontinuation rates.”

® Version 2 of Reality v does not calculate the annual number of removals for the TUD, given the method’s potential
long-term use (10 or more years), compared with the potentially shorter use of implants (five years or less).
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Removal Data That You Have to Input

e There are no removal data that need to be input into Reality v, although you can change the
discontinuation rates for each method, if you prefer. Provided that CPR and population data are
entered above, the tool will automatically generate removal estimates.

Reality V will automatically populate o ©
the green “method-specific discon-
tinuation rates” cells, based on the

discontinuation rates above in the Method Specific
. 55 |AHHNUAL REMOVAL CLIENTS Discontinuation Rates

Adopters section. If you choose to [

use different data, just erase the |[g7

values in the green cells and enter |88 [Implant - Morplart, Jadelle 028

your values. 29 |Implant - Implapnn 0.4s
a0 [Implant - Sino-implant (0 0.28

To illustrate the link between users and the number of removals, see the example below. There are
13,234 implant users in 2013 (Cell R49). This total represents a total of the number of women who
continued to use the implant between 2012 and 2013, the number who contributed to the increase in
implant prevalence between 2012 and 2013, and the increase in the number of MWRA in the
population base.

To calculate implant removals, we simply apply the discontinuation rate to the number of users for an
estimate of the number of users who will discontinue in the year.

The formula for calculating removals is:

Number of usets
*

Discontinuation rate

In this example, the cell formula is G88*R49.

=88 - e =GEBETR4Y
A, G W R s |
3 |NUMBER OF USERS
40
4 2013 2014
49 |Implant - Morplant, Jadelle 13,234 14 5E0

4

Method-Specific

825 | ANNUAL REMOYAL CLIENTS | Discontinuation Rates
86
a7
88 |Implant - Morplant, Jadelle * (Ernl]

Note that in the example at the top of page 37, if we decrease discontinuation rates in the green cells,
even only slightly, we will have fewer removal clients to serve each year. In this example, if the
discontinuation rate decreases to 0.18 from 0.28, we will have more than 1,000 fewer removal clients in
2014 than in the previous year.
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S84 - A =GBE"R49

A, G [ g |
33 (NMUMBER OF USERS
40
41 2013 2014
49 |Implant - Morplant, Jadelle 13,234 14,560
a4

Method-Specific

25 | ANNUAL REMOYAL CLIENTS | Discontinuation Rates
26
ar 2013 2014
28 |Implant - Morplant, Jadelle 013 2,154 2,382

Commodities and Supplies

Now that the numbers of users and adopters have been calculated, it is important to determine the
corresponding numbers of commodities for short- and long-acting methods and supplies for perma-
nent methods that are needed.

Commodities and supplies for LA/PMs are simply equal to the number of adgpters in any given yeat.
Commodity and supply needs for the IUD, the implant, female sterilization, and male sterilization are
all calculated in this way. (See below for example.) SDM is also calculated in this way.

T106 - B =T7hH
& G H R | s | 7

Method-Specific
§2 |HUMBER OF ADOPTERS (HEW USERS}) Discontinuation Rates
63
G4 2013 2014 2015
72 |Implant - Morplant, Jadele 028 4620 ¢ 5031 5 457
76 |Femsle Sterilization 010 7572 g002 ¢+ 8442
1

Commodities Per
92 |COMMODITIES User
93
94 2013 2014 2015
102 |mplant - Morplart, Jadele ag20) ¥ 503 5457
106 |Female Stetilization 7572 gooz v sa4a2

Commodity and supply needs for resupply methods are calculated differently, in that such calculations
are based upon the numbers of users. Thus, it is important for your program to account for wastage,
due especially to the fact that pills and condoms may be received but not used. (This is not done for
the injectable, since it acts for three full months once received.) Pill users are typically handed three
cycles at a time, and with high discontinuation rates, many of these cycles are never used. The same is
true of condom supplies given to adopters and users.

The image at the top of page 38 shows a sample of the calculations for pills and injectables.

e In this section of the worksheet, for resupply methods, you will have to input the estimated
number of commodities a user would need over a one-year period. You can base these figures
upon local CYP factors, or you can use the international estimates included here (Ross et al., 2005).
o These figures are input into cells G95-99.
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=48 - e =S45%4GA8
& G H Q R 5
39 |HUMBER OF USERS
40
41 2012 2013 2014
42 |Fil + 0,953 G4,702 £5,551
#4 |Injectakle - three-marth 191,149 ¢ 205,809 227183
45 |htsle Condom 55 255 B0,290 ¢ B5518
Commodities Per

82 | COMMOMTIES User
a3
94 2012 2013 2014
35 |Pill cycles * t5—= 914440 | 970,523 1,025,266
97 |Injectakle - three-marth * 4 FoESH—= 935,235 |908.757
95 |Male Condom MR HERE——2SaaE— SE2, 143

e Pill commodity needs are estimated by calculating that a user will require approximately 15 cycles
per year. Therefore, the number of #sers in a given year is multiplied by 15.

o Formula=Q42*$G95

e Condom commodity needs are calculated by multiplying the number of #sers in a given year by 120
(the international estimate for the number of condoms a condom user will use annually).

o Formula=R45*$G98

e Injectable (three-month) commodity needs are calculated by multiplying the number of users in a
given year by four (the number of injections a user will need annually).

o Formula =544¥§G97

Costs

Utilizing commodity and supply data, you
can project how much commodities will
cost, or if you have more comprehensive
data on the total per-user cost of providing
a service, you can project the total cost to
your program to provide the services. This
is crucial to adequately plan and advocate
for the resources needed for family
planning.

Cost Data That You Have to Input

International average per-unit commodity
and supply costs are included as defaults in
Reality V. However, you can use local cost
estimates for each method and input those
costs into cells G117-131. Here,
international costs are shown in U.JS.
dollars (UNFPA, 2005; USAID, 2007).
(See Appendix B: Commodity Costs [page
79] for more information.) It is important
to note that the commodity costs indicated
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COMMODITY AND SUPFPLY COSTS

Average meerRalicnal commeaitr
NG SyARAE cosis are facfuded a5
gefanits in Foalicg « . & yoou dave
Fere aF o oG aiE aRE SURRIE cosls,
oF A ot Aave more complele per-
oai sarpics delivery cosis fthal
Mmefode fador, cverdead, afe b
=Ampfy repface e sefanfs eosls in
Coffe CFIF throagd CFTF with goor
oW CiTSS,

Fill Cyles

Injectable - two-month

Injectable - three-month

Fale Condam

Female Condom

Standard Days Method

Any Trad. or Falk

Implant - Morplant, Jadelle

Implant - Implancon

Implant - Sino-implant [11]

(8]}

Female Sterilization

ale Sterilization

Other 1

Cither 2

Commodity and Supply
Cost Per Unit [US$])

0.4
0.26
0.57

0025
077
118

22.00
24.00
2.00
0.37
3.03
4.95
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here are costs for commodities only; they do not include additional service delivery and distribution
expenses, such as personnel salaries or transport costs to deliver the commodities. These are also only
estimates based on averages. To capture additional costs, such as shipping or wastage, you could mark
up these costs by a certain percentage, based on your local program estimates. The following web sites
can also be useful sources for current per-unit commodity costs:

e The International Drug Price Indicator Guide, produced by Management Sciences for Health,
available at: http://erc.msh.org/mainpage.cfmrfile=1.0.htm&module=DMP&language= English

e The RH Interchange site, produced by the Reproductive Health Supplies Coalition, available at:
http://rhi.thsupplies.org/rhi/index.do?locale=en_US

e USAID family planning costs, on the JSI/DELIVER Project’s Family Planning Product Catalog,
available at: http://deliver.jsi.com/dhome/mycommodities/productcatalog /fpproducts

e UNFPA’s Negotiated Prices for Reproductive Health Commodities, available at: www.unfpa.org/
public/cache/offonce/procurement/pid/3239

You could also estimate the total service cost (labor, supplies, overhead, etc.) by changing the default
values in the green cells to the per-unit cost of providing each service. An Excel-based database of per-
unit service costs in a variety of countries and service delivery modes (based on a literature review
conducted by UNFPA and the Family Planning Costing Initiative) is included on the Reality \ CD-
ROM. Note that this database does not contain costs for all countries, and the costing studies
identified in the literature review used a variety of methodologies to estimate the per-unit cost. This
database, however, can be a useful tool for estimating the per-unit cost; average per-method costs are
located in separate sheets, and study year, country, factors included in cost estimate, and service
delivery mode are also listed. If, for example, you wanted to look at per-visit implant costs, you could
select the “implant” worksheet in the Excel workbook to view the different countries and delivery
modes in which costing studies have been conducted for implants (see image below). A median per-
visit cost is calculated at the bottom of the list of studies.

! Delivery ! of | [Direct])! % of | of | ! % oof |

System! otal Labor ETotal Fac_ tal Capital ;Total
Country ‘I"tar Provider Cost Cost El::ost ;Drtrltadé [ Co=t Cost Dther
LUsSA, 1395 $545.53

MWlesico 1945 i Clinic H F57010 iuin

Zimbabwe i 1995 ; Clinic H] $£54 36 [uin

Plali 1334 | Clinic H 24041 Quin $38.36 96 206 [
H wig
H] Hin

Pali 1994 : Clinic $37.H FI732 1 94 1 029 1=
Thailand {1991 | Hospital $35.00 F33.59 ¢ 96X 142 43
MEDIAH $47.39 $3I732; 96K #1442 4= $0.00 $0.00 $0.00

Other costing tools include:

e The EngenderHealth Cost Analysis Tool, available at: www.engenderhealth.org/pubs/quality/
cope.php

e UNFPA’s Reproductive Health Costing Tool, which can be requested at: www.unfpa.org/
public/site/global/lang/en/pid/3595#costing
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When inputting local costs, be sure to specify the currency type in cell G114.

Sterilization and implant costs appear to be the highest among all methods, but it important to keep in
mind that these are one-time costs. When the one-time LA/PM commodity costs ate compated over a
future-year basis against the costs of resupply methods, LA/PMs are among the most cost-effective
methods, and they reduce the need for resupply.

The costs included here are based on international estimated costs for a commodity or procedure. The
commodity costs in Column G are fixed costs. Therefore, the projected costs do not account for
future inflation.

When projecting commodity costs, please keep in mind that as with all figures projected, Reality\/ was
designed to project estimates to help inform future programmatic decision making; the tool can
provide insight on possible future scenarios only based on the estimated figures and the best data
available at the time the projections were run.

The commodity costs for all methods are linked directly to the projected commodity requirements for
that year. The following image shows the link between cost and the number of commodities.

T127 - A =MAX(T105°$G$127).0)
a e} W a | & [ s | T

32 |COMMODITIES Commodities Per User

a3

a4 2012 2013 2014 2015
35 | Fill Cycles 16 p 914,440 Av0523 1,028,266 1,087 E70
102 | Implant - Morplant, Jadelle 4,224 4620 ¢ BOH 5457
105 | U0 0 ] 0 r ]

12

Commodity and Supply
114 (COMMODITY AND SUPFPLY COST Cost Per Unit [US5%)
N8 | Average imfernaticnal
COTTH G ARG SURRSF cosls are
mefuded 35 defauits in Heality

v K pou dave foeal commoaity
and SupaplE coslfs, or i Fon Aave
TR SORpele pBEr-UAH Serpice
gefiverg cosls frdar incfode
fabor, cverdead afe f simply
repface e Sefauft cosis i
Cedls CHF throagh CL3F with

16 | goreir R cosis 2012 2013 2014 2015
117 | Pill Cycles - £ 192,032 203,210 216,938 22841
124 [ Implant - Morplant, Jadelle Pl ——— e oaR e 1I0ETT 120,057
127 [IUD - B £ & f 1]
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Interpreting the Data: Commodities and Costs

In assessing costs, it is important to think about your existing commodity and logistics system. For

example:

e Has your program experienced stock-outs recently?

e How do commodities actually reach service delivery points?

e Who is responsible for contraceptive commodity procurement?

We can also examine the summary data in terms of the cumulative costs of “any modern method” and
“all LA/PMs.” This will help you to budget and advocate for the necessaty resources to program for
family planning services in the future. It can also help you to assess which methods are cost-effective
for your program. It is important to keep in mind that costs alone should not drive the program; cost
must be balanced with protecting a client’s right to a choice of methods.

The final level of analysis in Reality\/ will concern the service delivery capacity of your program.

Service Provision: Estimated Number of Clients per Month

As you have gone through the process of calculating your past trend and projecting that trend, you
have probably thought about the current service delivery capacity of your program. Now it is time to
look at estimates for the impact of the projected increases in numbers of users and of adopters at the
service delivery points. It is very important to keep in mind that it is difficult to fully capture client load
for resupply methods, due to factors such as discontinuation and community access to pills and
condoms. The estimates for LA/PMs are much more teliable, due to the fact that these are providet-
dependent methods; therefore, clients will have to visit service delivery sites to access the methods.

Service Provision Data That You Have to Input

In this section of the worksheet, you can input current figures for the estimated number of sites able to

3 F ] I provide  service (Column  G)
and the estimated client visits per
Estimated | ycqr (Column F). The image
Estimated Humber of
Client Sites Able to the left shows those cells.
SERVICE PROVISION: ESTIMATED CLIENT LOAD PER.  |VISITS to Provide
136 |MONTH PER SITE Per Year Service The estimated number of vi-
e sits per year for all methods
135 .
eI 4 gl can be adjusted .bgsed on
140 |Injectable - tevo-morth g g5/ your current policies. For
11 |Injectable - thrae-maorth 4 33| example, if pill resupply cli-
42 Male Condom 4 T8 cnts can receive six packages
143 |Female Condam 4 55 . .
144 Standard Days Method 1 55 of pills per visit, then you
145 | Any Trad. or Folk would input two visits per
146 |Implart - Morplant, Jadele 1 15 year for that method in Cell
1147 |Impalant - Implanon 1 13 .
143 |Implart - Sino-implart (1) 1 15 F13_9' Or, ,lf your current
143 |IUD 1 2p| policy requires IUD clients
150 | Female Sterilization 1 5 to come in for a follow-up
Lailibals Steriization L T visit, you could input a 2 in
152 [iTther 1
153 Cither 2 CCH F149.
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The formula for calculating the number of clients per month per site for resupply methods is:

umber of users * number of visits per vear umber of sites able to provide service
12
See the following image for an example.

5139 - £ =IF(ISNUMBER(S$138) (S4275F 133/8G139)/12 ")
A P ] G & [ ® | 5 |
29 | NUMBER OF USERS
40 Last Data
41 2003 2012 2013 2014
42 [ Fill 32867 E0 963 E4 702 + E3551
136
Estimated
SERYICE PROYISION: Client Estimated Number of
ESTIMATED CLIENT LOAD ¥ISITS Sites Able to Provide
136 |PER MONTH FPER SITE Fer Year Service
137
138 2012 2013 ¢ 2014
123 | Fill * 4 = 5 M ap6—= 305

Given that pills and condoms may be available through community distribution points such as
pharmacies, it is up to you as to how you want to use this field. If X numbers of community health
workers provide condoms in your geographic region of interest, for example, X could be the number
of condom sites, as each worker is essentially operating as a service site. Given that LA/PMs are
provider-dependent and that clients have to access those methods at the site level, to be consistent,
you may want to solely focus on site-level distribution here (versus trying to account for community-
level distribution as well).

Very Important Qualification

It is extremely important again to point out that estimates for resupply methods are based on the
number of users, and therefore the service delivery estimates will actually be higher for these methods,
due to clients who begin using a method but then discontinue. These figures only take into account the
number of users (i.e.,, women who continue using a method for a 12-month period) and not those who
start using a method but then discontinue. When examining these figures and analyzing the estimates,
consideration must be given to the number of people who will visit sites and who subsequently will
discontinue use of their method (thus having an impact on client load).

Because LA/PMs and SDM (also known as CycleBeads) do not require resupply visits, the estimated
client load for these methods is calculated by using the number of adgpters in a given year instead of the
number of users. The formula for these methods is:

(Number of adopters * number of visits per year)/(number of sites able to provide service)

12
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T146 - & =IFISNUMBER(T$138)(T7 27 3F 146/$G 146112,

A, F | G H @ | rR | s | 1
Method-
Specific
Discontinuat
£2 |HUMBER OF ADOPTERS {HEW USERS) ion Rates
B3
G4 2012 2013 214 215
72 |Implant - Morplant, Jadelle n.2s 4224 4 520 03 v 5457
135
Estimated

Estimated Humber of
Client Sites Able
SERVICE PROVISION: ESTIMATED VISITS to Provide
|136 | CLIENT LOAD PER. MONTH PER. SITE  [Per Year Service

137
1358 2012 2013 214 ¢ 215
146 | Implart - Morplant, Jadelle - 1 i~ = 23 Fila] pia] a0

Because the estimated client load figures for LA/PMs are linked to adopters, and because adopters are
visiting a site for one insertion or procedure (which is provider-dependent), these estimates will be
more accurate than the estimates for short-acting methods.

Interpreting the Data: Service Delivery Capacity

When looking at the data for service provision, it is again important to think about issues that have
been mentioned previously, such as the number of service sites or trained providers, etc. The existing
and expected service capacity may not be sufficient to provide for the projected client load; therefore,
more resources and interventions may be required to increase the capacity to provide those services.

If we look at the estimated monthly number of implant clients (in this example, Norplant/Jadelle) who
will be served at each site capable of providing implants in the year 2015 (Cell T146), the estimated
service delivery capacity for each site is approximately 30 clients per month. The daily client load could
then be calculated; this would mean approximately one implant client per day per site. This may
prompt a need to think about issues such as:

e Isit feasible to offer implant services to more clients?
e What is the best schedule for implant services—daily, or perhaps only once a week?

Estimated Number of Removal Clients per Month

Remember that nearly all clients who use implants will return to have their devices removed either
when they decide to discontinue use of the method or when its effective period has lapsed; and these
removals will contribute to the client load placed on a facility. Just as it is important to understand the
client load per service site for contraceptive initiation and for follow-up visits, it is important to have a
sense of how many clients will return to have their implants removed each year. In addition to the
monthly service projections calculated above, these projections should be considered when the
feasibility of a goal is being considered.
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Implant Removal Data That You Have to Input

e No data entry is required for this section; Reality V will automatically calculate the estimated
number of removal clients per service site per month, based on the number of facilities previously
entered. However, if you know that not all of these sites are able to provide removal services, feel
free to adjust to the number of facilities that provide removal services.

The formula for calculating the number of removal clients per month per site for implants is:

(Number of removals/number of sites able to provide setvice)

12
A, e
Estimated
Humber of
Sites Able
REMOVAL CLIENTS PER FACILITY to Provide
155 |PER MOHNTH Service
156
157
158 | Implant - Morplant, Jadelle 12
138 | Implant - Inplanan 12
160 [mplart - Sino-imglant 10 12

See the following example, in which monthly removal service volume is estimated; this is very similar

to the way in which overall monthly service volume is estimated in the cells above.

A G W s | 7 | u |
Estimated Number of
REMOYAL CLIENTS PER Sites Able to Provide
155 |FACILITY PER MONTH Service
156
157 2014 2015 2016
1588 |Implant - Morplant, Jadelle 12 17 12 20
1589 | Implant - Implanon 12 1] 0 1]
160 | Implant - Sinc-implant (1) 12 1] 0 1]

Note in the following example that if we are able to increase even slightly the number of service sites
able to provide implant removals, the monthly removal load per site decreases.
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A G W s | 7 | u |
Estimated Number of
REMOYAL CLIENTS PER Sites Able to Provide
155 |FACILITY PER MONTH Service
156
157 2014 2015 2016
1588 | Implant - Morplant, Jadelle 15 13 15 16
1589 | Implant - Implanon 12 1] 0 1]
160 | Implant - Sinc-implant (1) 12 1] 0 1]
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Couple-Years of Protection

Reality Vis designed to estimate CYP. In
Column G, rows 165-179, you can input
the CYP factor used in your program.
(See Appendix D [page 101] for more
informa-tion on CYP.) You can see from
the image to the right that the CYP
factors for the pill, injectables, and male
and female condoms are the same as the
commodity estimates used earlier. The
CYP factor currently used by USAID for
SDM is 2 per trained and confirmed
adopter, while the CYP factor for
LA/PMs is based on average length of
usage (as described in the section on
discontinuation). The CYP figures
calculated for each LA/PM adopter are
captured all at once, within the year of
method adoption.

162 |[CYP

163

164

165 |Fill

166 | Injectakle - two-month

167 | Injectable - three-manth

165 | Male Condom

169 |Female Condom

170 Standard Days Method

171 | Any Trad. or Folk

172 | Implant - Morplant, Jadelle

173 |lmplart - Implanon

174 | Implant - Sino-implant (0

175 |{IUD

176 |Female Sterilization

17T | Male Sterilization

178 [Cther 1
179 [Cther 2

This section of the worksheet is linked to commodities. The following example shows that CYP for
the pill in 2012 is calculated by dividing pill commodities in 2012 (Cell Q95) by the CYP factor (in this

case, 15—Cell G165).

165 - fe =MAK(DIF(ISMUMBER(OF164), (D853 GT1ES) ")
a e 2 | rR | 5 [ 1 |

52 |COMMODITIES
93
94 2012 2013 2014 2015
95 |Fill cycles 14,440 970525 1,025 266 1,057 670 1
161
162 |CYP
163
164 b 2012 2013 2014 2015
165 |Fill E0oe3l  E4702 63551 72511

While CYP for resupply methods is calculated by dividing the commodities by the CYP factor, CYP
for LA/PMs and for SDM is calculated by multiplying commodities by the CYP factor; this is because
one commodity (such as one IUD insertion) provides longer protection for a client than the resupply
methods. For example, we can look at the implant in 2013 (Cell R172) and see (page 40) that it is
linked to implant commodities in 2013 (Cell R102). Thus, the formula for calculating CYP for

implants in 2013 equals (R102*G172).
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R172 - A =MAX(D FISNUMBER(RS164) (R102°8G172),"™)]
A, G H o | R | s | T |
Commadities

92 | COMMODITIES Per User

a5

a4 2012 2013 2014 2015

100 | Standard Dayvs Method T ] ] ] ]

102 |Implant - Morplant, Jadelle 4224 1 4E20 503 5457

106 |Female Sterilization 7154 7a¥2 1 §o02 o442

161

162 | CYP CYP Factor

163

164 b w2 v 23 v 214 2015

170 | Standard Days Method 5 ] ] ] ]

172 |Implant - Morplant, Jadelle ; : 15 1'."III.| ] 17 BO8 19,100

176 |Female Sterilization ‘—9—811-,3‘8‘-3—8‘8-,1'51—*' 72014 7e 877

As throughout the use of the tool, keep in mind that all figures are rounded for ease of use in working
with the data. Therefore, there may be minor discrepancies in the projections due to rounding.

As you have now completed the calculations and projections on your past trend, you can move next to
testing scenarios. But before jumping into the next section, be sure to review the data sheet and think
about what the results suggest. Examining these assumptions will help you consider scenarios to test in
the next steps of the process.

Occasionally, you may want to examine trends for multiple geographic scenarios (i.e., multiple regions
or districts in one country). It may be most convenient to create all of these scenarios in a single Excel
workbook, rather than create one workbook for each area.

To create copies of Reality v in multiple tabs of the same workbook, simply Insert. ..
right-click on the Past Trend Continnation sheet (as shown to the right) and select Delete

“Move or Copy...” Check the “Create a copy” box at the bottom of the box -

that will appear, and an exact copy of the entire sheet will appear in the LS
workbook. To rename this new sheet to distinguish it from any others, simply Mowe or Copy. .. rl
right-click, select “Rename,” and enter the title of your choice. (The new title oot (S|
should be something that distinguishes this sheet from the others.) If you copy -

a sheet in which you have already entered values, make sure to delete these Lab Color...
values from the new sheet, unless they are the same (i.e., if you are running |G iew Code

multiple scenarios in the same geographic area). 1 Past Trends Graphs 2

The same process can be repeated for the Future Goals sheet.
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Running CPR Quickly

If you wanted to run a quick calculation to view a projection for any method CPR or for any modern
method CPR, you could use the “pill” option as a proxy; you would do this if you did not want to run
details on methods individually and instead just wanted a quick overview of any method or any modern
method CPR and users. To do this, you would have to detail in your assumptions that you are using the
“pill” option as a proxy for any method or any modern method CPR, and you would input the CPR into
the “pill” cells EI4 and FI4. You would input the number O into all other methods (or leave them
blank). You would also input your projected population data, so that you could project estimates on
the number of users. Please keep in mind that you would then only be able to look at projections for
CPR and users. Data on adopters, commodities, commodity and supply costs, service delivery, and
CYP would not be applicable for this type of proxy calculation.

Graphs

e For each output in Reality V (CPR, Users, Adopters, etc.), a customizable graph is generated in the
separate Graph tab. Graphs will not be generated if Macros are not enabled in Excel.

e In the blue section at the top of the Graphs sheet (see image below), note that you can select:

o Which method(s) to include in the graphs. This may be particularly useful when values for high-
prevalence methods skew the scale of the graph so that lower-prevalence methods are barely
visible; you can deselect the high-prevalence methods to view only those with lower prevalence.
> In the yellow area, you can select to show only the summaries of all methods, all modern

methods, or all LA/PMs. Note that selecting these features will show an aggregate sum of all

methods, modern methods, or LA/PMs combined; to view information for each method,

select the individual methods of interest from the checkboxes.

% For most graphs, you can select which type of graph to generate: Reality V can generate
cither line graphs or stacked bar graphs to represent your data visually.

e Note that after making your selections of the type of graph and which methods to include, you must
select the “Update Graphs” button to apply the changes throughout. If you return to the worksheet
and edit the data in any way, be sure to select the “Update Graphs” button when returning to the
Graph tab, to ensure that all changes are incorporated.

Select Plot Series Select Graph Type
[w] Fill " Line Graph
[v] Injection - Two Month * Stacked Bar Graph

[w] Injection - Three Manth
Iale Condom

Female Condam

[¥] Standard Oays Method
Any Trad. Or Folk Update Graphs
Implant - Marplant, Jadelle
[w] Implant - Implanan

[¥] Implant - Sinc

[v] o Cuick navigate to Graph

[¥] Femnale . j
L] r1ale 51
[¥] Other 1
[¥] Other 2

Warning: Graphs are dynamically generated in code. Adding ar removing roves
[ oy Methiod in the datasheet will result in errors in plotting

| Ay Modern Method
[ &l LatPra Methods
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e The graphs show the projections; they show the trends and help expose data input or assumptions
that are incorrect. For example, if you see sharp increases or decreases in the lines (versus a steady
trend), you may need to question how realistic or achievable those increases or decreases will be in
the future.

e Note that if you edit the data you input, you will need to select the “Update Graphs” button to
regenerate the graphs.

e You may wish to change the titles of graphs; this can be done by clicking anywhere within the
graph’s title box, then changing the title as you wish. Graphs can then be copied and pasted into
Microsoft Word documents by right-clicking, selecting “copy,” and selecting “paste” once you
have opened the document into which you would like to paste the graph.

e Graph colors and patterns can also be adjusted by right-clicking on each line or column, then
selecting the “Format Data Series” option.

e Note that once you have pasted the graph into the second document, you may not be able to edit
the title, colots, or other features.

2. Future Goals: Projecting by Testing Scenarios

Overview

Now that you have calculated past trends and have explored what things would look like if the past
trends continued, it is time to test alternative CPR and method-mix scenarios. This will allow you to
input data based on previously established CPR goals or based on scenarios that you would like to test.
You can also use past trend data to inform the goals that you will test.

Testing scenarios is really about the art of programming for family planning. Being able to input and
test various method prevalence rates will help you to create projections that can inform programmatic
decisions. For example, the data will help guide your decision-making process on factors such as:

e Resource utilization

e Interventions needed to reduce discontinuation

e TFuture commodity needs requiring attention

e Provider capacity needed to meet projected service estimates

e Demand-side interventions needed to address barriers to contraceptive uptake
e DPotential impact of CPR and method-mix scenarios

The worksheet for testing future projection scenarios is very similar to the one used to calculate the
past trend. The concepts that apply to that worksheet apply to this one as well. The biggest difference
is that here, you are testing various CPR scenarios by inputting your scenarios or goals on the far right
side. The concepts are identical to those for calculating past trends, so you can refer back to the
previous sections of the guide for clarification. Note that this time, however, the annual changes come
from the difference between the goal (far right side of the worksheet) and the starting value.
Previously, the changes were projected from the past trend.
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Source Data and Assumptions Data That You Have to Input

The same instructions previously noted have to be followed for inputting the source data and
assumptions (see below for an illustrative example). The assumptions outlined in this section of the
worksheet are shown in Row 4:

o

1 | Date:

z | Title of Scenario:
Geographic
LevelName of Analysis
{i.e. national, regioen,

3 |district):

4 | Assumptions:

EBased Upon WRA or

5 MWRA:

Population Data Source
CPR Data Source:

Future Goal CPR Data That You Have to Input

Your CPR data points must be entered into this worksheet in the same way as in the previous
worksheet. The biggest exception is that here, you will on/y input your most recent survey or estimated
data points (Column D) (see below).

Final Year |Maost
to Be Recent
13 [CPR Projected |Data Point

15 [Fill
& |Injectable - bwo-month

17 |Injectable - three-month
18 | Male Condom

19 | Female Condom

20 |5tandard Oays Method

21 | Any Trad. ar Falk

22 |Implant - Marplant, Jadelle
23 |Implant - Implaran

24 |Implant - Sinc-implant (1)
26 [lUD

26 | Female Sterilization

Male Sterilization
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These data are important, as they provide the baseline from which we start; if they are inaccurate, they
will result in inaccurate projections of annual numbers of users, adopters, etc., for the years between
the baseline and the final (target) year. These baseline data can be obtained in several ways:

e The demographic data from the most recent DHS or other population-based survey can be used if
they are very recent (ideally within the last 1-2 years) or if you have reason to believe that the
contraceptive prevalence for each method has not changed since these data were collected.

e If you believe that past trends have continued since the most recent population-based survey, you
can use the data generated in the Past Trend Continuation worksheet. If, for example, CPR data are
from 2000 and 2005 but you need to generate a future scenario with a baseline of 2010, and if you
believe the rates of growth achieved between 2000 and 2005 continued through 2010, you can do
a past trend analysis in the Past Trend Continnation worksheet, then use the CPR figures generated
for 2010 as the base in the Future Goals worksheet. You would need to note in the “Assumptions”
section that the 2010 baseline data assume that the 2000-2005 trends continued through 2010.

You also will need to input the Final Year to Be Projected (Cell C14). This scenario is being projected
through 2015. For example, if you wanted to project to 2020, you would enter 2020 in that cell.

Once you have input the year and the CPR data points, you must input your projected goals. To do
this, input your Final Year Projected Prevalence into the green cells in column C. This worksheet can
also project up to 25 years after the year of your initial starting point, but you can choose the final year
you would like to project. For example, if you would like project to 2020, you would input 2020 in Cell
C14. Column AD automatically recognizes the final year and adjusts the columns in the middle of the
worksheet to stop at 2019.

For this example, 2015 will be the final year projected. The image below shows that column O
contains figures for 2014 and that column AD shows figures for 2015. All of the columns in between
are hidden for visual purposes.

A C ] | o] | A0
Input Final
Year
FProjected
Final Year to  Most Recent Frevalence

| 1= |CPR Be FProjected |Data Foint Here

| 14 | 2015 2003 2014 2015

| 15 | Fill 220 4.30 440

| 16 |Injectable - two-month -

17 | Injectable - three-month E.40 062 1.00
| 18 | Male Condom 130 254 260
| 18 | Femnale Candom -
| 20 | Standard Days Method 0.28 0,30
| 21 | Any Trad. or Folk 4.E0 4.60 4.E0)
| &2 |Implant - Morplant, Jadelle 020 212 2.0
| 23 |Implant - Implanon -
| 24 |Implant - Sinc-implant (1] -
| 25 |IUD 020 112 120
| 2B | Femnale Sterilization 200 210 220
| 27 |Male Sterilization .00 0.92 100
| &8 | Other1 -

29 | Other 2
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Please keep in mind that you can test any scenario you would like in a relatively rapid manner. For
example, you can input projected prevalence based on previously established national family planning
goals, or you can test other scenarios, based on variants such as:

e Increasing male sterilization
e Increasing injectable use

e Decreasing traditional method use

e Increasing implant use
e Introducing SDM

In the example shown below, the various projected method prevalence rates are set to add to overall
modern method prevalence of 26% and any-method prevalence of 30.6%. In this scenario, LA/PM
use is set to rise to 7.7%, while resupply methods are set to increase at a pace similar to the past trend.

One minor difference in this worksheet is that the average annual change is to the right side of the
spreadsheet. The right side shows the differences in measurement between the final year projected and

the first year projected (see below).

a

13 |CPR

114 |

|15 [Pill

|16 |Injectable - tvwo-month
117 |Injectable - three-month
18 [Male Condom

119 |Female Condom

120 | Standard Days Method
121 |Any Trad. or Falk

|22 |Implant - Morplant, Jadelle
|23 |Implant - Implamon

124 |Implant - Sino-imgalant ()
|25 (IUD

26 |Female Sterilization
flale Sterilization

Any Method
32 | Any Modern Method
33 | Al LAFPME

AF

Most Recent
Data Point

Average Annual
Increase/Decrease Based
on Projected Scenario
{Based on Final Year
Projected and Most
Recent Data Point)

010
0.0o
0.35
0.06
0.0o
0.03
0.0o
017
0.0o
0.00
0.05
010
0.05
0.00
0.0o

1.00
1.00
0.43

This information can give you a sense of the magnitude of change from your first year projected and

your last (in this case, 2004 to 2015).

The Method Mix Caleulators Excel file on the Reality V CD-ROM includes several tools that may be
useful for estimating future goal scenarios. These include:
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1. The Method Mix Calculator
Occasionally, you might want to test a future scenario in which overall CPR increases to a certain
total while the current method mix remains constant. Based on the current CPR for each method
and the percentage increase in total CPR you would like to see, this calculator will generate a future
CPR for each method, while holding each method’s share of the method mix constant.

2. The Percentage Share of Method Mix Calculator
You may also want to test scenarios in which each method comprises a certain percentage of the
method mix. This calculator allows you to indicate a future total CPR as well as the percentage of
the method mix that you would like each method to comprise. The tool then generates a future
CPR for each method; it offers the option of entering information about the current CPR for each
method, to compare the current CPR and method mix with your target CPR and mix.

To copy and paste values from either of the method mix calculators é Cut
. . e
asa future goal scenario in Reality v, you must use th.e Paste 8 copy
Special” option in Excel; if you paste the figures in without B past
. . . . . asCe
selecting this option, they will appear as the formulas used in the -
calculators. | Paste Special. . [
M

To use Paste Special:
1. Copy the values that you wish to transfer.
2. Right-click on the cells in which you would like to

Clear Conkents

enter the values. A Insert Comment
3. Select the “Paste Special” option, as shown to the right. ¢ Format Cells. ..
4. Select the “Values and Numbers Format™ option, then Pick Frorm Drop-down List. .
select “OK.”
add Watch

g LookUp...

Calculating Future CPR While Holding Method Mix Constant

CPR Data That You Have to Input

e Current method-specific CPR
e Desired total CPR (could be based on the current total CPR plus a reasonable amount of increase)

All green fields are required data entry fields. Simply enter the desired total CPR at the top, and enter
the current CPR for each method. If you do not have data for a particular method, simply leave the
corresponding green CPR cell blank. The calculator will then estimate the current and future
percentage shares of the method mix (which will be equal), as well as the future CPR for each method
for which you have entered data.

See the following example, in which we increase overall CPR to 45% while holding each method’s
share of the method mix constant.
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The future CPR for each method generated in the fourth column (Future CPR) could then be copied
and pasted as the future goal in Reality v.

What would you like the total
CPR.to be?
45
% share of % share of
current Future future

Current CPR. - method mix CPR method mix

Fill 11.90 4% 15.28 34%
Injectable - two-rmonth 0% 0.00 0%
Injectable - three-rmonth 7.40 21% 9.50 21%
Male Condom 0.70 2% 0.90 2%
Female Condaom 0% 0.00 0%
Standard Days Method 12.70 =% 16.31 aE%
Ay Trad. or Folk 0.50 1% 0.64 1%
Implant - Morplant, Jadelle 0% 0.00 0%
Implant - lmplanon 0% 0.00 0%
Implant - Sino-implant {0 0% 0.00 0%
(W] 1.24 4% 1.60 4%
Fernale Sterilization 0.40 1% 0.51 1%
Male Sterilization 0.20 1% 0.26 1%
Other 1 0% 0.00 0%
Other 2 0% 0.00 0%
Ay method 35.045 100 " 45.00 1.00
Ay modern method 34.85 nag 28.44 n.aa
All LAPMs i 1.85 005 278 0.05

Calculating the Desired Method Mix

CPR Data That You Have to Input

e Current CPR for each method (optional, but encouraged)

e Desired total CPR (could be based on the current total CPR plus a reasonable amount of increase)

e Percentage of the total method mix that you would like each method to comprise. This is where
entering the current CPR in the second column would be useful; you can look at the current

method-mix breakdown and determine which methods’ share you would like to increase and
which should decrease.

First, enter your desired total CPR in the green cell in the first row. (As before, you can only enter data

in the green cells.) Enter the current CPR for each method in the green cells in the second column
(this is optional, but recommended). In the fourth column, enter the percentage of the total method
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mix that you would like each method to comprise; note that these percentages that you enter should
add up to 100.00% in Cell D19.

See the following example, in which we will increase total CPR from 35.05% to 45% and increase
LA/PMs’ share of the method mix from 5% to 16%.

What would you like the total
CPRto he?

What percentage of the

Current share | total method mix would

Current CPR.  of total method | you like this method to
{optional) mix comprise?*

Future CPR

Fill
Injectable - two-rmonth
Injectable - three-rmaonth
Male Condom

Female Condom
Standard Days Wethod
Arvy Trad. or Folk

Implant - Morplant, Jadelle
Implant - Implanon
Implant - Sino-implant {0
LD

Female Sterilization

Male Sterilization

Any method 35.0% 100.00% 100.00% 4500
Any modern method 4.5 949% 100.00% 445.00
All LAPMs 1.85 A% 16.00% 7.20

The future CPRs for each method generated in the last column (Future CPR) can then be copied and
pasted as the future goal in Reality \%using the Paste Special option.

Data entry and interpretation for most of the rest of the worksheet is similar to that in the Past Trend
Continnation worksheet.

In this worksheet, calculations for the section on adopters and for all sections below it begin with the
first year projected—in this example, 2004. That is because they are based on the difference between
users from one year to the next. Here, 2003 adopters cannot be calculated, since there is no 2002
column to yield changes from 2002 to 2003 (see the empty 2003 cells in the image on page 55).
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A = | 1] | E | F |

_40 |NUMBER OF USERS
4 2003 2004 2005
42 | Fill 32,867 36,153 ITEDE
_43 | Injectable - two-month 1 0 1]
44 | Injectable - three-manth E5, 714 2271 79,272
45 | Male Condom 13,503 20,564 22307
_4& | Femnale Condom 0 0 1]
47 | Standard Days Method ] 2EE L
48 | Any Trad. or Falk 47,232 43,003 a0,531
48 | Implant - Marplant, Jadelle 3,080 4872 7005
B0 | Implant - Implanon ] o 0
5| Implant - Sino-implant (11 0 0 1]
B2 | UD 2,054 3ma 4,056
53 | Femnale Sterilization 20,536 22374 24,335
54 | Male Sterilization ul 283 1,844
_BE | Other 1 1] 1] 1]
_BE | Other 2 1] 1] 1]
57 |
88 | Any Method 190,351 208,521 227,861
B9 | AnyModern Method 143,743 169,212 176,473
(B0 | AllLA/PM: 26,670 1,252 37238
R

Method-

Specific

Discontinuation
_EZ2 |NUMBER OF ADOFTERS [MEW USERS) |Rates
B3 2003 2004 2005
B4 | Fill 0.50 18,730 20,023
_ES | Injectable - twa-month IR=] 0 1]
_EE | Injectable - three-month 050 39414 42,127
_E¥ | Male Condom 0.50 11,110 1875
_E& | Female Condom 050 1 0
_E8 | Standard Days Method 0.40 2EE 393
0| Any Trad, or Falk 0ER 2478 3Tas
¥ |Implant - Marplant, Jadelle 028 2,754 3426
_¥2 | Implant - Implanon 045 o 0
_¥3 | Implant - Sino-implant (1) n.zg 0 1]

Additional Data That You Have to Input in the Future Goals Worksheet

The information noted below should be entered in the same way as it was in the Past Trend Continnation
worksheet. Please see those sections of the guide for more information.

Population Data
The number of MWRA (or WRA) can be copied and pasted from the previous spreadsheet.

Number of Adopters
You will need to input local method-specific discontinuation rates, or you can utilize the international
averages previously provided.

Commodity and Supply Costs

You will need to input the cost estimates, or you can utilize the international rates previously provided.
You could also enter the total service cost (the cost to serve one user, including supplies, commodities,
labor, overhead, etc.) and estimate the total cost of family planning services.

Service Provision: Estimated Number of Clients per Month

You will need to input the estzmated number of sites able to provide services and the estimated number of visits per
client per year. Given that in this worksheet you are projecting based on future goals, you can test
different service delivery options, such as increasing the number of sites that can provide a service or
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reducing the number of visits that a resupply client would need. Note that the grey button allows you to
input the values you entered in the Past Trends tab; however, you should consider whether your
number of service delivery sites will increase with your intervention. If so, you should enter separate
values.

Service Provision: Estimated Number of Implant Removal Clients per Month

You will need to input the estimated number of sites able to provide removal services. Note that this information
will not necessarily be the same as in the Service Provision section above, as some sites able to provide
implant insertions may not have a provider trained in removals.

Method-Specific Annual Failure Rates
You will need to enter annual failure rates for each method, or you can use the international rates
already included.

Annual Pregnancy Rate for Nonusers of Family Planning

This figure is used to estimate the number of family planning users who would have become pregnant
in any given year if they were 7o using contraception. A default rate is provided (850/1000), but you
can enter a different rate, if you so choose.

Abortion Rate

This figure is used to estimate the number of abortions that would have occurred if all current family
planning users were 7ot using contraception and had experienced an unintended pregnancy. We
assume that a certain percentage of women experiencing an unintended pregnancy would have sought
an abortion.

Spontaneous Abortion Rate

When calculating the number of unintended births averted by providing contraception, an estimate of
the percentage of pregnancies that result in a spontaneous abortion/miscarriage is needed. A default
international value is provided, but this can be changed, if more local information is available.

Maternal Mortality Ratio
A country-specific maternal mortality ratio must be entered to generate an estimate of the number of
maternal deaths averted.

Infant Mortality Rate
A country-specific infant mortality rate must be entered to generate an estimate of the number of
infant deaths averted.

Child Mortality Rate
A country-specific child mortality rate must be entered to generate an estimate of the number of child
deaths averted.

Interpreting Your Data

In analyzing your projected scenario and goals, it will be important to think about all of the concepts
previously discussed.
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The following considerations, which have been discussed throughout the guide, can help you interpret
your results:

In terms of an international standard, relatively strong family planning programs can experience a
1.5% annual increase in CPR. How does your projected scenario compare with this number?

What factors have to be in place to reach the goals?

Will a renewed commitment to family planning be required at vatrious policy levels to reach the
goals?

What resources will be needed to meet the goals, and where will they be needed?

What communication campaigns or community activities will be required to increase method
utilization?

What should the family planning priorities be? Should training more providers in LA/PMs be a
priority?

How can contraceptive logistics systems be strengthened to improve supply lines and access to
services?

Do champion policymakers, providers, community leaders, or other family planning advocates
exist? How can the program identify and nurture them to strengthen a focus on family planning?
Should new family planning methods be introduced in your program?

Is a policy change needed in terms of the level of cadre allowed to provide a specific method, so
that services are easier to access at the community level?

Does your program offer a balanced method mix?

Is there a balanced distribution of use by method? If not, what factors may be at play, and what
action is needed?

As an example, let’s look at vasectomy prevalence in the projected scenario shown below.

The RESPOND Project

A, C [ O

Final Year to  Most Recent
12 |CPR Be Projected Data Point

15 | Fill

16 |Injectable - two-month
17 | Injectable - three-month
18 | Mlale Condom

19 | Female Condom

20 | 5Standard Days Method
21 | Any Trad. or Falk

22 | Implant - Morplant, Jadelle
23 |Implant - Implanan

24 | Implant - Sino-implant (1)
26 | IUD

26 | Fermale Sterilization

27 | Male Srerilization

H | Any Method
32 | Any Modern Method
3% | AllLAFME
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To determine what this means in terms of services, we will have to look at information on trained
providers, commodities, and estimated monthly client load.

For the context of this example, let’s say that a family planning programmer has decided that male
sterilization is an underutilized method and determines that there is a need to offer this service. Male
sterilization prevalence was 0.00% in 2003, and the family planning programmer decides that the
projected future goal in 2015 should be 1.00%. We can see that this will require an average annual
increase of 0.08 percentage points (Cell AF27).

What does this mean in terms of numbers of users and adopters? The following image shows what a
1.00% vasectomy prevalence in 2015 translates into. The illustration shows the first three years
projected (2004-20006) and the final year projected (2015).

A C [ [m] E | F | ] [AE AF |
Average Annual
Input Final IncreaselDecrease
Tear Based on Projected
Most Frojected Scenario [Based on
Final Year to Hecent Prevalence Final Year Projected
13 |CPR Be Projected Data Point Here and Most Recent Data
14 2015 2003 2004 200% 2015
27 | Male Sterilization 0.00 0.03 A 1.00 0.03
L)
Reszize Columnsto Ft DI"EIEI‘I_GE n
Population between
Baseline Year and Final
35 Tear Projected
36 | Population Data: Number gt LIk 2004 2005 2015
3 | MWYRA Copy From Calculator ’]?82 1065414 1106120 1562, 745 B36,963
38
34
Number of Users
between Baseline Year
and Final Year
40 | NUMBER OF USERS FProjected
4 2003 2004 200% 2015
B4 | Male Sterilization 1] aa8 1844 15,627 16,627
B
Method- Adopters [Mew Users)
Specific between Baseline Tear
NUMEBER OF ADDFPTERS |Discontinuatio and Final Year
E2 | [NEW USERS) n Rates FProjected
B3 2003 2004 200% 2015
¥E | Male Sterilization 0.0 aag 1,044 315 23,126

The projected number of users is 888 in 2004 (Cell E54) and is 15,627 in 2015. The projected number
of adopters rises from 888 in 2004 (Cell E76) to 3,115 in 2015.
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As can be seen below, in 2004, the commodity and supply cost of providing male sterilization services
is projected to be $4,395 for the 888 procedures. In 2015, due to an increase in vasectomy adoption,
that cost would be $15421 for 3,115 procedures. The estimated number of sites where male
sterilization services would be available is set at just one here, but this assumption can be based on
either current service capacity or a goal of offering male sterilization services at just one site in the
district. In this example, the single site would have its monthly client load increase from 74 in 2004 to
260 in 2015. The example also projects the estimated CYP associated with each year.

A C [ o] E F A0 AF
Total Number of
Commodities between
Commodities Baseline Year and Final
1 (COMMODITIES FPer User Tear Projected
a2
a3 2003 2004 2005 2015
106 | Male Sterilization 488 1,044 3,115 23125
112
Total Amount of
Commodity and Supply
Commodity and Costs between Baseline
COMMODITY AND Supply Cost Year and Final Year
13 |SUPPLY COSTS Per Unit [US5%) Projected
m Average mferRalicnal ¢ ity and
=HARSF cosfs are cfuded §x defanfis i
Aealicg . Kpou dave 3F & O
NG supply cosis, or i gouldase more
COMPAele BEF-UAR Serpice Belfiverg cosis
frAar incfude fabor, cverde@d, ofe } simply
repface e Sefablft cosls i Celfs CFE
15 | througd CX0T with goor owl cosis 2003 2004 2005 2015
128 | Male Sterilization 4495 4,395 5,170 15,421 114,463
Estimated Difference in Mumber of
SERYICE PROY¥ISION: Number of Clients Served Monthly
ESTIMATED CLIENT Sites Able to between Final Tear
LOAD PER MONTH PER |Frovide Projected and First
135 | SITE Service Tear Projected
136 ke Past Trend “Jalues |
137 2003 2004 2005 2015
(60| Male Sterilization 1 74 &7 260 126
160 U=z Past Trend “aues |
Total number of CYP
Achieved between the
Baseline Year and Final
&1 | CYP CYP Factor Tear Projected
162
163 2003 2004 2005 2015
176 | Male Sterilization 3 7991 9,400 28,038 208,126

In analyzing the projections, one may conclude that it is not realistic to expect one site to provide 260
male sterilization procedures in one month; this suggests that service capacity needs to be expanded to
meet the projected caseload. Decision makers would have to plan and provide for:

T

Trained providers

Equipment for the procedure

A small initial client load, so that providers can practice and build their skills
Possible negative community perceptions of male sterilization

Resources needed to launch a male sterilization program

Potential location of services (e.g., will there be mobile services?)
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Drawing upon the concepts explained in previous sections of the guide will help you analyze your data
and the scenarios you would like to test. You can copy the Future Goals worksheet to run as many
projections and scenarios as you would like. To build on the previous example, you may want to see
how the results change if male sterilization services are offered at three sites in the district. Running
various goals and scenarios will allow you to make programmatic decisions based on sound data and
assumptions.

Before concluding, we can look at a resupply method as an example. Imagine that a family planning
programmer decides that use of the three-month injectable will rise to 11% by 2015, from 6.4% in
2003. This would be an approximate annual increase of 0.38 percentage points (Cell AF17).

What does this increase mean in terms of numbers of users and adopters? The following image shows
us that this average increase of 0.38 percentage points per year will result in close to 100,000 more
users (Cell AF44, formula=AID44-D44) per year by 2015 over initial 2003 projections. It also means
that there will need to be a total of more than 760,000 adopters between 2004 and 2015 (Cell AF66,
formula=D66-ADG0).

A C | ] [ E | F | A0 [2E AF |
Average Annual
Input Final IncreaselDecrease
Tear Based on Projected
Most FProjected Scenario [Based on
Final Year to Be Hecent FPrevalence Final Year Projected
13 |[CPR Projected Data Point Here and Most Recent Data
14 2015 2003 2004 2005 2015
17 |Injectable - three-month E.40 E.73 A7 .00 0.33
4
Resize Columns to Fit Dlﬁeren_ce n
FPopulation between
Baseline Year and Final
35 Tear Projected
Fopulation Data: Number
36 | of Copy From Calculatar |Zl]l]3 2004 2005 2015
37 | MWRA TOZ6, 782  10E5414 1108120 1562, 745 535,963
38
34
Number of Users
between Baseline Year
and Final Year
40 (NUMEBER OF USERS Projected
4 2003 2004 2005 2015
44 |Injectable - three-manth E5, 714 72271 78,272 171,302 106,188
&1
Adopters [Mew Users)
Method-Specific between Baseline Year
NUMBER OF ADOFTERS |Discontinuation and Final Year
E2 |[NEW USERS) Rates Projected
[:3¢] 2003 2004 2005 2015
EE |Injectable - three-manth 050 349,414 43137 91,395 TE4ET1
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Examining commodities and commodity and supply costs can shed further light on how to plan for
injectable supplies, while looking at the projected client load can help assess service delivery capacity
planning needs (see the illustration on page 61).
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A B [ C [ o | E | F | ao |ag AF
Total Number of
Commodities between

Commodities Baseline Year and Final
3 | COMMODITIES FPer User Tear Projected
E 2003 2004 2005 2015
|56 | Injectable - three-manth 4 289,082 | HT088 B&T,E0S 0,692 614
iz
| Total Amount of
Commodity and Supply
Commodity and Costs between Baseline
COMMODITY AND Supply Cost Per Year and Final Year
2 [SUPFPLY COSTS Unit [US%] Frojected

MW | Busrage internaticnal loommodity and Supply costs
are fcfuded as defauls o Fealitg . K poo Aave
focal commodity and fupply eosts, or i gou Aave
TR COmpele per-uall serpice Gelvery cosis ftdar
fmcfude fabor, cverdeds, ofe f simpfy replace e
defaufs cosis i Celfs CHE through CFNT with goor oxn

N5 | ceosis 2003 2004 200% 2015
%%_ Injectable - three-month 0ay 261,602 | 275,866 535,219 4,952 674
SERYICE Difference in Number of
PROYISION: Estimated Estimated Clients Served Monthly
ESTIMATED CLIENT |¥isits Per Number of Sites between Final Year
LOAD PER MONTH  (Client Per Able to Provide Projected and First
135 | PER SITE Tear Service Tear Projected
136 | ke Past Trend “walues |
137 2003 2004 2005 2015
140 Injectable - three-month 4 50 432 523 1146 BE4
10 Use Past Trend “/alues |
Total number of CTF
Achieved between the
Baseline Year and Final
&l |CYP CYP Factor Tear Projected
163 | 2003 2004 2005 2015
E Injectable - three-month 4 72,271 TR2ET2 171,902 1423163

While looking at the projections, however, it is important to remember that these figures are based on
users, so therefore one must take into account that these figures do not account for discontinuers (who
do not count as wsers). Therefore, you must consider the extent to which discontinuation will lead to
higher estimates than the projections shown here.

Impact of Family Planning Scenarios

At the bottom of the Future Goals worksheet, Reality \ provides estimates of the impact of the tested
scenario in terms of:

e Unintended pregnancies averted

e Abortions averted

e Unintended births averted

e Maternal deaths averted

e Infant deaths averted

e Child deaths averted

The data input requirements for this section are relatively light, and some default international values
are provided. Note that for settings with larger populations and/or higher mortality rates, these
impact numbers will be larger and more impressive than for settings with fewer people and/or
stronger health indicators.
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Unintended Pregnancies Averted

Reality V will generate an estimate of the number of unintended pregnancies averted on an annual, per-
method basis, as well as a sum of the pregnancies averted by all methods for all years projected.

When calculating the number of unintended pregnancies averted, it is important to consider not only
the proportion of women who would have become pregnant if they had not been using their current
family planning method, but also the percentage of users who will experience a method failure
resulting in an unintended pregnancy.

Therefore, the number of unintended pregnancies averted for each method is calculated as:

(Number of users * Pregnancy rate)

(Number of users * Method-specific failure rate)

Unintended Pregnancy Data That You Have to Input

The pregnancy rate refers to the proportion of women of reproductive age who, if not using a family
planning method, would become pregnant in a given year. A default international value of 850 per
1,000 WRA (Trussell, 2007) is provided in Cell C184, but this can be changed if more local data are
available.

The method-specific failure rates (Cells B186 through B199) indicate the percentage of users of each
method who will experience a method failure (become pregnant) in a given year. Default international
values are provided (taken from Trussell, 2007), but again, these can be changed if more local data are
available. The current default values for typical use are:

e Pil 8.00
e Injectable 3.00
e Male condom 15.00
e Female condom 21.00
e SDM (Arévalo et al., 2002) 5.00
e Any traditional method" 27.00
e 1UD 0.80
e Implant (any) 0.05
o Female sterilization 0.50
e Male sterilization 0.15

These figures indicate a large variation of effectiveness between methods; while few implant users will
experience an unintended pregnancy in a given year (0.05%), approximately one-quarter of traditional
method users will become pregnant. Note that these default values refer to typical use of each method.

This calculation assumes that:

e All users are sexually active.

o All users are fertile.

e If not using their current method, users would not be using another method.

e Any pregnancies incurred by current contraceptive users would be unintended.

10 Withdrawal is used as a proxy indicator for the failure rate of any traditional method.
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As with other projections in the Future Goals worksheet, a sum of all unintended pregnancies averted
via any method, by any modern method, and by all LA/PMs is provided at the bottom (Rows 201—
203). The total number of all unintended pregnancies averted during all years projected appears in

Column AF.
A [u] A0 AE AF
Total Number of
Unintended Pregnancies
UNINTENDED Averted between the
PREGMANCIES Baseline and Final Years

122 | A¥YERTED 2014 2015 Projected

154

125 | Rill 50,215 52946 471172
186 | Injectable - bwo-month 1] 1] 0
127 | Injectable - three-manth 132,032 140,960 1166,986
188 | Male Condom 26,983 28442 253533
189 |Female Condom a a 0
130 | Standard Days Method 3337 3,751 21745
191 | Any Trad. or Folk 40,463 41634 413,532
192 | Implant - Morplant, Jadelle 27486 30,534 134,011
193 | Implant - Implanon 1] 1] 0
194 | Implant - Sinc-implant (1] 1] 1] 0
195 |IUD 14,260 15,740 102,764
196 | Female Sterilization 38,728 42,267 367E1R
197 | Male Sterilization 1,796 13,260 TE27E
198 | Other 1 1] 1] a
199 | Other 2 0 0 1
200

201 | Any Method 346,299 JB9,B32 3,064,244
202 | Any Modern Method 305,835 el 2,644,712
203 | AllLAIPMS 93,269 101,840 73278

The following example shows the number of unintended pregnancies averted by the IUD for 2010.
In this example, the formula is:

(K52 * [C184/1000]) — (K52 * B195)
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K195 - A =(KE27($C$184/1000)-(K52*$E195)
5 E [ c 1 K |

40 | NUMBER OF USERS
H 2010
52 | IUO 10,435
132 Use Past Trend “/alues

UNINTENDED

FPREGMAMNCIES
133 |AYERTED
154
195 | IUD
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Abortions Averted

When faced with an unintended pregnancy, many women will seek an abortion, even in contexts in
which the procedure is not available under safe and/or legal circumstances. Preventing unintended
pregnancies through family planning also prevents abortions.

To calculate the number of abortions averted due to family planning, we must enter a country- or
region-specific abortion ratio into Cell C206. The abortion ratio refers to the known percentage of
pregnancies that result in induced abortion (as opposed to the abortion rate, which refers to the
estimated number of abortions per 1,000 women). Measurement of abortion is difficult, since it is
often performed under illegal circumstances and may be a cause of embarrassment to survey respon-
dents. However, estimates of abortion ratios can be found in Appendix G (page 107).

The number of abortions averted is calculated as:

Number of unintended pregnancies averted
*

Abortion ratio/100

In the following example, the number of abortions averted by the use of the pill is calculated for 2010.
In this case, the formula for this figure is (K185 * [C206/100]).

K207 - A =K1857($CE206M100)
& B | e | K
I
Method-
Specific
Annual Annual
Failure Pregnancy
Rates Rate {per
UHINTEHDED {Typical 1,000
1153 |PREGHANCIES AVERTED |Use) Women) 2011
1154 | 50
183 [Pl &.00% 40 003
204
Abortion
Ratio (per
1203 | ABORTIONS AVERTED 10K} 2011
206 2
207 il 10,401

Note that in settings in which more abortions are performed, the number of abortions averted will
be higher.

Unintended Births Averted

To estimate the number of unintended births averted, we need to consider the number of unintended
pregnancies averted, then subtract the numbers that would have ended in induced or spontaneous
abortion (miscarriage).

For this section, therefore, we need to include an estimate of the percentage of all pregnancies that will

result in a spontaneous abortion. A default value of 13 per 100 is already included in Cell C228 of
Reality V, but this can be revised, if you choose to do so.
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The number of unintended births averted is calculated via the following formula:

Number of unintended pregnancies averted

(Number of unintended pregnancies averted * Spontaneous abortion rate)

Number of abortions averted

In the following example, the number of unintended births averted by the injectable in 2010 is
calculated by subtracting the numbers of induced and spontaneous abortions from the number of
unintended pregnancies.

L231 - A =L187-(L1877($C$228/100))-L209
& B | e | K | L
I
Method-
Specific
Annual Annual
Failure Pregnancy
Rates Rate (per
UHINTEHDED {Typical 1,000
1153 |PREGHANCIES AVERTED |Use) Women) 2010 2011
1184 850
1187 |Injectable - three-month 3.00% 99 220 t 106,955
04
] Abortion
Ratio {per
120:5 |ABORTIONS AVERTED 100} 2010 2011
1209 |Injectable - three-month 25797 T 27817
226
Spontaneous
Abortion
UHINTENDED BIRTHS Rate {per
227 |AVERTED 100) 2010 201
= e o=
231 |Injectable - three-manth =R 55,263

Maternal Deaths Averted

To calculate the number of maternal deaths averted via family planning, we apply the country-specific
maternal mortality ratio (deaths per 100,000 live births) to the number of unintended births.

This calculation requires you to input one data point, the country-specific maternal mortality ratio, in
Cell C250. A list of country-specific maternal mortality ratios from the World Health Organization can
be found in Appendix H (page 109), or you can use values from another source of your choice.

The number of maternal deaths averted is calculated as:

Number of unintended births averted
*

(Maternal mortality ratio/100,000)

In the example on page 66, the number of maternal deaths averted by the hormonal implant in 2012 is
calculated via the following formula: (M236 * (C250/100,000).
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W25E - A =M23ET(ECE250M100000)
& B | o | K | L M
Spontaneous
Abortion
UHINTENDED BIRTHS Rate (per
227 | AVERTED 100} 2010 2011 2012
225 13
236 | Implart - Morplant, Jadelle 10,124 11 BES T 13,286
245
Maternal
Mortality
MATERHAL DEATHS Ratio {per
249 | AVERTED 100,000} 2010 2011 2012
250
258 | Implart - Morplant, Jadells 132 173

Note that, just as for all other outputs generated by Reality v, summaries for maternal deaths averted
by all methods, by all modern methods, and by all LA/PMs are provided in Rows 267 to 269.
Summaries of all years are provided to the right, in column AE.

Infant Deaths Averted

Similar to the calculation of maternal deaths, to calculate the number of infant deaths averted by
family planning, we apply the infant mortality rate (the number of infants who will die in their first
year of life per 1,000 live births) to the number of unintended births averted.

This calculation requires one data input in Cell C272: the country-specific infant mortality rate. A list
of infant mortality rates derived from the DHS can be found in Appendix I (page 113), or you can
use a different source of your choice.

The calculation for the number of infant deaths averted by family planning is:

Number of unintended births averted
*

(Infant mortality rate/1,000)

In the example below, the number of infant deaths averted via female sterilization in 2014 is calculated
using the formula AD240 * (C272/1,000). Note that summary figures for all years between the
baseline and final years are projected in Column AF.

ADZE4 - A =AD2407($CE272/1000)
A E [ C | I [ ] | aD  [aE AF
Spontaneous Total Number of
Abortion Unintended Births
UNINTENDED BIRTHS Rate [per Averted between Baseline
227 | AYERTED 100} 2013 2014 2015 and Final Years Projected
Pt 12
240 | Female Skerilization ] 24234 ¢ 25 TTT 218,149
70
Infant Total Number of Infant
Mortality Deaths Averted between
INFANT DEATHS Rate [per Baseline and Final Years
271 | AYERTED 1.000) 2013 2014 2015 Projected
272 H
284 [ Femnale Sterilization 2,473 ) 2.810_;' 23,774
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Child Deaths Averted

As with maternal and infant deaths, we calculate the number of child deaths by applying the country-
specific child mortality rate (the number of children who will die before age 5 per 1,000 live births) to
the number of unintended births.

This calculation also requires one data input, the country-specific child mortality rate, in Cell C294.
Child mortality ratios obtained from the DHS are provided in Appendix I (page 113), but you can use
values from another source, if you so choose.

The calculation for the number of child deaths averted is:

Number of unintended births averted
*

(Child mortality rate/1,000)

In the following example, we calculate the number of child deaths averted by the injectable in 2015
via the formula: AD231 * (C294/1,000)

AD297 - fe =ADZITECE2H4/1000)
A B [ C | o | ap [aE AF
Spontaneous Total Number of
Abortion Unintended Births
UNINTEMDED EBIRTHS Rate [per Averted between Baseline
227 |AYERTED 100) 2013 2014 201% and Final Years Projected
228 13
231 | Injectable - three-manth TE.270 20533 1 8954985 711,861
232
Child Total Number of Child
Mortality Deaths Averted between
CHILD DEATHS Rate [per Baseline and Final Years
233 | AYERTED 1.000) 2013 2014 2015 Projected
294
587 | Injectable - three-manth MMF 10,4041 BEA3E

The sample programmatic considerations raised throughout the guide can help you think further about
these projections and about their implications for your family planning program.
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CONCLUSIONS, BIBLIOGRAPHY,
AND ADDITIONAL RESOURCES

Conclusions

Now that you have been through the steps for assessing your past trends and for testing future goals,
you can generate and use projections to make programmatic decisions more wisely or advocate for
more resources to help meet the family planning goals of your program. Exploring alternative
projections will help you plan realistically to ensure that service capacity keeps pace with the desire to
serve more clients both efficiently and effectively.
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interventions in the health sector, Progress Report 2008. Geneva. Available from www.who.int/entity/hiv/
pub/towards_universal_access_report_2008.pdf.

Additional Resources

If you would like to learn more about any of the concepts introduced in this guide, please see the
following additional resources:

Guttmacher Institute. 2008. Facts on contraceptive use. Iz Brigf. New York. Accessed at
www.guttmacher.org/pubs/fb_contr_use.html.

Hatcher, R. A., Trussell, J., Nelson, A. L., et al., eds. Contraceptive Technology: Nineteenth Revised Edition.
New York: Ardent Media.

Kols, A. 2008. Reducing unmet need for family planning: Evidence-based strategies and approaches.
Outlook. Volume 25, Number 1.

Pandit, T., and Bornbusch, A. (eds.) 2004. Contraceptive security: Ready lessons 1. Washington, DC: USAID.

PATH and United Nations Population Fund (UNFPA). 2006. Meeting the need: Strengthening family
planning programs. Seattle.

Pilz, K., and Bornbusch, A. (eds.) 2008. Contraceptive security: Ready lessons 1. Washington, DC: USAID.

Smith, R., et al. 2009. Fawily planning saves lives. 4" edition. Washington, DC: Population Reference

Bureau.

Singh, S., et al. 2009. Adding it up: The costs and benefits of investing in_family planning and maternal and newborn
health. New York: Guttmacher Institute and UNFPA.
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APPENDIX A:
Assumptions behind United Nations
Population Projections

Note: We are grateful to the United Nations Population Division for their permission to use data from
World Population Prospects: 2008 Revision in Reality V. Full data are available from: United Nations,
Department of Economic and Social Affairs, Population Division. 2009. World population prospects: The
2008 revision, CD-ROM Edition—Comprehensive dataset in Excel and ASCII formats. New York. (United
Nations publication, Sales No. E.07. XIIL.8).

Assumptions Underlying the Results of the 2008 Revision of World
Population Prospects

The preparation of each new revision of the official population estimates and projections of the
United Nations involves two distinct processes: (a) the incorporation of all new and relevant
information regarding the past demographic dynamics of the population of each country or area of
the world; and (b) the formulation of detailed assumptions about the future paths of fertility,
mortality, and international migration. The data sources used and the methods applied in revising past
estimates of demographic indicators (i.e., those referring to 1950-2010) are presented online and in
Volume III of World Population Prospects: The 2008 Revision.

The future population of each country is projected starting with an estimated population for 1 July
2010. Because population data are not necessarily available for that date, the 2010 estimate is derived
from the most recent population data available for each country, obtained usually from a population
census or a population register, projected to 2010 using all available data on fertility, mortality, and
international migration trends between the reference date of the population data available and 1 July
2010. In cases where data on the components of population change relative to the past five or 10
years are not available, estimated demographic trends are projections based on the most recent
available data. Population data from all sources are evaluated for completeness, accuracy, and
consistency and are adjusted as necessary."

To project the population until 2050, the United Nations Population Division uses assumptions
regarding future trends in fertility, mortality, and international migration. Because future trends cannot
be known with certainty, a number of projection variants are produced. The following paragraphs
summarize the main assumptions underlying the derivation of demographic indicators for the period
starting in 2010 and ending in 2050. A more detailed description of the different assumptions will be
available in Volume I of World Population Prospects: The 2008 Revision.

The 2008 revision includes eight projection variants. The eight variants are: low; medium; high;
constant-fertility; instant-replacement-fertility; constant-mortality; no change (constant-fertility and

' For a general description of the procedures used in revising estimates of population dynamics, see: Chapter VI
Methodology of the United Nations population estimates and projections (pp. 100—-104) in World Population Prospects:
The 2004 Revision, V'olume I1I: Analytical Report.

The RESPOND Project Reality V User’s Guide—Version2 73



constant-mortality); and zero-migration. The World Population Prospects Highlights focuses on the
medium variant of the 2008 revision, and results from the first four variants are available on line and
are published in Volume I of World Population Prospects. The full set of results for all variants and
scenarios is available only on CD-ROM.

The first five variants—namely, the low, medium, high, constant-fertility, and instant-replacement-
tertility—differ among themselves exclusively in the assumptions made regarding the future path of
fertility. The sixth variant, “constant-mortality,” differs from the medium variant only with regard to
the path followed by future mortality. The seventh variant, “no change,” has constant mortality and
constant fertility and thus differs from the medium variant with respect to both fertility and mortality.
The eight variant, “zero-migration,” differs from the medium variant only with regard to the path
followed by future international migration. Generally, variants differ from each other only over the
period 2010-2050.

To describe the different projection variants and scenarios, the various assumptions made regarding
fertility, mortality, and international migration are presented below.

A. Medium-Fertility Assumption

Total fertility in all countries is assumed to converge eventually toward a level of 1.85 children per
woman. However, not all countries reach this level during the projection period—that is, by 2045—
2050. Projection procedures differ slightly, depending on whether a country had a total fertility above
or below 1.85 children per woman in 2005-2010.

Fertility in high- and medium-fertility countries is assumed to follow a path derived from models of
fertility decline established by the United Nations Population Division on the basis of the past
experience of all countries with declining fertility during 1950—2010. The models relate the level of total
fertility during a period to the average expected decline in total fertility during the next period. If the
total fertility projected by a model for a country falls to 1.85 children per woman before 2050, total
fertility is held constant at that level for the remainder of the projection period (that is, until 2050).
Therefore, the level of 1.85 children per woman represents a floor value below which the total fertility
of high- and medium-fertility countries is not allowed to drop before 2050. However, it is not necessary
for all countries to reach the floor value by 2050. If the model of fertility change produces a total
tertility above 1.85 children per woman for 2045-2050, that value is used in projecting the population.

In all cases, the projected fertility paths yielded by the models are checked against recent trends in
fertility for each country. When a country’s recent fertility trends deviate considerably from those
consistent with the models, fertility is projected over an initial period of five or 10 years in such a way
that it follows recent experience. The model projection takes over after that transition period. For
instance, in countries where fertility has stalled or where there is no evidence of fertility decline,
fertility is projected to remain constant for several more years before a declining path sets in.

Fertility in low-fertility countries is generally assumed to remain below 2.1 children per woman during
most of the projection period and to reach 1.85 children per woman by 2045-2050. For countries
where total fertility was below 1.85 children per woman in 2005-2010, it is assumed that over the first
five or 10 years of the projection period, fertility will follow the recently observed trends in each
country. After that transition period, fertility is assumed to increase linearly at a rate of 0.05 children
per woman per five-year period. Thus, countries whose fertility is currently very low need not reach a
level of 1.85 children per woman by 2050.
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B. Mortality Assumptions: Increasing Life Expectancy Except When Affected by HIV
and AIDS

Normal Mortality Assumption

Mortality is projected on the basis of models of change of life expectancy produced by the United
Nations Population Division. These models produce smaller gains the higher the life expectancy
already reached. The selection of a model for each country is based on recent trends in life expectancy
by sex. For countries highly affected by the HIV epidemic, the model incorporating a slow pace of
mortality decline has generally been used to project a certain slowdown in the reduction of general
mortality risks not related to HIV and AIDS.

Impact of HIV and AIDS on Mortality

In the 2008 revision, countries where HIV prevalence among persons aged 15—49 was ever equal to or
greater than 1% during 1980-2007 are considered to be affected by the HIV epidemic, and their
mortality is projected by modeling explicitly the course of the epidemic and by projecting the yearly
incidence of HIV infection. Also considered among the affected countries are those where HIV
prevalence has always been lower than 1% but whose population is so large that the number of people
living with HIV in 2007 surpasses 500,000 (i.e., Brazil, China, India, the Russian Federation, and the
United States). In total, 58 countries are considered to be affected by the HIV epidemic in the 2008
Revision.

The model developed by the UNAIDS Reference Group on Estimates, Modeling and Projections
(Ghys et al., 2008; Brown et al., 2008) is used to fit past estimates of HIV prevalence provided by
UNAIDS for each of the affected countries (UNAIDS & WHO, 2008)'* so as to derive the
parameters determining the past dynamics of the epidemic for each of them. For most countries, the
model is fitted assuming that the relevant parameters have remained constant in the past. Beginning in
2007, the parameter PHI, which reflects the rate of recruitment of new individuals into the high-risk
or susceptible group, is projected to decline by half every 20 years. The parameter R, which represents
the force of infection, is projected to decline by half every 30 years. The reduction in R reflects the
assumption that changes in behavior among those subject to the risk of infection, along with increases
in access to treatment for those infected, will reduce the chances of HIV transmission.

In the 2008 Revision, interventions to prevent mother-to-child transmission of HIV are modeled on
the basis of estimated country-specific coverage levels that, in 2007, averaged 36% among the 58
affected countries, but varied from 0% to 99% among them (with 22 countries having less than 20%
coverage of pregnant women in 2007, and only eight countries with more than 75% coverage). These
coverage levels are projected to reach 60%, on average, by 2015, varying between 40% and 99%
among the affected countries (UNAIDS, UNICEF, & WHO, 2008)."” After 2015, the coverage of
interventions to prevent mother-to-child transmission of HIV is assumed to remain constant until
2050 at the level reached in each of the affected countries in 2015. Among women receiving
treatment, the probability of transmission from mother to child is assumed to vary between 2% and
19%, depending on the particular combination of breastfeeding practices (mixed breastfeeding,
replacement feeding, exclusive breastfeeding), its duration in the population, and the type of treatment
available (single-dose nevirapine, dual-prevention, or triple-prevention antiretroviral treatment). These

12 See online table: “Adult (15-49) HIV prevalence percent by country, 1990-2007 (with 95% confidence intervals),” at
http://data.unaids.otg/pub/GlobalReport/2008/080813_gr08_prev1549_1990_2007_en.xls.

13 See Table 1. Preventing mother-to-child transmission of HIV (pp. 33-35) and Table 2. Providing paediatric treatment (pp.
36-38); accessed at www.uniteforchildren.otg/uniteforchildren/knowmore/files/StocktakingReport08_Full_110708.pdf.

The RESPOND Project RealityV User’s Guide—Version2 75



assumptions produce a reduction in the incidence of HIV infection among children born to HIV-
positive women, but the size of the reductions varies from country to country, depending on the level
of coverage that treatment reaches in each country (Stover et al., 2008).

The survivorship of infected children (Brown et al., 2008) takes account of varying access to pediatric
treatment (Marston et al., 2005; and Newell et al., 2004). In the 2008 Revision, HIV-infected children
are divided into two groups: i) those infected in utero, among whom the disease progresses rapidly and
whose average survival is set at 1.3 years, and ii) those infected through breastfeeding after birth,
among whom the disease progresses slowly and whose average survival is set at 15.2 years without
treatment (Marston et al., 2005; and Newell et al., 2004). Explicit inclusion of pediatric treatment is
done via country-specific coverage levels, which averaged 34% in 2007 but varied between 0% and
99% among the 58 affected countries (with 15 countries having less than 10% coverage in 2007 and
only 12 countries having a coverage level above 75%). By 2015, the projected coverage is expected to
reach 60%, on average, in the 58 affected countries, varying from 40% to 100% (WHO, UNAIDS,
and UNICEF, 2008). Coverage levels are assumed to remain constant from 2015 to 2050 at the level
reached in each country by 2015. The annual survival of children receiving treatment is 80% during
the first year, 90% in the second year, and 95% thereafter, so that their mean survival time is 31.1
years, and the median survival time is 20.5 years in the absence of other causes of death (Marston et
al., 2005; and Newell et al., 2004).

The 2008 Revision incorporates a longer survival for persons receiving treatment with highly active
antiretroviral therapy (ART) (Brown et al., 2008; Marston et al., 2005; and Newell et al., 2004). The
proportion of the HIV-positive population receiving such treatment in each country is consistent with
estimates prepared by the World Health Organization (WHO, UNAIDS, and UNICEF, 2008), which
averaged 36% in 2007 among the 58 affected countries, but varied between 8% and 99%. Coverage is
projected to reach between 40% and 100% by 2015, averaging 60% for the affected countries.
Between 2015 and 2050, coverage levels are assumed to remain constant at the level reached in each
country by 2015. It is assumed that adults receiving treatment have, on average, an 85% chance of
surviving the first year of treatment, and a 95% chance of surviving each year thereafter in the absence
of other causes of death. Under this assumption, mean survival time after the initiation of therapy is
19.3 years, and the median survival time is 10.9 years, in the absence of other causes of death. Therapy
is assumed to start at the time full-blown AIDS develops. Without treatment, infected adults have a
mean survival time of 3.2 years (and a median survival time of 3.0 years) after the onset of full-blown
AIDS (Brown et al., 2008; Marston et al., 2005; and Newell et al., 2004).

C. International Migration Assumptions

Normal-migration assumption:

Under the normal migration assumption, the future path of international migration is set on the basis
of past international migration estimates and of consideration of the policy stance of each country with
regard to future international migration flows. Projected levels of net migration are generally kept
constant over most of the projection period.

Zero-migration assumption:
Under this assumption, for each country, international migration is set to zero starting in 2010-2015.

76 RealityV User’s Guide—Version 2 The RESPOND Project



D. Eight Projection Variants

The 2008 Revision includes eight different projection variants (see table below). Five of those variants
differ among themselves only with respect to the level of fertility in each, that is to say, they share
the assumptions made with respect to mortality and international migration. The five fertility
variants are: low, medium, high, constant-fertility and instant-replacement fertility. A comparison of
their results allows an assessment of the effects that different fertility paths have on other
demographic parameters.

Projection Variants in Terms of Assumptions for Fertility, Mortality,
and International Migration

Projection variant Assumptions
Fertility Mortality International
migration
Low-fertility Low Normal Normal
Medium-fertility Medium Normal Normal
High-fertility High Normal Normal
Constant-fertility Constant as of 2005- | Normal Normal
2010
Instant replacement-fertility Instant-replacement | Normal Normal
as of 2010-2015
Constant-mortality Medium Constant as of 2005- | Normal
2010
No change Constant as of 2005- |Constant as of 2005- | Normal
2010 2010
Zero-migration Medium Normal Zero as of 2010-
2015

In addition to the five fertility variants, a constant-mortality variant, a zero-migration variant and a
constant variant have been prepared. The constant-mortality variant and the zero-migration variant
both have the same fertility assumption (namely, medium fertility). Furthermore, the constant-
mortality variant has the same international migration assumption as the medium variant.
Consequently, the results of the constant-mortality variant can be compared with those of the
medium variant in order to assess the effect that changing mortality has on other demographic
parameters. Similarly, the zero-migration variant differs from the medium variant only with respect
to the underlying assumption regarding international migration. Therefore, the zero-migration
variant allows an assessment of the effect that non-zero net migration has on other demographic
parameters. Lastly, the constant variant has the same international migration as the medium variant
but differs from the latter in having constant fertility and mortality. Consequently, the results of the
constant variant when compared with those of the medium variant shed light on the effects that
changing fertility and mortality have on the results obtained.

E. Methodological Changes Introduced in the 2008 Revision

The following changes and adjustments were made in the 2008 Revision in relation to procedures
followed in the 2006 Revision.

e The base year, that is to say, the year in which the projections start changed from 2005 to 2010.
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o In the 2008 Revision, the impact of HIV/AIDS on mortality is modeled explicitly for all countries
where HIV prevalence among persons aged 15—49 was ever equal to or greater than 1 per cent
during 1980-2007.

e The models of the incidence of HIV infection by age have been revised to take into account
newly available data from nationally representative population surveys. Three new regional
models, one each for Africa, Asia and the Caribbean, have been the basis for estimations by the
Population Division for each sex using adult HIV prevalence rates by age and sex from 24
Demographic and Health Surveys (DHS) (covering 21 countries between 2001 and 2007)."* In
the new models, mean age at infection is lower than in the models used in previous revisions,
particularly for males. The mean age of infection for females varies between 25.0 years (Asia)
and 206.9 years (Africa) while for males it varies between 27.9 years (Asia) and 31.9 years (Africa).

" The approach is based on methodology presented at the UNAIDS Reference Group on Estimates, Modelling and Projections
January 2008 meeting (London) by Ray W. Shiraishi and others, on "Using Population-based HIV surveys to estimate HIV
incidence in Kenya, Malawi and Uganda.”
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APPENDIX B:
Commodity and Supply Costs

The table below was adapted from UNFPA’s Achieving the ICPD goals (UNFPA, 2009) to reflect
estimated averages for Norplant”, Jadelle”, Implanon®, Sino-implant (IT), the two-month injectable,
and SDM (also known as CycleBeads).

Units Required Price per Unit
Method for One CYP (U.S dollars) Cost per CYP®
Female sterilization 1/9* $9.09° $1.01
Male sterilization 1/9* $4.95° $0.55
IUD 1/3.5 $0.37° $0.11
Jadelle® 1/3.5 $22.00' $6.29
Implanon™ 1/2.1 $24.00" $11.43
Sino-implant (1) 1/3.5 $8.00" $2.29
Pill I5 $0.21° $3.15
Injectable—three-month 4 $0.87° $3.48
Injectable—two-month 6 $0.86 $5.16
Male condom 120 $0.025b $3.00
Female condom 120 $0.77b $92.40
SDM/CycleBeads® 12 $1.168 $0.58

a Though sterilization’s effect is permanent, it is assumed to provide only nine years of protection, because many
are not sterilized until late in their reproductive years.

b Prices are weighted averages of those normally paid by UNFPA and USAID, with weights reflecting the
respective shares of commodities they supply.

¢ Calculated from preceding columns.

Implanon® is not purchased by USAID. The cost cited here is based on a tiered pricing system where the cost of
purchasing 30,000-50,000 units is $20.74. This tier is cited based on an example of what the cost would be if a
country with a population size of Uganda had a 1% CPR for implants; then, approximately 43,000 units would be
needed. The other tiers range in price from approximately $18.18 to $23.37 per unit.

e Price is inclusive of Cycle Beads, with instructions and calendar (USAID, 2007).
f Price is an average of estimated cost range from Reproductive Health Supplies Coalition database (RHSC, 2009).

g From The Deliver Project’s Family Planning Product Catalog, 2010. Available at: http://deliver.jsi.com/dhome/
mycommodities/productcatalog /fpproducts. Accessed July 7, 2010.
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APPENDIX C:
Excel Functions: Tips on Using Excel

The following tips on using Excel are taken, with permission, from the help files of Microsoft Office
Online. When applicable, differences between Excel 2003 and Excel 2007 and 2010 are noted. For
Excel 2007 or 2010 users, the “Microsoft Office Button” is the round button in the top left corner; it

{Da
looks like this:

Save a File
Excel 2003: On the File menu, click Save.
Excel 2007 or 2010: Click the Microsoft Office Button, and then click Save.

Note: If you are saving the file for the first time, you will be asked to give it a name.

Save a copy of a file

Excel 2003

1. On the File menu, click Save As.

2. In the File name box, enter a new name for the file.
3. Click Save.

Excel 2007 or 2010
1. Click the Microsoft Office Button, and then click Save As.

2. In the File name box, enter a new name for the file.
3. C(lick Save.

Tip:
To save the copy into a different folder, click a different drive in the Save As drop-down list or a

different folder in the folder list, or both. To save the copy into a new folder, click Create New
Folder.

Save a file to another format

Excel 2003

1. On the File menu, click Save As.

2. In the File name box, enter a new name for the file.

3. Click the Save As Type drop-down list, and then click the file format that you want the file to be

saved in.
4. C(Click Save.
Excel 2007 or 2010

1. Click the Microsoft Office Button, and then click Save As.

2. In the File name box, enter a new name for the file.

3. In the Save as type list, click the file format that you want to save the file in. For example,
click Rich Text Format (.rtf), Web Page (htm or .html), or Comma Delimited (.csv).

4. Click Save.
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Save files automatically while working

Excel 2003

1. On the Tools menu, click Options, and then click the Save tab.

2. Select the Save AutoRecover info every check box.

3. In the minutes box, enter the interval for how often you want to save files. The more frequently
your files are saved, the more information is recovered if there is a power failure or similar
problem while a file is open.

Excel 2007 or 2010

1. Click the Microsoft Office Button, then click Excel Options.

2. Click Save.

3. Select the Save AutoRecover information every check box.

4. In the minutes box, type or select a number to determine how often you want to save files.

Note: AutoRecover is not a replacement for regularly saving your files. If you choose not to save the
recovery file after opening it, the file is deleted and your unsaved changes are lost. If you save the
recovery file, it replaces the original file (unless you specify a new file name).

Copy a File

When you copy a file or folder, you are making a duplicate of the original item that you can then
modify, delete, or store independently of the original.

1. Open the location that contains the file or folder you want to copy.

2. Right-click the file or folder you want to copy, and then click Copy.

3. Open the location where you want to store the copy.

4. Right-click within the location, and then click Paste.

The copy of the original file or folder appears in the new location.

Note: You can also select more than one file to copy at a time.

Tip:
If you select a file that you do not want, hold down CTRL and click the file again.

Move or Copy Sheets

Caution: Be careful when you move or copy sheets. Calculations or charts based on worksheet data

might become inaccurate if you move the worksheet. Similarly, if you insert a worksheet between

sheets that are referred to by a 3-D formula reference (i.e., a reference to a range that spans two or

more worksheets in a workbook), data on that worksheet might be included in the calculation.

1. To move or copy sheets to another workbook, open the workbook that will receive the sheets.

2. Switch to the workbook that contains the sheets you want to move or copy, and then select the
sheets.

How?
When you enter or change data, the changes affect all selected sheets. These changes may replace
data on the active sheet and other selected sheets.
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To select Do this

A single sheet Click the sheet tab.
Sheet1 & Sheet2 [ Crarti
| Active shest

If you do not see the tab you want, click the tab scrolling buttons to display the

M 4k K| Sheetl / Sh
Tah scroling buttons

Two or more Click the tab for the first sheet, and then hold down SHIFT and click the tab for
adjacent sheets the last sheet.

Two or more Click the tab for the first sheet, and then hold down CTRL and click the tabs for
nonadjacent sheets the other sheets.

All sheets in a Right-click a sheet tab, and then click Select All Sheets on the shortcut menu
workbook (i.e., a menu that shows a list of commands relevant to a particular item; to display

a shortcut menu, right-click an item or press SHIFT+F10).

Note: If sheet tabs have been color-coded, the sheet tab name will be underlined in a user-specified
color when selected. If the sheet tab is displayed with a background color, the sheet has not been
selected.

Cancel a selection of multiple sheets:
To cancel a selection of multiple sheets in a workbook, click any unselected sheet.

If no unselected sheet is visible, right-click the tab of a selected sheet. Then click Ungroup Sheets
on the shortcut menu.

3. On the Edit menu, click Move or Copy Sheet.
4. In the To book box, click the workbook to receive the sheets.

To move or copy the selected sheets to a new workbook, click new book.

5. In the Before sheet box, click the sheet before which you want to insert the moved or copied
sheets.
6. To copy the sheets instead of moving them, select the Create a copy check box.

Tip:

To move sheets within the current workbook, you can drag the selected sheets along the row of
sheet tabs. To copy the sheets, hold down CTRL, and then drag the sheets; release the mouse
button before you release the CTRL key.
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Hide or Display Rows and Columns
Hide a row or column

1.

Select the rows or columns you want to hide.

To select

Text in a cell

\ Do this

If editing in a cell is turned on, select the cell, double-click in it, and then
select the text in the cell.

If editing in a cell is turned off, select the cell, and then select the text in
the formula bar.

AL

A single cell

Click the cell, or press the arrow keys to move to the cell.

A range of cells (i.e., two
or more cells on a sheet.
The cells in a range can be
adjacent or nonadjacent.)

Click the first cell of the range, and then drag to the last cell.

A large range of cells

Click the first cell in the range, and then hold down SHIFT and click the
last cell in the range. You can scroll to make the last cell visible.

All cells on a worksheet

Click the Select All button.
|SE:|E:I31 All button
|

A
1 !

Nonadjacent cells or cell
ranges

Select the first cell or range of cells, and then hold down CTRL and select
the other cells or ranges.

An entire row or column

Click the row or column heading.
& B L(2)

Adjacent rows or columns

Drag across the row or column headings. Or, select the first row or
column, then hold down SHIFT and select the last row or column.

Nonadjacent rows or
columns

Select the first row or column, and then hold down CTRL and select the
other rows ot columns.

More or fewer cells than
the active selection

Hold down SHIFT and click the last cell that you want to include in the
new selection. The rectangular range between the active cell (i.e., the
selected cell in which data is entered when you begin typing. Only one cell
is active at a time. The active cell is bounded by a heavy border.) and the
cell you click becomes the new selection.

Cancel a selection of cells

Click any cell on the worksheet.

2. Excel 2003: On the Format menu, point to Row or Column, and then click Hide.
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3. Excel 2007 or 2010: On the Home tab, in the Cells group, click Format.

Do one of the following:

1. Under Visibility, point to Hide & Unhide, and then click Unhide Rows or Unhide
Columns.

2. Under Cell Size, click Row Height or Column Width, and then type the value that
you want in the Row Height or Column Width box.

Display a hidden row or column:

1. Do one of the following:
¢ To display hidden rows, select the row above and below the rows you want to display.
¢ To display hidden columns, select the column adjacent to either side of the columns you

want to display.

2. Excel 2003: On the Format menu, point to Row or Column, and then click Unhide.
Excel 2007 or 2010: On the Home tab, in the Cells group, click Format. On the Home
tab, in the Cells group, click Format.

Notes

Excel 2003

If the first row or column of a worksheet is hidden, click Go To on the Edit menu. In the Reference
box, type Al, and then click OK. On the Format menu, point to Row or Column, and then click
Unhide.

Instead of being hidden, the height or width of the first row or column of a worksheet may have been

. . . +
set to zero. In this case, point to the border of the Select All button until the cursor changes to = or
[+ and then drag to widen the row or column.

Select All button

Excel 2007 or 2010
1. To select the first hidden row or column on the worksheet, do one of the following:
e In the Name Box next to the formula bar, type Al.
e On the Home tab, in the Editing group, click Find & Select, and then click Go To.
e In the Reference box, type Al, and then click OK.
2. On the Home tab, in the Cells group, click Format.
3. Do one of the following:
e Under Visibility, point to Hide & Unhide, and then click Unhide Rows or Unhide
Columns.
e Under Cell Size, click Row Height or Column Width, and then type the value that
you want in the Row Height or Column Width box.

Move or Copy Cells and Cell Contents
Using the Cut, Copy, and Paste commands in Microsoft Excel, you can move or copy entire cells or
their contents. You can also copy specific contents or attributes from the cells. For example, you can
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copy the resulting value of a formula without copying the formula itself, or you can copy only the
formula.

Note: Excel displays an animated moving border around cells that have been cut or copied. To cancel
a moving border, press ESC.

Move or copy entire cells
When you move or copy a cell, Excel moves or copies the entire cell, including formulas and their
resulting values, comments, and cell formats.

1. In Excel 2003, 2007, or 2010: Select the cells that you want to move or copy.

To select Do this

A single cell Click the cell, or press the arrow keys to move to the cell.

A range of cells (i.e., two or Click the first cell of the range, and then drag to the last cell.
more cells on a sheet. The
cells in a range can be
adjacent or nonadjacent.)

A large range of cells Click the first cell in the range, and then hold down SHIFT while you
click the last cell in the range. You can scroll to make the last cell visible.

All cells on a worksheet Click the Select All button.

|SE|EE:’t All buttor

I 1

1 !
Nonadjacent cells or cell Select the first cell or range of cells, and then hold down CTRL while
ranges you select the other cells or ranges.

More or fewer cells than the | Hold down SHIFT while you click the last cell that you want to include
active selection in the new selection. The rectangular range between the active cell (i.e.,
the selected cell in which data are entered when you begin typing. Only
one cell is active at a time. The active cell is bounded by a heavy border.)
and the cell that you click becomes the new selection.

Note: To cancel a selection of cells, click any cell on the worksheet.

Excel 2003
2. Do one of the following:

e To move cells, click Cut # on the Standard toolbar (a bar with buttons and options that you
use to carry out commands. To display a toolbar, press ALT and then SHIFT+F10.), or press
CTRL+X.

e To copy cells, click Copy =3 on the Standard toolbar, or press CTRLA+C.
3. Select the upper-left cell of the paste area (the target destination for data that have been cut or
copied by us the Office Clipboard).

4. Click Paste [“=lon the Standard toolbar, or press CTRL+V.
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Excel 2007 or 2010
1. Select the cells that you want to move or copy.
2. On the Home tab, in the Clipboard group, do one of the following:

e To move cells, click Cut
Keyboard shortcut: You can also press CTRL+X.

e To copy cells, click Copy
Keyboard shortcut: You can also press CTRL+C.
3. Select the upper-left cell of the paste area.

4. On the Home tab, in the Clipboard group, click Paste F=Y

Tip:
To move or copy a selection to a different worksheet or workbook, click another worksheet tab or
switch to another workbook, and then select the upper-left cell of the paste area.

Notes:

e To choose specific options when you paste cells, you can click the arrow next to Paste on the
Standard toolbar (Excel 2003) or on the Clipboard group (Excel 2007 or 2010), and then click
the option that you want.

e By default, Excel displays the Paste Options button on the worksheet to provide you with special
options when you paste cells, such as Keep Source Formatting and Match Destination
Formatting. If you do not want to display this button every time you paste cells, you can turn this
option off. In Excel 2003: On the Tools menu, click Options; on the Edit tab, clear the Show
Paste Options buttons check box. In Excel 2007 or 2010: Click the Microsoft Office Button,
and then click Excel Options; in the Advanced category, under Cut, Copy, and Paste, clear
the Show Paste Options buttons check box.

Excel replaces existing data in the paste area when you move cells.

e When you copy cells, cell references are automatically adjusted. When you move cells, however, cell
references are not adjusted, and the contents of those cells and of any cells that point to them may
be displayed as reference errors. In this case, you will need to adjust the references manually.

e If the selected copy area (i.c., the cells that you copy when you want to paste data into another
location; after you copy cells, a moving border appears around them to indicate that they have been
copied.) includes hidden cells, Excel also copies the hidden cells. You may need to temporarily
unhide cells that you do not want to include when you copy information.

If the paste area contains hidden rows or columns, you might need to unhide the paste area to see all
of the copied cells.

Move or copy entire cells by using the mouse
By default, drag-and-drop editing is turned on so that you can use the mouse to move and copy cells.
1. Select the cells or range of cells that you want to move or copy.

e How to select cells
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To select ‘ Do this

A single cell Click the cell, or press the arrow keys to move to the cell.
A range of cells Click the first cell of the range, and then drag to the last cell.
A large range of Click the first cell in the range, and then hold down SHIFT while you click
cells the last cell in the range. You can scroll to make the last cell visible.
All cells on a Click the Select All button.
worksheet [Select All uttor

'] &

1 !
Nonadjacent cells Select the first cell or range of cells, and then hold down CTRL while you
or cell ranges select the other cells or ranges.
More or fewer cells | Hold down SHIFT while you click the last cell that you want to include in
than the active the new selection. The rectangular range between the active cell (i.e., the
selection selected cell in which data are entered when you begin typing; only one cell

is active at a time) and the cell that you click becomes the new selection.

2. Do one of the following:
e To move a cell or range of cells, point to the border of the selection. When the pointer

becomes a move pointer b drag the cell or range of cells to another location.
e To copy a cell or range of cells, hold down CTRL while you point to the border of the
+

selection. When the pointer becomes a copy pointer i , drag the cell or range of cells to
another location.

Notes

e Excel replaces existing data in the paste area when you move cells.

e When you copy cells, cell references are automatically adjusted. When you move cells, however, cell
references are not adjusted, and the contents of those cells and of any cells that point to them may
be displayed as reference errors. In this case, you will need to adjust the references manually.

e If the selected copy area includes hidden cells, Excel also copies the hidden cells. You may need to
temporarily unhide cells that you do not want to include when you copy information.

If the paste area contains hidden rows or columns, you might need to unhide the paste area to see all
of the copied cells.

Insert moved or copied cells between existing cells
1. Select the cell or range.
In Excel 2003:
1. Do one of the following:
e To move the selection, click Cut on the Standard toolbar, or press CTRL+X.
e To copy the selection, click Copy on the Standard toolbar, or press CTRLA+C.
2. Select the upper-left cell of the paste area.
3. On the Insert menu, click Cut Cells or Copied Cells.
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4. In the Insert Paste dialog box, click the direction in which you want to shift the surrounding
cells.

In Excel 2007 or 2010:
1. Select the cell or range of cells that contains the data that you want to move or copy.
2. On the Home tab, in the Clipboard group, do one of the following:
e To move the selection, click Cut.
e To copy the selection, click Copy.
3. Right-click the upper-left cell of the paste area, and then click Insert Cut Cells or Insert
Copied Cells from the shortcut menu.

Note: If you insert entire rows or columns, the surrounding rows and columns are shifted down and
to the left.

Tip
To move or copy a selection to a different worksheet or workbook, click another worksheet tab
or switch to another workbook, and then select the upper-left cell of the paste area.

Copy visible cells only

If some cells, rows, or columns on your worksheet are not displayed, you have the option of copying
all cells or only the visible cells. For example, you can choose to copy only the displayed summary data
on an outline.

In Excel 2003:

Select the cells that you want to copy.

On the Edit menu, click Go To.

In the Go To dialog box, click Special.

In the Go To Special dialog box, click Visible cells only, and then click OK.

Click Copy on the Standard toolbar, or press CTRLA+C.

Select the upper-left cell of the paste area.

Click Paste on the Standard toolbar, or press CTRL+V.

ok w»wh =

In Excel 2007 or 2010:

Select the cells that you want to copy.

On the Home tab, in the Editing group, click Find & Select, and then click Go To.
In the Go To dialog box, click Special.

Under Select, click Visible cells only, and then click OK.

On the Home tab, in the Clipboard group, click Copy.

Select the upper-left cell of the paste area.

SRR

Tip
To move or copy a selection to a different worksheet or workbook, click another worksheet tab
or switch to another workbook, and then select the upper-left cell of the paste area.

7. On the Home tab, in the Clipboard group, click Paste.
Notes

e [xcel pastes the copied data into consecutive rows or columns. If the paste area contains hidden
rows or columns, you might need to unhide the paste area to see all of the copied cells.
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e If you click the arrow next to Paste on the Standard toolbar, you can choose from several paste
options to apply to your selection.

e When you copy or paste hidden or filtered (i.e., displaying only the rows in a list that satisty the
conditions you have specified) data to another application or another instance of Excel, only visible
cells are copied.

Prevent copied blank cells from replacing data
Excel 2003:

1. Select the range of cells that contains blank cells.

2. Click Copy on the Standard toolbar, or press CTRL+C.

3. Select the upper-left cell of the paste area.

4. Click the arrow to the right of Paste on the Standard toolbar, and then click Paste Special.
5. Select the Skip blanks check box.

Excel 2007 or 2010:

1. Select the range of cells that contains blank cells.

2. On the Home tab, in the Clipboard group, click Copy.

3. Select the upper-left cell of the paste area.

4. On the Home tab, in the Clipboard group, click the arrow below Paste, and then click
Paste Special.

5. Select the Skip blanks check box.

Move or copy the contents of a cell
1. Double-click the cell that contains the data you want to move ot copy.

Note: By default, you can edit and select cell data directly in the cell by double-clicking it, but you can
also edit and select cell data in the formula bar (the bar at the top of the Excel window in which you
enter or edit values or formulas in cells or charts).

2. In the cell, select the characters that you want to move or copy.

In Excel 2003:

1. Do one of the following:
e To move the selection, click Cut on the Standard toolbar, or press CTRL+X.
e To copy the selection, click Copy on the Standard toolbar, or press CTRL+C.

2. In the cell, click where you want to paste the characters, or double-click another cell to move or
copy the data.

3. Click Paste on the Standard toolbar, or press CTRL+V.

4. Press ENTER.

In Excel 2007 or 2010:
1. On the Home tab, in the Clipboard group, do one of the following:
e To move the selection, click Cut.
e To copy the selection, click Copy.
2. In the cell, click where you want to paste the characters, or double-click another cell to move
ot copy the data.
On the Home tab, in the Clipboard group, click Paste.
4. Press ENTER.

@
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Note: When you double-click a cell or press F2 to edit the active cell, the arrow keys work only within
that cell. To use the arrow keys to move to another cell, first press ENTER to complete your editing
changes to the active cell.

Copy cell values, cell formats, or formulas only

When you paste copied data, you can do any of the following:

e Convert any formulas in the cell to the calculated values without overwriting the existing formatting
e Paste only the cell formatting, such as font color or fill color (and not the contents of the cells)

e Paste only the formulas (and not the calculated values)

In Excel 2003:
1. Select the cell or range of cells that contains the values, cell formats, or formulas that you want to
copy.

2. Click Copy on the Standard toolbar.
3. Select the upper-left cell of the paste area or the cell where you want to paste the value, cell format,
or formula.
4. Click the arrow to the right of Paste on the Standard toolbar, and then do one of the following:
e To paste values only, click Values.
e To paste cell formats only, click Paste Special, and then, in the Paste Special dialog box,
click Formats.
e To paste formulas only, click Formulas.

In Excel 2007 or 2010:

1. Select the cell or range of cells that contains the values, cell formats, or formulas that you
want to copy.

2. On the Home tab, in the Clipboard group, click Copy.

3. Select the upper-left cell of the paste area or the cell where you want to paste the value, cell
format, or formula.

4. On the Home tab, in the Clipboard group, click the arrow below Paste, and then do one of
the following:
e To paste values only, click Paste Values.
e To paste cell formats only, click Paste Special, and then click Formats under Paste.
e To paste formulas only, click Formulas.

Note: If the copied formulas contain relative cell references, Excel adjusts the references (and the
relative parts of mixed cell references) in the duplicate formulas. For example, suppose that cell B8
contains the formula =SUM(B1:B7). If you copy the formula to cell C8, the duplicate formula refers to
the corresponding cells in that column: =SUM(C1:C7). If the copied formulas contain an absolute cell
reference (i.e., the exact address of a cell, regardless of the position of the cell that contains the
formula), the references in the duplicate formulas are not changed. If you do not get the results that
you want, you can also change the references in the original formulas to either relative or absolute cell
references and then recopy the cells.

Edit data on multiple worksheets

When you select several worksheets and then change the data on one of them, the changes are applied

to the same cells on all of the selected worksheets.

1. Click the tab of the first worksheet that contains the data that you want to edit, then hold down
CTRL while you click the tabs of other worksheets that contain the same data.
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Note: If you do not see the tab that you want, click the tab scrolling buttons to display the tab, and

then click the tab.

_______________ -
M4 v [m] Sheet1 /s
IT.;-\.I.:-\. o= 1 ——

e A 2 1
L kL 1

2. On the active worksheet (i.e., the sheet that you are working on in a workbook), select the cell or
range of cells that contains the data that you want to edit.

e How to select cells

To select Do this

A single cell Click the cell, or press the arrow keys to move to the cell.
A range of cells Click the first cell of the range, and then drag to the last cell.
A large range of cells Click the first cell in the range, and then hold down SHIFT while you

click the last cell in the range. You can scroll to make the last cell visible.

All cells on a
worksheet

Click the Select All button.
|Seleu::t All buttor

' [ &
1 I

Nonadjacent cells or
cell ranges

Select the first cell or range of cells, and then hold down CTRL while you
select the other cells or ranges.

An entire row or
column

Click the row or column heading.
A, B H 2)

1 Row heading
2 Column heading

Adjacent rows or
columns

Drag across the row or column headings. Or select the first row or
column; then hold down SHIFT while you select the last row or column.

Nonadjacent rows or
columns

Select the first row or column, and then hold down CTRL while you
select the other rows or columns.

More or fewer cells
than the active
selection

Hold down SHIFT while you click the last cell that you want to include in
the new selection. The rectangular range between the active cell and the
cell that you click becomes the new selection.

Note: To cancel a selection of cells, click any cell on the worksheet.

3. Edit the data in the selected cell, and then press ENTER or TAB to move the selection to the next

cell.

4. Repeat the previous step until all changes have been made.

Notes

e When you edit data, the changes affect all selected worksheets and may inadvertently replace data
that you did not mean to change. If needed, you can view worksheets at the same time:
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Excel 2003
1. On the Window menu, click New Window.
2. Switch to the new window, and then click a worksheet that you want to view. Repeat for each
worksheet that you want to view.
3. On the Window menu, click Arrange, and then click the option that you want.
4. To view worksheets in only the active workbook, select the Windows of active workbook check
box.
e To cancel a selection of multiple worksheets, click any unselected worksheet. If an unselected
worksheet is not visible, right-click the tab of a selected worksheet, and then click Ungroup
Sheets.

Excel 2007 or 2010

View two worksheets in the same workbook side by side

On the View tab, in the Window group, click New Window.

On the View tab, in the Window group, click View Side by Side.

In the workbook window, click the worksheets that you want to compare.

To scroll both worksheets at the same time, click Synchronous Scrolling in the Window
group on the View tab.

e

View two worksheets of different workbooks side by side

Open both of the workbooks that contain the worksheets that you want to compare.

On the View tab, in the Window group, click View Side by Side.

In each workbook window, click the sheet that you want to compare.

To scroll both worksheets at the same time, click Synchronous Scrolling in the Window
group on the View tab.

b=

If you resize the workbook windows for optimal viewing, you can click Reset Window Position
to return to the original settings.

To restore a workbook window to full size, click Maximize at the upper-right corner of the
workbook window.

View multiple worksheets at the same time

1. Open the workbook or workbooks that contain the worksheets that you want to view at the
same time.

2. Do one of the following:

If the worksheets that you want to view are in the same workbook:
1. Click a worksheet that you want to view.

2. On the View tab, in the Window group, click New Window.

3. Repeat steps 1 and 2 for each sheet that you want to view.

If the worksheets that you want to view are in different workbooks, continue with Step 3.

1. On the View tab, in the Window group, click Arrange AllL

2. Under Arrange, click the option that you want.

3. To view sheets only in the active workbook, select the Windows of active workbook check
box.
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Rename a worksheet

The name (or title) of a worksheet appears on its sheet tab on the Sheet tab bar at the bottom of the
screen. By default, the names are Sheetl, Sheet2, and so on, but you can give your worksheet a more
appropriate name.

To rename the active sheet, do one of the following:

e On the Format menu, point to Sheet and then click Rename.

e On the Sheet tab bar, right-click the tab you want to rename, and then click Rename.

1.

Shestd

Sheet? | Chati

Artive sheet

2. Type the new name over the current name.

Copy Excel data and charts to Word or PowerPoint

Excel 2003

1. Select the data or chart that you want to copy.

2. Click Copy.

3. Switch to Microsoft Word or Microsoft PowerPoint.

4. Click in the document or presentation where you want to put the Microsoft Excel data or chart,

and do one of the following:
e Paste the data into Word
1. Click Paste on the Formatting toolbar.
2. Click Paste Options next to the data, and then do one of the following:

(e]

To paste the data as a Word table, click Match Destination Table Style or Keep
Source Formatting.

To paste a link to the Excel data, so that the data in the Word document are updated
whenever you change the data in the original Excel workbook, click Match
Destination Table Style and Link to Excel or Keep Source Formatting and Link
to Excel.

To paste the data as text with each row in a separate paragraph and tabs separating the
cell values, click Keep Text Only.

e DPaste a chart into Word
1. Click Paste on the Formatting toolbar.
2. Click Paste Options next to the chart, and then do one of the following:

(e]

(¢]

To paste the chart as a chart, so that when you double-click the chart in the Word
document you can use Excel to edit it, click Excel Chart.

To paste a link to the Excel chart, so that the chart in the Word document is updated
whenever you change the chart in the original Excel workbook, click Link to Excel
Chart.

To paste a bitmap picture of the chart, click Picture of Chart.

e Paste the data into PowerPoint
1. On the Edit menu, click Paste Special, and then do one of the following:

(¢]

To paste the data as an Excel range, so that when you double-click the range in the
presentation you can edit it with Excel, click Microsoft Excel Worksheet Object. If
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o To paste a link to the Excel data, so that the data in the presentation are updated
whenever you change the data in the original Excel workbook, click Paste link, and
then click Microsoft Excel Worksheet Object.

o To paste the data as text that you can edit in PowerPoint, click Formatted Text
(RTF) or Unformatted Text.

o To paste a bitmap picture of the data, click Picture or Bitmap.

e Paste a chart into PowerPoint
1. On the Edit menu, click Paste Special, and then do one of the following:

o To paste the chart as a chart, so that when you double-click the chart in the
presentation you can use Excel to edit it, click Microsoft Excel Chart Object.

o To paste a link to the Excel chart, so that the chart in the presentation is updated
whenever you change the chart in the original Excel workbook, click Paste link, and
then click Microsoft Excel Chart Object.

o To paste a bitmap picture of the chart, click Picture.

Excel 2007 or 2010:

Copy worksheet data to a Word document

In Excel, select the worksheet data that you want to copy to a Word document.

On the Home tab, in the Clipboard group, click Copy.

In the Word document, click where you want to paste the copied worksheet data.

On the Home tab, in the Clipboard group, click Paste.

Click Paste Options next to the data, and then do one of the following:

e To paste the data as a Word table, click Keep Source Formatting if you want to use
the original format of the copied data, or click Match Destination Table Style if you
want to use the document theme that is applied to the Word document.

To paste the data as a static picture, click Paste as Picture.

To paste a link to the Excel data so that the data in the Word document are updated
when you change the original data in the Excel workbook, click Keep Source
Formatting and Link to Excel or click Match Destination Table Style and Link
to Excel.

e To paste the data as text, with each row in a separate paragraph and with tab spaces
separating the cell values, click Keep Text Only.

e If you do not see the Paste Options button, you may have to turn it on. Click the
Microsoft Office Button, and then click Word Options. In the Advanced category,
under Cut, Copy, and Paste, sclect the Show Paste Options buttons check box.

e If you paste the data into a Word table, the Paste Options button displays different
paste options. You can insert the copied data as a nested table, merge it with the
existing table, insert it as new rows in the existing table, overwrite the cells in the
existing table, or paste it as a static picture.

ARl ol S

Copy a chart to a Word document

1. In Excel, select the embedded chart or chart sheet that you want to copy to a Word
document.

2. On the Home tab, in the Clipboard group, click Copy.

3. In the Word document, click where you want to paste the copied chart.
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4. On the Home tab, in the Clipboard group, click Paste.

Click Paste Options next to the chart, and then do one of the following:

e To paste the chart with a link to its source data, click Chart (linked to Excel data).

e To paste the chart and to include access to the entire workbook in the document, click
Excel Chart (entire workbook).
To paste the chart as a static picture, click Paste as Picture.
To paste the chart in its original format, click Keep Source Formatting.
To paste the chart and format it by using the document theme that is applied to the
document, click Use Destination Theme.

vt

Copy worksheet data to a PowerPoint presentation

In Excel, select the worksheet data that you want to copy to a PowerPoint presentation.

On the Home tab, in the Clipboard group, click Copy.

Click in the PowerPoint presentation where you want to paste the copied worksheet data.

On the Home tab, in the Clipboard group, click Paste.

Click Paste Options next to the data, and then do one of the following:

e To use the original format of the copied data, click Keep Source Formatting.

e To use the document theme that is applied to the PowerPoint presentation, click Use
Destination Theme.
To paste table data that you copied as text, click Keep Text Only.
If you do not see the Paste Options button, you may have to turn it on. Click the
Microsoft Office Button, and then click PowerPoint Options. In the Advanced
categoty, under Cut, Copy, and Paste, sclect the Show Paste Options buttons check
box.

e If you paste the data into a PowerPoint table, the Paste Options button is not
displayed.

AR S

Copy a chart to a PowerPoint presentation
1. In Excel, select the embedded chart or chart sheet that you want to copy to a PowerPoint
presentation.

2. On the Home tab, in the Clipboard group, click Copy.
3. Click in the PowerPoint presentation where you want to paste the copied chart.
4. On the Home tab, in the Clipboard group, click Paste.
5. Click Paste Options next to the chart, and then do one of the following:
e To paste the chart with a link to its source data, click Chart (linked to Excel data).
e To paste the chart and include access to the entire workbook in the presentation, click
Excel Chart (entire workbook).
To paste the chart as a static picture, click Paste as Picture.
To paste the chart in its original format, click Keep Source Formatting.
To paste the chart and format it by using the document theme that is applied to the
presentation, click Use Destination Theme.
Tip:

If you want a range of Excel data that you have pasted into Word or PowerPoint to expand when
the data expand in Excel, name the range in Excel before you copy it, and then paste a link to the
named range. (Noze: When naming a range, use an easy-to-understand name, such as “Products,” to
refer to hard-to-understand ranges, such as “Sales!C20:C30.”)
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Remove the split from a window or unfreeze a pane

1. To restore a window that has been split into two scrollable areas, double-click any part of the split
bar that divides the panes.

2. To remove nonscrolling “frozen” panes, click Window, and then click Unfreeze Panes.

Change the scale of a value axis

By default, Microsoft Excel determines the minimum and maximum scale values of the value (y)

axis in a chart. You can, however, customize the scale to better meet your needs.

1. In a chart sheet (i.e., a sheet in a workbook that contains only a chart) or an embedded chart ( i.e.,
a chart that is placed on a worksheet rather than on a separate chart sheet), click the value (y)
axis that you want to change.

e How to select an axis
Excel 2003:

1. Click the chart sheet or the embedded chatt.
2. On the Chart toolbart, click the arrow next to the Chart Objects box, and then click
Category Axis or Value Axis.

Tip

If you do not see the Chart toolbar, point to Toolbars on the View menu, and then select Chart.
The Chart Objects box is available unless the toolbar has been anchored at the left or right side of
the screen.

2. On the Format menu, click Selected Axis.
Note: The Selected Axis command is only available when a chart axis is selected.

3. On the Scale tab, do one or more of the following:

Important: The following scaling options are only available when a value (y) axis is selected. The

Scale tab provides different options for a category (x) axis.

e To change the number at which the value axis starts or ends, type a different number in the
Minimum box or the Maximum box.

e To change the interval of tick marks (i.e., small lines of measurement, similar to divisions on a
ruler, that intersect an axis) and chart gridlines , type a different number into the Major unit
box or Minor unit box.

e To change the units displayed on the value axis, select the units that you want in the Display
units list.

If you want to show a label that describes the units, select the Show display units label on
chart check box.

Excel 2007 or 2010:

To change the values on a vertical axis:
1. Ina chart, click the vertical (value) axis that you want to change, or do the following
to select the axis from a list of chart elements:
e Click anywhere in the chart. (This displays the Chart Tools, adding the
Design, Layout, and Format tabs.)
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e On the Format tab, in the Current Selection group, click the arrow next to

the Chart Elements box, and then click Vertical (Value) Axis.
2. On the Format tab, in the Current Selection group, click Format Selection.
3. Click Axis Options if it is not selected, and then do one or more of the following:

e To change the number at which the vertical (value) axis starts or ends, for the
Minimum or Maximum option, click Fixed and then type a different number
in the Minimum box or the Maximum box.

e To change the interval of tick marks and chart gridlines, for the Major Unit or
Minor Unit option, click Fixed and then type a different number in the Major
unit box or Minor unit box.

o To reverse the order of the values, select the Values in reverse order check
box.

e To change the value axis to logarithmic, select the Logarithmic scale check
box.

e To change the placement of the axis tick marks and labels, select any of the
options that you want in the Major tick mark type, Minor tick mark type,
and Axis labels boxes.

e To change the point at which you want the horizontal (category) axis to cross
the vertical (value) axis, under Horizontal axis crosses, click Axis value, and
then type the number that you want in the text box, or click Maximum axis
value to specify that the horizontal (category) axis crosses the vertical (value)
axis at the highest value on the axis.

Change the scale of the horizontal (category) axis in a chart
1. Ina chart, click the horizontal (category) axis that you want to change, or do the following to
select the axis from a list of chart elements:
e Click anywhere in the chart. (This displays the Chart Tools, adding the Design,
Layout, and Format tabs.)
e On the Format tab, in the Current Selection group, click the arrow next to the Chart
Elements box, and then click Horizontal (Category) Axis.
2. On the Format tab, in the Current Selection group, click Format Selection.
3. Click Axis Options if it is not selected, and then do one or more of the following:
e To change the interval between tick marks, in the Interval between tick marks box,
type the number that you want.
e To change the interval between axis labels, under Interval between labels, click
Specify interval unit, and then in the text box, type the number that you want.
e To change the placement of axis labels, in the Label distance from axis box, type the
number that you want.
To reverse the order of categories, select the Categories in reverse order check box.
To change the axis type to a text or date axis, under Axis Type, click Text axis or
Date axis, and then select the appropriate options. Text and data points are evenly
spaced on a text axis. A date axis displays dates in chronological order at set intervals or
base units, such as the number of days, months, or years, even if the dates on the
worksheet are not in order or in the same base units.
e To change the placement of the axis tick marks and labels, select any of the options
that you want in the Major tick mark type, Minor tick mark type, and Axis labels
boxes.
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e To change the point at which you want the vertical (value) axis to cross the horizontal
(category) axis, under Vertical axis crosses, click At category number, and then type
the number that you want in the text box, or click At maximum category to specify
that the vertical (value) axis cross the horizontal (category) axis after the last category
on the x-axis.

Tip

If the chart values are large numbers, you can make the axis text shorter and more readable by
changing the display unit of the axis. For example, you can display chart values ranging from
1,000,000 to 50,000,000 as 1 to 50 on the axis and show a label that indicates that the units are
expressed in millions.

e To change the value axis to logarithmic, select the Logarithmic scale check box.

Tip:
This type of scale is useful when the values that are plotted in the chart cover a very large range.

e To reverse the order of the values on the selected axis, select the Values in reverse order
check box.

Note: When you change the order of the values on the value (y) axis from bottom to top, the
category labels on the category (x) axis will flip from the bottom to the top of the chart.
Likewise, when you change the order of the categories from left to right, the value labels will
flip from the left side to the right side of the chart.

e To specify the value at which the category (x) axis crosses the value (y) axis, type that value in
the Category (X) axis crosses at box.

e To force the x-axis, cross the value axis at the highest value, and select the Category (X) axis
crosses at maximum value check box. This effectively moves the category labels to the
opposite side of the chart.

Note: This option overrides the Category X crosses at value.

Tip

XY (scatter) charts show values on both the category (x) axis and the value (y) axis, while line charts
show values on only the value (y) axis. This difference is an important factor in deciding which
chart type to use. Because the scale of the line chart’s category axis cannot be changed as much as
the scale of the value axis that is used in the xy (scatter) chart, you might consider using an xy
(scatter) chart instead of a line chart if you need to change the scaling of that axis or display it as a
logarithmic scale.
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APPENDIX D:
CYP Factors

The following are recommended couple-year of protection (CYP) factors for sterilization, by country.
Note: The CYP factors for most methods are constant across countries; the factor for sterilization
varies across countries because of differences in national averages of when in the individual’s
reproductive life the sterilization is performed.

CYP per CYP per

Country Procedure Country Procedure
Global 9
Africa 8 Latin America 9
Democratic Republic of the Congo 8 Bolivia 10
Ethiopia 8 Brazil 10
Gambia 8 Colombia I
Ghana 8 Dominican Republic 12
Guinea 8 Ecuador 10
Kenya 9 El Salvador 12
Liberia 9 Guatemala I
Madagascar 8 Mexico 8
Malawi 8 Nicaragua I
Mali 7 Paraguay I
Mauritius 9 Peru 9
Namibia 7 Trinidad and Tobago 9
Nigeria 8 Venezuela 9
Rwanda 8
Sierra Leone 8 Asia 10
Tanzania 8 Bangladesh Il
Uganda 8 India 13
Zimbabwe 8 Indonesia 9

Nepal 12
North Africa and the Near East 8 Pakistan 9
Egypt 7 Philippines I
Jordan 8 Sri Lanka I
Morocco 9 Thailand 10
Tunisia 9
Turkey 9

Adapted from: Stover, |, Bertrand, J. T., and Shelton, J. D. 2000. Empirically based conversion factors for

calculating couple years of protection. Evaluation Review 24(1): 3—46.
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APPENDIX E:
Contraceptive Discontinuation Rates

Contraceptive Discontinuation Rates
Male Female Implants
Pill IUD | Condom | Injectables | Sterilization | (Norplant) | Total
Sub-Saharan Africa
Ethiopia (2005) 60.9 - 41.8 320 - - 40.9
Malawi (2004) 523 - 61.9 325 - - 35.8
Kenya (2003) 46.2 - 59.4 31.8 37.6
Tanzania (2004-2005) 40.5 - 45.0 36.5 - - 378
Uganda (2006) 61.4 71.0 46.6 57.8
Zimbabwe (1994) 15.1 - 442 15.6 - - 19.5
Zimbabwe (1999) 16.3 - 433 26.2 - - 20.2
Zimbabwe (2005-2006) 15.7 - 53.7 243 - - 20.2
North Africa/West Asia/Europe
Albania (2008-2009) 428 31.7 26.9
Armenia (2000) - 6.5 38.9 - - - 39.7
Armenia (2005) 6.1 31.0 32.1
Azerbaijan (2006) - 6.7 48.2 - - - 27.5
Egypt (1992) 41.8 12.5 47.8 - - - 29.0
Egypt (1995) 46.2 14.2 55.7 52.1 - - 29.8
Egypt (2000) 48.4 14.2 52.5 48.4 - - 285
Egypt (2005) 50.2 15.2 379 455 - 19.3 30.6
Egypt (2008) 40.0 1.8 31.9 36.8 - - 259
Jordan (1990) 635 | 209 63.8 - - - 44.6
Jordan (1997) 67.9 17.7 67.6 - - - 48.5
Jordan (2002) 554 12.8 56.0 55.2 - - 42.0
Jordan (2007) 46.5 11.8 43.6 41.2 - - 31.6
Moldova (2005) 49.8 6.6 388 - - - 378
Morocco (1992) 374 18.9 - - - - 38.6
Morocco (2003-2004) 40.9 15.3 50.4 524 - - 43.2
Turkey (1993) 55.1 10.1 49.0 - - - 36.8
Turkey (1998) 56.4 9.4 433 - - - 349
Ukraine (2007) 253 1.4 22.8 - - - 22.9
Central Asia
Turkmenistan (2000) | 728 117 | 585 - - - 58.0
South & Southeast Asia
Bangladesh (1993-1994) 449 | 37.1 719 57.6 - - 47.7
Bangladesh (1999-2000) 46.3 | 343 66.7 50.1 - - 48.3
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Contraceptive Discontinuation Rates
Male Female Implants
Pill IUD | Condom | Injectables | Sterilization | (Norplant) | Total
Bangladesh (2004) 46.3 - 71.2 48.7 - - 49.2
Bangladesh (2007) 542 | 327 75.7 53.0 - - 56.5
India (2005-2006) 49.2 19.8 44.8 534 0.2 27.2
Indonesia (1991) 29.9 15.7 51.2 32.8 - 35 27.5
Indonesia (1994) 338 15.2 50.9 29.1 - 43 26.8
Indonesia (1997) 339 12.3 37.7 235 0.1 29 24.1
Indonesia (2002-2003) 319 8.9 38.8 18.4 - 2.7 20.7
Indonesia (2007) 38.8 9.9 383 23.0 - 5.7 26.3
Nepal (2006) 64.0 734 419 44.8
Philippines (1993) 40.6 | 22.6 59.8 - - - 35.6
Philippines (1998) 43.8 14.3 60.1 51.8 - - 41.1
Philippines (2003) 39.2 14.0 58.0 52.7 - - 39.0
Vietnam (1997) 332 10.3 32.0 - - - 17.6
Vietnam (2002) 36.1 12.5 378 - - - 248
Latin America & the Caribbean
Bolivia (1994) 589 1.9 69.8 782 - - 41.1
Brazil (1991) 511 - 82.9 72.7 - - 46.8
Brazil (1996) 44.8 - 60.0 63.7 - - 434
Colombia (1990) 449 | 20.0 574 63.7 - - 393
Colombia (1995) 524 19.1 64.8 67.4 0.1 - 50.3
Colombia (2000) 49.7 16.8 61.5 62.1 - - 52.1
Colombia (2005) 47.2 16.6 529 50.7 - - 420
Dominican Republic (1991) | 63.4 37.6 79.1 - - - 525
Dominican Republic (1996) | 59.2 | 32.7 82.8 - - - 52.7
Dominican Republic (1999) | 60.4 - - - - - 548
Dominican Republic (2002) | 51.7 | 27.2 67.4 67.0 - - 47.5
Guatemala (1995) 46.6 18.5 50.6 56.0 0.8 - 358
Guatemala (1998-1999) 514 - 68.9 56.0 - - 423
Nicaragua (1998) 49.2 | 243 63.3 59.7 - - 39.7
Paraguay (1990) 60 15.5 722 71.2 - - 57.1
Peru (1992) 56.4 1.9 66.7 66.6 - - 47.2
Peru (1996) 53.8 17.4 59.2 53.6 - - 45.2
Peru (2000) 544 15.1 533 40.6 - - 40.0
Peru (2004) 605 | 21.1 57.0 434 - - 47.2
Average 47.2 | 16.5 54.5 47.4 0.3 6.4 383

Sources: ORC Macro. 2007. MEASURE DHS STATcompiler. Accessed at www.measuredhs.com; and
individual country final reports.
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APPENDIX F:

Modern Method and Injectable
Prevalence Growth Rates

Average Annual Gain in Average Annual Gain in Injectable
Injectable Use among All Women, Use among Married Women,
1990s-2000s, Selected Countries 1990s-2000s, Selected Countries
Annual gain, Annual gain,
injectable use injectable use
Region/country 1990s | 2000s Region/country 1990s | 2000s
Africa Africa
East/Southern Africa East/Southern Africa
Ethiopia 0.9 Ethiopia 1.4
Kenya 0.7 2.2 Kenya 0.9 1.5
Malawi 1.5 0.2 Malawi 1.9 5.6
Rwanda -0.6 22 Rwanda -0.8 35
Tanzania 0.6 0.3 Tanzania 0.6 0.3
Uganda 0.5 0.5 Uganda 0.7 0.8
Zambia 0.2 0.6 Zambia 0.2 0.8
West Africa West Africa
Burkina Faso 0.1 0.3 Burkina Faso 0.2 04
Cameroon 0.04 0.1 Cameroon .04 0.1
Ghana 0.2 0.1 Ghana 0.5 0.2
Nigeria 0.1 -0.1 Nigeria -0.1 0.2
Senegal 0.3 0.1 Senegal 0.4 0.2

Sources: STATCompiler and selected
Demographic and Health Surveys
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Average Annual Gain in Average Annual Gain in
Modern Method Use among All Women, Modern Method Use among Married
1990s-2000s, Selected Countries Women, 1990s-2000s,
Annual gain, any Selected Countries
modern method use Annual gain, any
Region/country 1990s | 2000s modern method use
Africa Region/country 1990s | 2000s
East/Southern Africa Africa
Ethiopia 1.0 East/Southern Africa
Kenya 1.0 3.3 Ethiopia 1.5
Malawi 1.9 0.2 Kenya 0.8 1.4
Rwanda -0.7 0.2 Malawi 23 0.5
Tanzania .4 04 Rwanda -0.9 57
Uganda .1 -0.2 Tanzania 1.2 0.5
Zambia 1.1 0.97 Uganda 1.7 -0.1
West Africa Zambia 1.4 1.5
Burkina Faso 03 1.0 West Africa
Cameroon 0.5 0.9 Burkina Faso 0.1 1.0
Ghana 0.7 -0.4 Cameroon 0.4 0.9
Nigeria 0.6 0.0 Ghana 0.6 —0.4
Senegal 0.6 0.1 Nigeria 0.6 -0.1
Asia Senegal 0.8 0.3
South Asia Asia
Bangladesh 1.2 -0.03 South Asia
Nepal 1.2 -0.3 Bangladesh |.4 -0.9
Southeast Asia Nepal 1.9 1.8
Cambodia 1.0 Southeast Asia
Indonesia 1.3 0.17 Cambodia 1.7
Philippines 0.4 0.9 Indonesia 1.3 1.0
Latin AmericalCaribbean Philippines 0.7 1.0
Bolivia 0.9 1.4 Latin AmericalCaribbean
Colombia .1 1.1 Bolivia 1.9 1.9
Dom. Rep. 1.5 0.7 Colombia 0.9 0.8
Dom. Rep. 1.5 0.8

Sources: STATCompiler and selected
Demographic and Health Surveys
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APPENDIX G:
Abortion Ratios

Believed to Be

Incomplete or of Unknown

Completeness

Complete
Australia, 1995-1996 26.4
Belarus, 1996 61.9
Belgium, 1996 1.2
Bulgaria, 1996 55.2
Canada, 1995 22
Cuba, 1996 58.6
Czech Republic,1996 34
Denmark, 1995 20.3
England & Wales, 1996 20.5
Estonia, 1996 56
Finland, 1996 14.7
Germany, 1996 14.1
Hungary, 1996 42.1
Israel, 1995 13.1
Kazakhstan, 1996 41.3
Latvia, 1996 53.9
Netherlands, 1996 10.6
New Zealand, 1995 19.1
Norway, 1996 19.1
Puerto Rico, 1991-1992 23
Scotland, 1996 17.2
Singapore, 1996 22.8
Slovak Republic, 1996 28.8
Slovenia, 1996 35.7
Sweden, 1996 25.2
Switzerland, 1996 13.3
Tunisia, 1996 7.8
United States, 1996 259

The RESPOND Project

Albania, 1996 23.7
Armenia, 1996 394
Azerbaijan, 1996 18
Bangladesh, 1995-1996 3.1
China, 1995 27.4
Croatia, 1996 18.7
France, 1995 17.7
Georgia, 1996 33.2
Hong Kong, 1996 279
India, 19951996 2.1
Ireland, 1996 8.9
Italy, 1996 21.1
Japan, 1995 22.4
Korea (South), 1996 24.6
Kyrgyzstan, 1996 17.5
Lithuania, 1996 41.5
Macedonia, 1996 31.1
Moldova, 1996 42.7
Mongolia, 1996 18.2
Romania, 1996 63
Russian Federation, 1995 62.6
South Africa, 1997 2.4
Spain, 1996 12.6
Tajikistan, 1990 21.2
Turkey, 1993 20.5
Turkmenistan, 1990 229
Ukraine, 1996 57.6
Uzbekistan, 1996 95
Vietham, 1996 437
Yugoslavia, 1993 45.8
Zambia, 1983 04
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Region and subregion Ratio
Total 26
Developed regions 42
Excluding Eastern Europe 26
Developing regions 23
Excluding China 20
Africa 15
Eastern Africa 16
Middle Africa 14
Northern Africa 12
Southern Africa 12
Western Africa 15
Asia 25
Eastern Asia 34
South-central Asia 18
South-eastern Asia 28
Western Asia 20
Europe 48
Eastern Europe 65
Northern Europe 23
Southern Europe 34
Western Europe 17
Latin America 27
Caribbean 35
Central America 21
South America 30
Northern America 26
Oceania 20

Source: Henshaw, Singh, & Haas, 1999.
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APPENDIX H:
Maternal Mortality Ratios

Maternal Maternal
Mortality Mortality
Country or Area Ratio (2008) | Country or Area Ratio (2008)
Afghanistan 1,400 | Congo, Democratic Rep. of 670
Albania 31 | Costa Rica 44
Algeria 120 | Céote d'Ivoire 470
Angola 610 | Croatia 14
Argentina 70 | Cuba 53
Armenia 29 | Cyprus 10
Australia 8 | Czech Republic 8
Austria 5 | Denmark 5
Azerbaijan 38 | Djibouti 300
Bahamas 49 | Dominican Republic 100
Bahrain 19 | Ecuador 140
Bangladesh 340 | Egypt 82
Barbados 64 | El Salvador 110
Belarus I5 | Equatorial Guinea 280
Belgium 5 | Eritrea 280
Belize 94 | Estonia 12
Benin 410 | Ethiopia 470
Bhutan 200 | Fiji 26
Bolivia 180 | Finland 8
Bosnia and Herzegovina 9 | France 8
Botswana 190 | Gabon 260
Brazil 58 | Gambia 400
Brunei Darussalam 21 | Georgia 48
Bulgaria 13 | Germany 7
Burkina Faso 560 | Ghana 350
Burundi 970 | Greece 2
Cambodia 290 | Guatemala 110
Cameroon 600 | Guinea 680
Canada 12 | Guinea-Bissau 1,000
Cape Verde 94 | Guyana 270
Central African Republic 850 | Haiti 300
Chad 1,200 | Honduras 110
Chile 26 | Hungary 13
China 38 | Iceland 5
Colombia 85 | India 230
Comoros 340 | Iran (Islamic Rep) 30
Congo 580 | Iraq 75
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Maternal Maternal
Mortality Mortality
Country or Area Ratio (2008) | Country or Area Ratio (2008)
Ireland 3 | Niger 820
Israel 7 | Nigeria 840
Italy 5 | Norway 7
Jamaica 89 | Oman 20
Japan 6 | Pakistan 260
Jordan 59 | Panama 71
Kazakhstan 45 | Papua New Guinea 250
Kenya 530 | Paraguay 95
Korea 370 | Peru 98
Kuwait 9 | Philippines 94
Kyrgyzstan 81 | Poland 6
Lao People's Democratic Republic 580 | Portugal 7
Latvia 20 | Qatar 8
Lebanon 26 | Republic of Korea 18
Lesotho 530 | Republic of Moldova 32
Liberia 990 | Romania 27
Libyan Arab Jamahiriya 64 | Russian Federation 39
Lithuania 13 | Rwanda 540
Luxembourg 17 | Saudi Arabia 24
Macedonia 9 | Senegal 410
Madagascar 440 | Sierra Leone 970
Malawi 510 | Singapore 9
Malaysia 31 | Slovakia 6
Maldives 37 | Slovenia 18
Mali 830 | Solomon Islands 100
Malta 8 | Somalia 1,200
Mauritania 550 | South Africa 410
Mauritius 36 | Spain 6
Mexico 85 | Sri Lanka 39
Mongolia 65 | Sudan 750
Morocco 10 | Suriname 100
Mozambique 550 | Swaziland 420
Myanmar 240 | Sweden 5
Namibia 180 | Switzerland 10
Nepal 380 | Syrian Arab Republic 46
Netherlands 9 | Tajikistan 64
New Zealand 14 | Thailand 48
Nicaragua 100 | Timor-Leste 370
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Maternal

Mortality
Country or Area Ratio (2008)
Togo 350
Trinidad and Tobago 55
Tunisia 60
Turkey 23
Turkmenistan 77
Uganda 430
Ukraine 26
United Arab Emirates 10
United Kingdom 12
United Republic of Tanzania 790
United States of America 24
Uruguay 27
Uzbekistan 30
Venezuela 68
Viet Nam 56
Yemen 210
Zambia 470
Zimbabwe 790

Source: World Health Organization, 2010.
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APPENDIX I:
Infant and Child Mortality Rates

Infant Under-5 Infant Under-5
Mortality Mortality Mortality Mortality
Country (and Survey Rate (per Rate (per | Country (and Survey | Rate (per Rate (per
Year) 1,000) 1,000) Year) 1,000) 1,000)
Albania (2002 RHS) 26.8 30.7 | Honduras (2005-2006) 234 29.6
Angola (2006—2007) 69 104.7 | India (2005-2006) 57 743
Armenia (2005) 25.6 29.8 | Indonesia (2007) 34.2 44.4
Azerbaijan (2006) 43 49.5 | Jordan (2009) 23.1 28.1
Bangladesh (2007) 51.5 65 | Kazakhstan (1999) 61.9 714
Benin (2006) 67 124.9 | Kenya (2008-2009) 51.7 73.6
Bolivia (2003) 53.6 75 | Kyrgyz Republic (1997) 61.3 723
Botswana (1988) 384 52.6 | Lesotho (2004) 91 112.8
Brazil (1996) 393 48.8 | Liberia (2009) 72.6 [14.4
Madagascar (2008-
Burkina Faso (2003) 81.4 183.7 | 2009) 479 71.7
Burundi (1987) 73.7 152.5 | Malawi (2004) 76.1 133.2
Cambodia (2005) 65.6 83.3 | Mali (2006) 95.8 190.5
Cameroon (2004) 74.1 143.6 | Mauritania (2000-2001) 69.9 104.2
Central African
Republic (1994—1995) 96.7 157.5 | Mexico (1987) 474 61.4
Chad (2004) 101.7 190.6 | Moldova (2005) 12.8 13.6
Colombia (2005) 18.7 22.2 | Morocco (2003-2004) 404 474
Comoros (1996) 77.3 104 | Mozambique (2003) 100.7 152.4
Congo-Brazzaville (2005) 75.5 [16.6 | Namibia (1992) 56.6 83.9
Congo, Democratic
Republic of (2007) 91.8 147.9 | Namibia (2006—2007) 46.1 69.4
Cote d'lvoire (1998-1999) 112.2 180.7 | Nepal (2006) 47.9 61.2
Dominican Rep. (2007) 32.1 36.5 | Nicaragua (2006 RHS) 29 354
Ecuador (2004 RHS) 29.8 34.7 | Niger (2006) 814 197.6
Egypt (2008) 24.5 28.3 | Nigeria (2008) 75.3 156.9
El Salvador (2002 RHS) 24.6 30.5 | Pakistan (2006—2007) 77.7 94.2
Eritrea (2002) 47.7 93.3 | Paraguay (2004 RHS) 29.1 333
Ethiopia (2005) 77 123.5 | Peru (2000) 333 46.7
Gabon (2000) 57.3 88.6 | Philippines (2008) 249 335
Georgia (2005 RHS) 21.1 25 | Rwanda (2007-2008) 62.3 102.6
Ghana (2008) 50.3 80 | Senegal (2008-2009) 53.6 84.8
Guatemala (2002 RHS) 388 52.9 | Sierra Leone (2008) 88.9 139.8
Guinea (2005) 91.4 163.2 | South Africa (1998) 454 59.4
Haiti (2005-2006) 57.3 86.3 | Sri Lanka (1987) 247 34
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Infant Under-5 Infant Under-5

Mortality Mortality Mortality Mortality

Country (and Survey Rate (per Rate (per | Country (and Survey | Rate (per Rate (per
Year) 1,000) 1,000) Year) 1,000) 1,000)

Sudan (1989-1990) 70 123.7 | Turkmenistan (2000) 739 94.3
Swaziland (2006—2007) 85.5 119.9 | Uganda (2006) 71.1 127.6
Tanzania (2004-2005) 68 112 | Ukraine (2007) 13.9 16.9
Thailand (1987) 35.2 44.1 | Uzbekistan (1996) 49.1 59.3
Togo (1998) 797 [46.3 | Vietnam (2002) 18.2 23.6
Trinidad & Tobago (1987) 28 31.6 | Yemen (1997) 75.3 104.8
Tunisia (1988) 48 61.9 | Zambia (2007) 70.4 118.7
Turkey (1998) 42.7 52.1 | Zimbabwe (2005-2006) 59.9 82.5

Source: StatCompiler: Most recent DHS for each country.
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APPENDIX J:
Definitions, Acronyms, and Formulas|

Abortion Ratio

The number of induced abortions per 100 known pregnancies (Henshaw, Singh, & Haas, 1999). In
Reality V, this ratio is used to calculate the number of abortions averted by a particular family planning
scenario, using the following formula:

Number of unintended pregnancies averted
*

(abortion ratio/100))

Adopter
Adopters (also known as new users) are all of the people who begin using a method in any given year.
The formula for calculating the number of adgpters in a given year in Reality V is:

(Number of users in the current year —number of users in the previous year)
+

(Number of users in the previous year * discontinuation rate)

Even if an individual has been using a method and switches to another method, s/he will be
considered an adopter of that method in the year in which s/he begins to use it.

Census

A complete population count taken by a national census bureau every 10 years. A census details the
age and sex structure of a national population and various subpopulations, providing figures for
women of reproductive age (WRA) and married women of reproductive age (MWRA) or percentage
in union (FPLM, 2000).

Child Mortality Rate
The proportion of children who will die in their first five years of life per 1,000 live births. In Reality \/,
this rate is used to calculate the number of child deaths averted, using the following formula:

Number of unintended births averted * (child mortality rate [child deaths/1,000 births])

Commodities and Supplies
The supplies (pills, injections, IUDs, surgical equipment, etc.) needed to provide contraceptive
protection for one year.

Continuation Rate

The cumulative probability that acceptors of a contraceptive method will still be using any
contraceptive method offered by the program after a specified period of time (e.g., one year) (Bertrand
& Escudero, 2002).
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Contraceptive Prevalence Rate (CPR)

The percentage of women of reproductive age who are using (or whose partner is using) a
contraceptive method at a particular point in time, almost always reported for women married or in a
sexual union. Generally, CPR includes all contraceptive methods (modern and traditional), but it may
include modern methods only (Bertrand & Escudero, 2002). This information can generally be found
through population-based surveys such as the Demographic and Health Survey (DHS) or the Multiple
Indicator Cluster Survey (MICS).

Couple-Years of Protection (CYP)

The amount of contraception necessary to protect one couple from pregnancy for one year, based
upon the volume of all contraceptives sold or distributed to clients during that year. It is calculated by
multiplying the quantity of each method distributed to clients by a factor representing the number of
units needed to protect a couple for one year, to yield an estimate of the duration of contraceptive
protection provided per unit of that method. The calculation takes into account that some methods,
like condoms and oral contraceptives, for example, may be used incorrectly and then discarded, or that
IUDs and implants may be removed before their lifespan is realized (USAID, 2009). CYP is generally
used to assess program progress, not to plan for service delivery.

Demand for Family Planning
The percentage of MWRA who either are using a family planning method or have expressed an unmet
need for family planning (Bertrand & Escudero, 2002).

Discontinuation Rate

The cumulative probability that acceptors of a contraceptive method will discontinue using the
method after a specified period of time (e.g., one year). It is the inverse of the continuation rate
(Bertrand & Escudero, 2002).

Demographic and Health Survey (DHS)

An ongoing program of nationally representative household surveys that provide data on a wide range
of monitoring and impact evaluation indicators in the areas of population, health, and nutrition. These
surveys are implemented by Macro International, Inc., and collaborating organizations (Measure DHS,
no date). Data from the DHS can be found in the DHS reports at www.measuredhs.com/or at
www.statcompiler.com/.

Failure Rate

The percentage of women experiencing an unintended pregnancy during the first year of use of a
particular contraceptive method. The failure rate is the inverse of the effectiveness rate. Data are
available for typical use and perfect use of contraception (Trussell, 2004).

Infant Mortality Rate
The number of infants who die in their first year of life for every 1,000 live births. In Reality V, this
rate is used to calculate the number of infant deaths averted, using the following formula:

Number of unintended births averted * infant mortality rate
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Long-Acting and Permanent Methods (LA/PM:s)

Contraceptive methods that provide the longest duration of protection—the hormonal implant, the
intrauterine device (IUD) (both of them long-acting methods), male sterilization (vasectomy), and
female sterilization (both of them permanent methods).

Maternal Mortality Ratio
The number of maternal deaths per 100,000 live births. In Reality V, this ratio is used to calculate the
number of maternal deaths averted, using the following formula:

Number of unintended births averted * maternal mortality ratio

Method Mix

The mix of contraceptive methods used by the population, expressed as the percentage that each
method constitutes out of all contraceptives used (FPLM, 2000). If, for example, a particular method is
used by 5% of women, and the CPR for the population of interest is 30%, then that method
comprises 16.7% of the total method mix (5/30).

Modern Methods of Contraception

Condoms, injectables, implants, IUDs, oral contraceptives and other hormonal methods, vaginal
methods (spermicides, diaphragms, or caps), the standard days method, and male or female
sterilization.

Married Women of Reproductive Age (MWRA)

Women aged 1549 who either are formally married or live with a male sexual partner (consensual
unions). MWRA is often used as an estimate of the percentage of WRA who are potentially at risk of
pregnancy (FPLM, 2000). (This measure is also known as “currently married women.”)

Population Growth Rate

Annual rate of population growth, measured as births minus deaths plus migration, or the more
commonly available rate of natural increase, which is simply births minus deaths. It should be noted
that these rates measure the growth of an entire population and may differ somewhat from the rate of
growth for MWRA (FPLM, 2000).

Pregnancy Rate

The percentage of sexually active women of reproductive age who will become pregnant in a given
year if not using contraception (Trussell, 2004). In Reality v, this rate is used to calculate the number
of unintended pregnancies averted, using the following formula:

(Number of users * Pregnancy rate)

(Number of users * method-specific failure rate)

Standard Days Method (SDM)
A method in which a woman keeps track of estimated high- and low-fertility points during her
menstrual cycle, using a product called CycleBeads (Arévalo, Jennings, & Sinai, 2001).

Traditional Methods of Contraception

Nonsupply methods, such as periodic and postpartum abstinence, total abstinence if for contraceptive
reasons, withdrawal, douching, and folk methods (IPPF, no date).
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Unmet Need for Contraception

The number or percentage of women currently married or in union who are fecund and who desire to
either terminate or postpone childbearing, but who are not currently using a contraceptive method.
The total number of women with an unmet need for family planning consists of two groups of
women: those with an unmet need for limiting (i.e., who never want another birth), and those with an
unmet need for spacing (i.e., who want another birth, but only after a certain period of time) (Bertrand
& Escudero, 2002).

Users

The people using a particular contraceptive method in a given year (also known as clients or
customers). In Reality V, numbers of users are calculated by multiplying the contraceptive prevalence
rate (CPR) by the number of women of reproductive age or of married women of reproductive age in
the population.

Women of Reproductive Age (WRA)
Number of women in their reproductive years (ages 15—49) (FPLM, 2000).
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APPENDIX K:
Troubleshooting for Reality

The following are the most commonly encountered Reality \ problems and their solutions. For
additional support with or to share feedback on the tool, please feel free to contact The RESPOND
Project at info@respondproject.org.

Problem

I’'ve entered my CPR data into the Past Trend Continuation worksheet, but no average annual increase or
decrease or projection of the trend has been generated.

Solutions

Make sure that you have entered the values of the years that correspond to those data in Cells
B13 to F13. Reality \ considers the difference between these years when calculating the
average annual rate of increase or decrease.

Make sure that you have macros enabled on your machine by following the steps listed on
pages 6—7 of the User’s Guide. Close and reopen the Reality v document.

Problem

I tried to enter the total CPR or modern method CPR in the cells in Rows 30, 31, or 32, but I received
an error message.

Solution

Remember that in Reality V, data are only entered in the green cells; the cells in Rows 30
through 32 are summary cells that show the sum of the method-specific CPRs that are entered
in the green cells above. Because they contain formulas, they are locked, to minimize the
possibility of error.

To look at the total CPR or the modern method CPR, enter the method-specific CPRs in the
green cells above. Alternately, you can enter the total CPR and/or modern method CPR in the
cells labeled as “other” in Rows 27 and 28 or in those designated for the pill or other methods;
you would then need to change the label(s) in Column A to correctly identify the data
contained in the cells.

Problem

I entered CPR wvalues for multiple years, but some of the future CPR values projected seem
unreasonably high or low.

Solution

When two CPR values are entered, Reality \ creates a simple linear projection by calculating
the average annual difference (increase or decrease) between those values and projecting that
change to continue in the future. When more than two values are entered, the tool creates a
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line of best fit between the points. When a sharp increase or decrease occurs between the CPR
values you enter, the average annual change will be significant and, when projected forward,
may produce values as low as zero or as high as 100. These projections are obviously
unrealistic and should be discounted. A solution is to enter additional data points that may
provide a more realistic indication of the past rate of change and produce a more realistic
projection of the continuation of those trends.

Problem
I changed the years of the CPR data sources, and my population data have disappeared.

Solution

Reality v automatically erases the population data when the CPR vyears are adjusted; because
your years have changed, the population figures corresponding to those years will need to
change as well.

Problem

I entered CPR values for all methods of interest, but the values for the outputs below (users, adopters,
commodities, etc.) are missing or incomplete.

Solution
Verify that you have entered correct population data for all years of interest; Reality V requires
both CPR and population data to generate outputs.

Problem

I attempted to generate data for the population of married women of reproductive age using the
population calculator, but the tool generated a population of zero.

Solution

The tool does not contain default values for the percentage of women of reproductive age
who are married for every country, just for those that have had Demographic and Health
Surveys. If you selected a country that does not have a default value for the percentage of
women of reproductive age who are married and checked the “MWRA” box but did not enter
a value, the tool assumed that 0% of women of reproductive age are married and calculated a
value of zero. Enter a value or estimated value of the percentage of WRA that are married in
the grey box.

Problem

I receive an error message when I attempt to use the “Copy from Calculator” button.

Solution

Make sure that the years in the Population Calculator align with those in Reality V. When you
are working in the Past Trend Continnation worksheet, the first year in the Population Calculator
must be the same as the year in Cell F34 of the Past Trend Continuation worksheet, and the end
year can be any year up to 25 years in the future. When working in the Future Goals worksheet,
the first year in the Population Calculator must be the same as that in Cell D14, while the last
year must be the same as that in Cell C14.
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Verify that you only have one Reality \ workbook and one Population Calculator workbook
open at the same time.

Make sure that you have macros enabled on your machine by following the steps listed on
pages 6—7 of the User’s Guide. Close and reopen the Reality \ document and the Population
Calculator.

Problem
I manually copied and pasted the population values into the Fusure Goals worksheet. The population

value for the final (target) year appears in a column that appears next to the second-to-last year, while
the population cell for the final year is blank.

Solution

The Future Goals worksheet in Reality \ contains macros, automatic scripts that adjust the
number of columns that appear based on the number of years for which you are projecting. A
number of blank columns are hidden between the second-to-last and final years; when you
copy and paste the population values into the first cells, the tool adds the additional column, as
it thinks that you have increased the difference between the years.

Copy and paste the population value from the column between the second-to-last and final
years into the correct cell for the final year, then delete it from that additional column (do not
cut and paste or drop and drag the value from one column to the next, as an error will occur
with the formulas). Highlight the additional column that appeared by selecting the letter of that
column from the top (next to the final column, AD). Right-click the column and select
“Hide.”

In the future, copy and paste the value for your final year separately to avoid any problems.

Problem
The Population calculators are not working; when I select “Calculate,” nothing happens.

Solution
Make sure that you have enabled macros on your machine by following the steps listed on
pages 6—7 of the User’s Guide. Close and reopen the spreadsheet.

Problem

I am trying to save a Reality \ file that 1 have created from the CD-ROM, but I receive an error
message that states that the file is “read-only.”

Solution

The “Save” command is to save the file onto the CD-ROM from which it came, which is not
possible; use the “Save As” feature to save the file onto your own computer.
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Problem

When I paste values from the method mix calculators into Reality v, they appear as blank cells and the
cells linked by formulas show a #VALUE! Error.

Solution
Use the “Paste Special” feature described on page 52 of the User’s Guide.

Problem

I entered the estimated number of facilities able to provide each service in Cells C139 through C153,
but no outputs have been generated.

Solution
Be sure to enter the estimated number of client visits per year in Cells B139 through B153; if
these are left blank, the tool assumes that clients will make zero annual visits.

Problem

I am running multiple scenarios in the same workbook and I want to view graphs for each scenario. I
copied the graphs tab to create graphs for the second scenario, but I have received an error message.

Solution

You can run multiple scenarios in the same workbook by using the “Move or Copy” feature.
However, the graphs worksheets correspond only to the first scenario created in the original
Past Trend Continuation or Future Goals worksheet. To view graphs for each scenario, it is best to
create each scenario in a separate workbook.

Problem

The graphs do not seem to represent the latest data that I have entered into the Past Trend Continuation
ot Future Goals worksheet.

Solution
Try clicking on the “Update Graphs” button at the top of the graphs page; updates to the data
may not be automatically reflected in the graphs.
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